
Installation and Reference Guide

Agilent N1900 Series
Physical Layer Test Systems

N1930A Physical Layer Test System Software
which supports VNA-Based and TDR-Based

Physical Layer Test System Hardware
Manufacturing Part Number: N1930-90005

Printed in USA

May 2004

© Copyright 2004 Agilent Technologies Inc., all rights reserved.



Notice
The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental 
or consequential damages in connection with the furnishing, performance, or use of this 
material.

LIMITED WARRANTY
The material contained in this document is provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the maximum extent permitted by applicable 
law, Agilent disclaims all warranties, either express or implied with regard to this manual 
and any information contained herein, including but not limited to the implied warranties of 
merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or 
for incidental or consequential damages in connection with the furnishing, use, or 
performance of this document or any information contained herein. Should Agilent and the 
user have a separate written agreement with warranty terms covering the material in this 
document that conflict with these terms, the warranty terms in the separate agreement will 
control.

Assistance
Product maintenance agreements and other customer assistance agreements are available for 
Agilent Technologies products. For any assistance, refer to “Contacting Agilent” on page 237.
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Software Licensing
The Physical Layer Test System has two licensing options. The options are:

Node-Locked allows use of PLTS software only on a single personal computer. The license 
resides on and is tied to the local PC via a hardware address.

Server-Based
Floating allows the sharing of a licenses (or multiple licenses) across a network. The 

PLTS software may be installed on an unlimited number of personal 
computers. The license(s) reside on a networked drive/folder and are 
checked out on a first-come, first-served basis.

Refer to Chapter 3, Installing the Physical Layer Test System Software, for the licensing 
procedure.

Software Compatibility
This document is compatible with Physical Layer Test System software revisions 2.500 and 

above. 

Document Conventions
This document uses a few conventions to make reading easier.

• Menu and dialog box items are shown in bold face type. When described in text, menus and 
sub-menus are separated by right arrows, as in File > Open > Data…

• Window and dialog box names are shown in italic font.

• Keyboard entries are shown in mono-spaced typeface.

• Network analyzer keys are displayed in condensed, bold font.
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Embedded Operating System Risk

PNA Network Analyzers

The Agilent PNA-family of network analyzers make use of Embedded Operating Systems 
(EOS) technology. The EOS is Windows1 2000, a standard personal computer-based operating 
system. The PNA is essentially a network analyzer with a personal computer behind the front 
panel.

EOS devices, including the PNA may be connected to computer networks. When connected, 
these devices are open to numerous security exploits, worms, and viruses. In addition, they 
can become a threat to other EOS devices, servers, end-user PCs, and to the network itself.

Precautions are taken to ensure that the PNA has no security issues, such as worms or 
viruses, prior to shipping. To maintain the health of the PNA, it is recommended that you 
install anti-virus software and the latest service packs on the PNA before connecting the PNA 
to a computer network.

Infiniium DCA Oscilloscopes

On your 86100C, you can access Microsoft Windows XP Professional just as you would on your 
personal computer. Use Windows XP Professional to manage files and folders, add, remove, 
and setup printing, configure networking, and install applications. The ability to access the 
operating system is not available on 86100A/B instruments.

Although the 86100C is an instrument and not a personal computer, the operating system is 
accessible. This makes it possible for you to install applications such as virus protection 
software. If the performance of the Infiniium DCA application decreases while running other 
applications, you may need to close those applications that are demanding processor 
resources. It is also suggested that you schedule automatic virus scans for times when you are 
not making measurements. Refer to the 86100C Help for complete information.

1. Windows and MS Windows are U.S. registered trademarks of Microsoft Corporation.
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I Installation
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Part I guides you through the initial steps of installing the physical layer test system.

Chapter 1, “Installing the VNA-Based Physical Layer Test System Hardware”

Provides you a step-by-step installation procedure for the VNA-based PLTS 
hardware.

Chapter 2, “Installing the TDR-Based Physical Layer Test System Hardware”

Provides you a step-by-step installation procedure for the TDR-based PLTS 
hardware.

Chapter 3, “Installing the Physical Layer Test System Software”

Provides you a step-by-step installation procedure for the PLTS software. This 
chapter also explains the various areas of the main software screen.
2



1 Installing the VNA-Based Physical 
Layer Test System Hardware
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Installing the VNA-Based Physical Layer Test System Hardware
The Physical Layer Test System (PLTS) consists of the following items:

• Personal computer (PC)

• VNA-based system (Network analyzer and S-parameter test set)

• PLTS software

The installation procedure in this chapter will lead you through setting up the hardware (the 
PC and the VNA-based system). After that is complete, you will refer to Chapter 3, Installing 
the Physical Layer Test System Software, to install the software. 

NOTE If you have the TDR-based PLTS system, refer to Chapter 2, “Installing the 
TDR-Based Physical Layer Test System Hardware,” on page 33 for instructions 
on setting up that system.

This installation procedure will lead you through a series of steps to set up your PLTS 
hardware. The following is a list of the installation steps:

• Step 1. Set Up the Personal Computer

• Step 2. Verify your System Shipment

• Step 3. Set Up the Network Analyzer

• Step 4. Attach the Test Set to the Network Analyzer (N4420B or N4464A/B Test Set Only)

• Step 5. Install the S-Parameter Test Set on a Bench Top or in an Equipment Rack

• Step 6. Make the Interconnections between the S-Parameter Test Set and the Network 
Analyzer

• Step 7. Set Up the General Purpose Interface Bus (GPIB)

• Step 8. Power up the Physical Layer Test System

NOTE These installation instructions were written specifically for customers who 
have just received their PLTS. If you have already been using our S-parameter 
test set and its corresponding network analyzer, you have probably completed 
most of these installation steps. Review these installation steps to ensure that 
your system is currently set up as recommended. Then, begin the software 
installation process by starting at Chapter 3, “Installing the Physical Layer 
Test System Software,” on page 41.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 1. Set Up the Personal Computer
Step 1. Set Up the Personal Computer

1. Make sure that your PC meets the following minimum system controller requirements:

2. Using the PC documentation, make sure that the PC is operating properly.

3. Make sure the GPIB card is installed in the PC and that it is operating properly.

4. Make sure the PC is located near where you will position the Physical Layer Test System 
(PLTS). Later in this process, you will connect the GPIB card to the PLTS using a GPIB 
cable.

Table 1-1 Minimum PC Requirements by PLTS Modes of Operation

PC Requirement

Measurement Controller Mode Off-Line Analysis Mode

In the lab, controlling test 
equipment and making quick 
analysis of the results

In your office, performing “What if...” 
analysis, characterization, 
cross-domain analysis, filtering, 
waveform math, and eye diagram 
simulation

CPU 400 MHz Pentiuma II or greater

a. Pentium is a U.S. registered trademark of Intel Corporation.

1 GHz Pentium III compatible PC

Main Memory 256 MBb

b. 512 MB of Main Memory is recommended for the Measurement Controller Mode when the 
measurement is measuring 16,000 points with the PNA B-model network analyzer.

512 MB

Virtual Memoryc

c. As a general rule for optimum PC performance when using PLTS, virtual memory should be 
1.5 to 2 times the size of the main memory.

512 MB 768 MB

GPIB Interface Agilent 82357A USB/GPIB Interface 
for Windows or supported GPIB card 
(any National Instruments or Agilent 
82340/41 or 82350 GPIB card)

No GPIB connection is required to 
utilize PLTS in the off-line mode. 
Saved (stored) measurement files can 
be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPd

d. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768

Display Colors High Color (16 Bit) or greater
Chapter 1 5



Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
Step 2. Verify your System Shipment

1. Unpack your system from the containers in which it was shipped.

WARNING The test system hardware is heavy. Use proper lifting techniques. 
The network analyzer can weigh between 53 lb. (24 kg) and 64 lb. 
(29 kg). The test set can weigh as much as 20 lb. (9 kg). 

2. Carefully inspect the system hardware to make sure that it was not damaged during 
shipment.

NOTE If your test system was damaged during shipment, contact Agilent 
Technologies. Refer to “Contacting Agilent” on page 237.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
3. Use Table 1-2 to verify that your test set is compatible with your network analyzer and its 
installed options. “Step 3. Set Up the Network Analyzer” on page 10 has additional 
network analyzer option information if you have a question. If the installed options are not 
compatible, contact us before proceeding. Refer to “Contacting Agilent” on page 237.

Table 1-2 Physical Layer Test System Configurations

Test Set
Model 
Numbera

a. For the discontinued test set model numbers (N4415A, N4416A, N4417A, N4418A, N4419A, 
and N4421A), refer to Table B-2 on page 281 in Appendix B, “Reference Information for 
Discontinued Physical Layer Test System Hardware.”

System
Frequency

Range

Supported Network Analyzer

Model 
Number

Optionsb

b. This table lists only the most specifically relevant options. For compatibility with options not 
listed here, contact the factory.

Required Compatible Incompatible

N4419B 10 MHz to 
20 GHz

E8362Ac/B

c. “A” models of this network analyzer have a start frequency of 45 MHz.

014 010, 022, 711, UNL

N5230A 225 010 220

N4420B 10 MHz to 
40 GHz

E8363Ac/B 014 010, 022, 711, UNL

N4421B 10 MHz to 
50 GHz

E8364Ac/B 014 010, 022, 711, UNL
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
4. Check the accessories that were shipped with your system. Your network analyzer 
accessories will be checked during the network analyzer setup. 

Item Nr Part Number Part Description

1 8120-3445 GPIB Cable (3 feet)

2 N/A “Port 3” Label

3 Varies by Test Set 
Model and Option

Semirigid interconnect cables (refer to Step 6. Make the 
Interconnections between the S-Parameter Test Set and the 
Network Analyzer for the appropriate number of cables)

4 Unique to country AC Power Cord (for the test set)

5 AD00658 Balanced Transmission Line PC Board Device (Sample DUT)

6 Left: Z5823-20239 
Right: Z5823-20240

2 Rear Locking Feet (N4420B, N4421A/B only) (With 4 Screws - 
2 each - longer: 0515-0686 and shorter: HW00235)

7 1600-1423 4 Lock Links (N4420B, N4421A/B only) with 8 screws 
(0515-1499)
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Installing the VNA-Based Physical Layer Test System Hardware
Step 2. Verify your System Shipment
5. If you ordered any of the following options, check the parts. Option 1CP is shipped in a 
separate container.

Option 
Number

Item 
Number

Part Description

1CP 1A
1B

Rack mount flange kit (For use with handles)
Handles (set of 2)

B20 2 Precision 50-ohm cables (4)

060 3 4-Port Electronic Calibration Module/Kit (Not available as an 
option for the N1951A/53A/53B/55B/57A/57B or N1935A PLTS)

Other Calibration Kits

N/A Not Shown 85033E 3.5mm Calibration Kit (0 Hz (dc) - 9 GHz) 1

85052D 3.5mm Economy Calibration Kit (0 Hz (dc) − 26.5 GHz) 1

85056A 2.4mm Precision Calibration Kit (0 Hz (dc) − 50 GHz) 1

85050C 7 mm Precision Calibration Kit (0 Hz (dc) − 18 GHz) 2

1 Kit for SOLT Calibration; 2 Kit for TRL Calibration
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Installing the VNA-Based Physical Layer Test System Hardware
Step 3. Set Up the Network Analyzer
Step 3. Set Up the Network Analyzer

1. Using Table 1-3, verify that your network analyzer options are compatible with the 
physical layer test system. Incompatible options are shaded.

NOTE For option information on the network analyzer model numbers listed below, 
refer to Table B-3 on page 283 in Appendix B, “Reference Information for 
Discontinued Physical Layer Test System Hardware.”

8753ES 8720ES/8722ES
E8356A/E8357A/E8358A E8362A/E8363A/E8364A
E8801A/E8802A/E8803A

Table 1-3 Common Hardware Option Number Descriptions for Network Analyzers

E8362B, E8363B, and E8364B Network Analyzer Optionsa

a. Network analyzer should have firmware revision A.03.53 or later. Contact the 
factory for information regarding PLTS support of earlier firmware revisions.

010 Time Domain Capability 014 Configurable Test Set

016b

b. This option has not been tested and is not specified with the Physical Layer Test System.

Add Receiver Attenuators 022 Extended Memory

080b Frequency Offset 081b External Reference Switch

083b Frequency Converter Measurement 
Application

711 Standard Power Range

UNL Extended Power Range with Bias Tees

N5230A Network Analyzer Options

010 Time Domain Capability 080b Frequency Offset

220 10 MHz−20 GHz, Standard Test Set 225 10 MHz−20 GHz, Configurable Test 
Set and Extended Power Range

420 10 MHz−40 GHz, Standard Test Set 425 10 MHz−40 GHz, Configurable Test 
Set and Extended Power Range

520 10 MHz−50 GHz, Standard Test Set 525 10 MHz−50 GHz, Configurable Test 
Set and Extended Power Range
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Installing the VNA-Based Physical Layer Test System Hardware
Step 3. Set Up the Network Analyzer
2. Using the network analyzer’s Installation and Quick Start Guide, set up the network 
analyzer. 

3. If you are installing your network analyzer in an equipment rack, be sure to leave at least 
2 rack units of space below the analyzer to install the test set.

NOTE For the N4420B or N4421A/B test set, connect the network analyzer to the test 
set before placing in the rack as a single unit on one set of rails. Refer to“Step 4. 
Attach the Network Analyzer to the Test Set” on page 12 for instructions.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Step 4. Attach the Network Analyzer to the Test Set 
(N4420B or N4421A/B Test Set Only)

If your test set is not an N4420B, an N4421A, or an N4421B, continue with “Step 5. Install the 
Test System on a Bench Top or in an Equipment Rack” on page 15.

The compatible network analyzers are attached to the N4420B and N4421A/B test sets using 
lock links at the front and locking feet at the rear. This hardware is supplied with the test set. 
Other network analyzers are not attached to test sets (N4415A, N4416A, N4417A, N4418A, 
and N4419A/B) using this hardware.

Preparing the Network Analyzer

1. Remove the four feet from the bottom of the network analyzer.

2. Remove the screws from the two lower rear panel standoffs.

3. Install the two rear locking feet where the standoffs were removed. Use part number 
Z5823-20239 on the left side of the analyzer and part number Z5823-20240 on the right 
side. Use the two longer screws to secure the feet to the analyzer.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Preparing the Test Set

4. Remove the trim strip from the top of the front frame.

5. Install the four lock links to the top of the front frame using eight screws.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 4. Attach the Network Analyzer to the Test Set
Attaching the Network Analyzer to the Test Set 

6. Place the network analyzer on top of the test set ensuring that the front frame of the 
network analyzer is positioned slightly forward of the lock links that are attached to the 
the test set. Then slide the network analyzer back so the lock links engage the front frame 
of the analyzer.

7. Secure the network analyzer’s lower locking feet to the test set’s upper locking feet by 
inserting the shorter two screws between the two pairs of locking feet, one on each side of 
the instrument as shown below. 

If the screw holes between the network analyzer’s lower locking feet are not aligned with 
the screw holes in the test set’s upper locking feet, loosen the screws securing the feet to 
the instruments slightly to align. 

8. Tighten all screws.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
Step 5. Install the Test System on a Bench Top or in an 
Equipment Rack
The test system can be installed on a bench top or in an equipment rack. 

In all installations, consider the following ventilation requirements when deciding where to 
set up your test system.

CAUTION Ventilation Requirements: 
When installing the product in a cabinet, the convection into and out of the 
product must not be restricted. The ambient temperature (outside the cabinet) 
must be less than the maximum operating temperature of the instrument by 
4 °C for every 100 watts dissipated in the cabinet. If the total power dissipated 
in the cabinet is greater than 800 watts, then forced convection must be used.

Refer to the section that applies to your installation.

• For bench top installation, continue on page 16.

• For equipment rack installation, continue on page 17.
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Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install on a Bench Top

1. Place the test set and the network analyzer on a bench top. In the example illustration 
shown below, the system is placed on a riser as an alternative to the bench top. Make sure 
that there is at least four inches of clearance on the sides and back of the system for 
adequate ventilation.

The front panel test cables are shown only as a reminder to make sure they can easily 
reach the test surface of the bench.

CAUTION Consider the ventilation requirement described on page 15 when selecting the 
location of your system.

2. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 21.
Chapter 116



Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install in an Equipment Rack

You may install the PLTS in an equipment rack in one of following two ways:

When you install the test set in an equipment rack, you will install rails in the rack to support 
the weight of the test set, attach the handles and the rack mount flanges to the test set, and 
secure the test set to the equipment rack.

1. Ensure that the front handle kit, the rack mount flange kit, and the rack mount rail set 
are complete.

NOTE If any items are damaged or missing from a kit, contact us (refer to “Contacting 
Agilent” on page 237) to order a replacement kit. Items within these kits are 
not individually available.

Removing Feet from VNA Leaving Feet attached to VNA

1. Install one set of rails into the 
equipment rack

2. Remove feet from Test Set and VNA
3. Attach mount flanges and the handles to 

Test Set
4. Attach mount flanges and the handles to 

VNA
5. Insert test set on rails in equipment rack 

and screw to rack
6. Place VNA on top of test set and screw 

VNA into rack
7. Bend Semi rigid interconnect cables to 

fit between the test set connector and the 
VNA connector

8. Connect semirigid between test set and 
VNA

1. Install one set of rails into the 
equipment rack

2. Remove feet from Test Set only
3. Attach mount flanges and the handles to 

Test Set
4. Attach mount flanges and the handles to 

VNA
5. Insert test set on rails in equipment rack 

and screw to rack
6. Place VNA on top of test set
7. Connect semirigid between test set and 

VNA

Handle Kit Contents Flange Kit Contents

• 4 Screws
• 2 Side Trim Strip
• 2 Handles
• Installation Instructions

• 4 Screws (Long)
• 4 Screws with Washers
• 4 Nuts with Metal Clips
• 2 Flanges
• Installation Instructions
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Step 5. Install the Test System on a Bench Top or in an Equipment Rack
2. Install the rails into the equipment rack using the instructions provided. Consider that the 
test set is two rack units high (3.5 inches). Mount the test set immediately below the 
network analyzer.

NOTE For the N4420B, N4421A, or N4421B test set, connect the network analyzer to 
the test set before placing in the rack as a single unit on one set of rails.

3. Attach the cabinet mount flanges and the handles to the sides of the front panel, using two 
long screws per side. (Attach the flanges to the outside of the handles.)

WARNING If an instrument handle is damaged, you should replace it 
immediately. Damaged handles can break while you are moving or 
lifting the instrument and cause personal injury or damage to the 
instrument.
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Step 5. Install the Test System on a Bench Top or in an Equipment Rack
4. Remove the feet before cabinet mounting the analyzer using the directions imprinted on 
the feet.

5. Ensure there is adequate clearance between the system cabinet and the sides and back of 
the test system for adequate ventilation.

CAUTION Consider the ventilation requirements described in “Step 5. Install the Test 
System on a Bench Top or in an Equipment Rack” on page 15 when selecting 
the location of your system.
Chapter 1 19



Installing the VNA-Based Physical Layer Test System Hardware
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
6. Lift the test set and slide it onto the rails that you installed earlier from the front of the 
equipment rack. Secure the test set to the equipment rack using the screws with washers 
and metal-clipped nuts provided in the flange kit.

7. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 21.
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Step 6. Make the Interconnections between the 
S-Parameter Test Set and the Network Analyzer

1. Locate your system or test set and network analyzer listed below. Refer to the page 
indicated for information describing the interconnections between the test set and the 
network analyzer.

2. Using the illustration and table located on the page referenced above in step 1, connect the 
interconnect cables between the test set and the network analyzer. Torque the semirigid 
cable connectors to 8 inch-pounds.

Test System 
Model Numbera

a. For interconnection information for the hardware models listed below, refer to Table B-4 on page 284.
PLTS Systems: N1947A, N1948A, N1951A, N1953A, N1957A
PLTS Test Sets: N4415A, N4416A, N4417A, N4418A, N4419A, N4421A
PLTS Network Analyzers: 8753ES, 8720ES/8722ES, E8356A/E8357A/E8358A, 

E8362A/E8363A/E8364A, E8801A/E8802A/E8803A

Test Set 
Model Numbera

Network Analyzer 
Model Numbera

Refer
to:

N1957B
N1955B

N1935A/N1953B

N4421B
N4420B
N4419B

E8364B
E8363B
N5230A Option 225/E8362B

page 23
page 25
page 27
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Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
CAUTION When connecting the interconnect cables described in the remaining pages of 
this section, be careful to install the interconnect cables correctly. The longer 
end of the interconnect cable connects to the network analyzer front panel 
connector. Refer to Figure 1-1 for the correct orientation. 

Figure 1-1 Interconnect Cable Orientation

Damage to the interconnect cable can result from improper connection of the 
cable.

TIP If the test set and the network analyzer are rack mounted, the screws securing 
the rack mount flanges to the instrument rack may be loosened slightly to allow 
for minor repositioning of the instruments. Don't forget to retighten the screws 
when you are done.

3. Continue with “Step 7. Set Up the General Purpose Interface Bus (GPIB)” on page 29.
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N1957B Test System Interconnections 

(or N4421B Test Set with E8364B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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N1955B Test System Interconnections 

(or N4420B Test Set with E8363B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
N1935A and N1953B Test System Interconnections 

(or N4419B Test Set with E8362B or N5230A Option 225 Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 AD00756-1 REF 1 SOURCE OUT REF 1 SOURCE OUT
2 AD00756-1 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 AD00756-1 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 AD00756-1 REF 2 SOURCE OUT REF 2 SOURCE OUT
5 AD00756-2 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 AD00756-2 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 AD00756-2 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 AD00756-2 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 AD00756-3 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 AD00756-3 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 AD00756-3 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 AD00756-3 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 AD00756-4 REF 1 on rear panel of the test set
14 AD00756-4 REF 2 on rear panel of the test set
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Step 7. Set Up the General Purpose Interface Bus (GPIB)
The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. The PLTS software will locate and identify your test system equipment 
automatically. Each test system device must have a unique GPIB address. 

NOTE There are 31 GPIB addresses, numbered 0 to 30. However, there may be the 
occasion that you need to change the GPIB address for test equipment. GPIB 
addresses are set either using rear panel switches or using the equipment 
firmware. Refer to “Setting Up the General Purpose Interface Bus Manually” in 
the PLTS User’s Guide for more information.

1. Connect a GPIB cable from the rear panel GPIB connector on the network analyzer to the 
rear panel GPIB connector on the test set.
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Step 7. Set Up the General Purpose Interface Bus (GPIB)
2. Connect a second GPIB cable from the PC GPIB card's connector to the GPIB connector on 
either end of the first cable that was connected.
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Step 8. Power up the S-Parameter Test Set
Step 8. Power up the S-Parameter Test Set

1. Ensure the available ac power supply meets the Power Source Requirements and the 
operating environment meets the Operating Environment Requirements listed below.

Refer to Chapter 5, “Specifications and Characteristics,” for the complete specifications.

2. Verify that the ac power cable is not damaged, and that the power-source outlet provides a 
protective earth contact.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage.

3. Turn off the PC and the network analyzer.

4. Connect the ac power cable from the power-source outlet to the ac input on the rear panel 
of the test set.

5. Turn on the PC, the network analyzer, and the test set by pressing the ON/OFF button on 
the front panel of each device.

Power Source Requirements
Input Voltage Range 100 − 120 Vac - or - 220 − 250 Vac
Frequency Range 47 − 62 Hz / 400 Hz
Power 40 VA maximum.

Operating Environment Requirements
Operating Environment Indoor use
Altitude Operating:

Storage: 
0 to 2.0 km (6,560 ft.)
0 to 15.24 km (50,000 ft.)

Temperature 0 °C to 40 °C
Maximum Relative Humidity 80% for temperatures up to 31 °C; decreasing 

linearly to 50% for a temperature of 40 °C
Chapter 1 31



Installing the VNA-Based Physical Layer Test System Hardware
Step 8. Power up the S-Parameter Test Set
6. If your network analyzer is an E8362A/B, E8363A/B, or E8364A/B, you will need to 
perform the Phase-Lock IF Gain Adjustment after it has been connected to the test set. 
This routine adjusts the R Channel receivers ALC gain to ensure phase lock over the 
entire frequency range. Refer to Phase-Lock IF Gain Adjustment in the network 
analyzer’s online help system for details. Use the following steps to perform this 
adjustment:

a. On the PNA, from the System menu, click Service, then Adjustments, then IF Gain 
Adjustment.

If you are unable to find these selections on your E836XA PNA, your analyzer firmware 
is a revision prior to 3.0. Refer to the “IF Gain Adjustment” section of the “Procedures” 
appendix in the PLTS User’s Guide for the adjustment procedure.

b. Select any special test set options installed.

c. No connections to the test ports are required.

d. Click Begin Adj. The adjustment takes about a minute to complete.

The advanced screen is for factory personnel only.

NOTE This adjustment must be performed before using the network analyzer each 
time the system is assembled or disassembled.

7. The PLTS hardware installation is complete. Continue with the PLTS software installation 
by referring to Chapter 3, “Installing the Physical Layer Test System Software,” on 
page 41.
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Installing the TDR-Based Physical Layer Test System Hardware
To make time domain measurements using the Physical Layer Test System (PLTS) software 
and a TDR system, you need the following equipment:

• Personal computer (PC)

• PLTS software

• TDR-based PLTS hardware (one of the following systems)

— Agilent 86100A/B/C Infiniium DCA Wide-Bandwidth Oscilloscope equipped with one or 
two 54754A Differential 18 GHz TDR/TDT Plug-in Modules using the following 
firmware revisions:

Agilent 86100A/B: Firmware Revision 03.06 or greater
Agilent 86100C: Firmware Revision 04.00 or greater

— Tektronix CSA8000 Communications Signal Analyzer equipped with one or two 80E04 
Dual Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or 
greater

— Tektronix TDS8000 Digital Sampling Oscilloscope equipped with one or two 80E04 
Dual Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or 
greater

Figure 2-1 TDR-based Physical Layer Test System Hardware: 
Tektronix CSA8000 (left) and Agilent 86100A/B/C DCA (right)

This installation procedure leads you through setting up the hardware (the PC and the 
TDR-based Physical Layer Test System). After you complete this installation, you will refer to 
Chapter 3, Installing the Physical Layer Test System Software, to install the software. 
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NOTE If you have the VNA-based Physical Layer Test System, refer to Chapter 1, 
“Installing the VNA-Based Physical Layer Test System Hardware,” on page 3 
for instructions on setting up that system.

The following is a list of the installation steps to set up your TDR system hardware:

• Step 1. Set Up the Personal Computer

• Step 2. Set Up the TDR System

• Step 3. Set Up the GPIB

• Step 4. Power up the TDR System

NOTE These installation instructions were written specifically for customers who 
have just received their TDR system with their PLTS software. If you have 
already been using your TDR system, you have probably completed most of 
these installation steps. Briefly review installation these steps to ensure that 
your system is currently set up as recommended. Then, begin the software 
installation process by starting at Chapter 3, “Installing the Physical Layer 
Test System Software,” on page 41.
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Step 1. Set Up the Personal Computer
Step 1. Set Up the Personal Computer

1. Make sure that your PC meets the following minimum system controller requirements:

NOTE Memory, both main and virtual, is critical to using PLTS effectively. There is no 
substitution for not having enough memory. As more applications are added to 
the PC, more memory is used. If your PC needs more memory, we suggest you 
take the time to remove unused programs. 

2. Using the PC documentation, make sure that the PC is operating properly.

3. Make sure the GPIB card is installed in the PC and that it is operating properly.

4. Make sure the PC is located near where you will position the oscilloscope-based TDR 
system. Later in this process, you will connect the GPIB card to the TDR system using a 
GPIB cable.

Table 2-1 Minimum PC Requirements by PLTS Modes of Operation

PC Requirement

Measurement Controller Mode Off-Line Analysis Mode

In the lab, controlling test equipment 
and making quick analysis of the 
results

In your office, performing “What if...” 
analysis, characterization, cross- 
domain analysis, filtering, waveform 
math, and eye diagram simulation

CPU 400 MHz Pentium II or greater 1 GHz Pentium III compatible PC

Main Memory 256 MBa

a. 512 MB of Main Memory is recommended for the Measurement Controller Mode when the 
measurement is measuring 16,000 points with the PNA B-model network analyzer.

512 MB

Virtual Memoryb

b. As a general rule for optimum PC performance when using PLTS, virtual memory should be 
1.5 to 2 times the size of the main memory.

512 MB 768 MB

GPIB Interface Agilent 82357A USB/GPIB Interface 
for Windows or supported GPIB card 
(any National Instruments or Agilent 
82340/41 or 82350 GPIB card)

No GPIB connection is required to 
utilize PLTS in the off-line mode. 
Saved (stored) measurement files can 
be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPc

c. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768

Display Colors High Color (16 Bit) or greater
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Step 2. Set up the TDR System

1. Unpack your system from the containers in which it was shipped.

WARNING The TDR system hardware can be heavy. Use proper lifting techniques. 
Refer to the TDR system’s documentation for information regarding 
the equipment weight.

2. Carefully inspect the system to make sure that it was not damaged during shipment.

If your TDR system was damaged during shipment, refer to the system’s documentation to 
contact the manufacturer. If the manufacturer is Agilent, refer to “Contacting Agilent” on 
page 237.

3. Using the TDR system’s documentation, set up the system as instructed, ensuring that the 
system’s permanent location is near the PC that was set up in Step 1 on page 36. 

CAUTION Both the Agilent and Tektronix TDR systems, although not required, may be 
connected to a computer network. Connecting to a computer network may 
present security risks to your TDR system. For the Agilent TDR system, refer 
to “Embedded Operating System Risk” on page iv for additional information. 
For the Tektronix TDR systems, refer to your system documentation for 
additional information.
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4. Ensure that your TDR system is one of the following: 

• Agilent 86100A/B/C Infiniium Digital Communications Analysis Wide-Bandwidth 
Oscilloscope with:

— Firmware: 86100A/B revision 03.06 or later / 86100C: revision 04.00 or later
— 1 or 2 Agilent 54754A 18 GHz Differential TDR/TDT Plug-In Modules installed

• Tektronix CSA8000 Communications Signal Analyzer Oscilloscope with:

— Firmware revision 1.3.3 (check with your Tektronix representative for firmware)
— 1 or 2 Tektronix 80E04 Dual Channel, 20 GHz TDR Sampling Modules installed in 

slot 1/2 and/or slot 3/4 only (no support for channels 5, 6, 7, or 8)

• Tektronix TDS8000 Digital Sampling Oscilloscope with:

— Firmware revision 1.3.3 (check with your Tektronix representative for firmware)
— 1 or 2 Tektronix 80E04 Dual Channel, 20 GHz TDR Sampling Modules installed in 

slot 1/2 and/or slot 3/4 only (no support for channels 5, 6, 7, or 8)

CAUTION Avoiding ESD Damage to TDR Plug-In Modules

The input connectors are very sensitive to electrostatic discharge (ESD). When 
you connect a device or cable that is not fully discharged to the input connector, 
you risk damage to the module and expensive instrument repairs. Refer to your 
TDR documentation for detailed information regarding ESD susceptibility.
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Step 3. Set Up the General Purpose Interface Bus (GPIB)
The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. The PLTS software will locate and identify your test system equipment 
automatically. Each test system device must have a unique GPIB address. 

Check the GPIB address of your Agilent TDR system by selecting Remote Interface from 
the Utilities menu on the TDR display. To check the GPIB address of your Tektronix TDR 
system, refer to the programming manual for information.

NOTE There are 31 GPIB addresses, numbered 0 to 30. However, there may be the 
occasion that you need to change the GPIB address for test equipment. GPIB 
addresses are set using the equipment firmware. Refer to “Setting Up the 
General Purpose Interface Bus Manually” in the PLTS User’s Guide for more 
information.

1. Connect a GPIB cable from the PC GPIB card's connector to the rear-panel GPIB 
connector on the TDR system.
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Step 4. Power up the TDR System
If you have not previously powered on your TDR system, start with step 1. If you have already 
powered on your TDR system, just review steps 1, 2, and 3 before continuing with step 4.

1. Ensure the available ac power supply meets the power source requirements and the 
operating environment meets the operating environment requirements for the TDR 
system. Refer to the TDR system documentation for the environmental specifications.

2. Verify that the ac power cable is not damaged, and that the power-source outlet provides a 
protective earth contact.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage.

3. Connect the ac power cable from the power-source outlet to the ac input on the rear panel 
of the test set.

4. Turn on the PC and the TDR system.

5. The TDR system hardware installation is complete. Continue with the PLTS software 
installation by referring to Chapter 3, “Installing the Physical Layer Test System 
Software,” on page 41.
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Installing the Physical Layer Test System Software
This chapter guides you through installing the Physical Layer Test System (PLTS) software. 
The software can be used 1) in the lab to control test equipment making measurements and 
make a quick analysis of the results, and it can be used 2) in your office to perform “What if...” 
analysis, characterization, cross-domain analysis, filtering, waveform math, and eye diagram 
simulation. 

• If you are making measurements in the lab, you should have already installed one of the 
following hardware systems:

— VNA-based system (Network analyzer and S-parameter test set) described in 
Chapter 1, “Installing the VNA-Based Physical Layer Test System Hardware”

— TDR-based system (Agilent TDR or Tektronix TDR) described in Chapter 2, “Installing 
the TDR-Based Physical Layer Test System Hardware”

NOTE Steps 1 and 2 of this chapter were performed during the hardware installation 
procedures described in Chapter 1 and Chapter 2. You may skip these steps if 
you already performed them.

• If you are performing analysis in your office, you will only need a PC to use the software.

This software installation chapter will lead you through a series of steps to install the PLTS 
software. The following is a list of the installation steps:

• Step 1. Set Up the Personal Computer 
(Skip this step if you already performed it during hardware installation.)

• Step 2. Verify your System Shipment 
(Skip this step if you already performed it during hardware installation.)

• Step 3. Install the Physical Layer Test System Software 

• Step 4. License the Physical Layer Test System Software

• Step 5. Start the Physical Layer Test System Software

• Step 6. Familiarize Yourself with the PLTS Software Screen
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Step 1. Set Up the Personal Computer
This procedure describes the steps that need to be performed if you plan to use PLTS in your 
office, performing “What if...” analysis, characterization, cross-domain analysis, filtering, waveform 
math, and eye diagram simulation and you do not plan to use this software to control test 
equipment and make measurements.

NOTE If you plan to control test equipment with the software, refer to “Set Up the 
Personal Computer” step in the appropriate chapter, either Chapter 1, 
“Installing the VNA-Based Physical Layer Test System Hardware,” or 
Chapter 2, “Installing the TDR-Based Physical Layer Test System Hardware.”

1. Make sure that your PC meets the following minimum system controller requirements:

2. Using the PC documentation, make sure that the PC is operating properly.

Table 3-1 Minimum PC Requirements for Off-Line Analysis Mode of Operation

CPU 1 GHz Pentium III compatible PC

Main Memory 512 MB

Virtual Memorya

a. As a general rule for optimum PC performance when using PLTS, virtual memory should be 1.5 to 2 
times the size of the main memory.

768 MB

GPIB Interface No GPIB connection is required to utilize PLTS in the off-line mode. Saved 
(stored) measurement files can be recalled at any time for analysis.

Operating Systems Windows 2000 or Windows XPb

b. Earlier versions of Windows are no longer supported by PLTS.

Screen Resolution 1024 × 768

Display Colors High Color (16 Bit) or greater
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Step 2. Verify your System Shipment

NOTE This procedure describes the steps that need to be performed if you only 
purchased the N1930A PLTS Software.

If you purchased a PLTS with the software, refer to “Verify your System 
Shipment” step in the appropriate chapter, either Chapter 1, “Installing the 
VNA-Based Physical Layer Test System Hardware.”

1. Unpack and carefully inspect the package to make sure that it was not damaged during 
shipment.

NOTE If the contents of your package were damaged during shipment, contact Agilent 
Technologies. Refer to “Contacting Agilent” on page 237.

Item Nr Part Nr Part Description

1 N1930-90003 User’s Guide (this document)

2 N1930A Physical Layer Test System Software CD-ROM (in envelope with 
Agilent Software License Terms printed on exterior)

3 N/A Software Entitlement Certificate (in envelope)

Not Shown N/A Agilent 86100 firmware upgrade on LM-120 and CD-ROM
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Step 3. Install the Physical Layer Test System Software 

CAUTION Before beginning the PLTS software installation, close any other applications 
that you computer is running. Not closing other applications could result in the 
loss of data because a reboot of the PC is required during the PLTS installation. 

In addition to loading PLTS files, PLTS installs other supported software programs that it 
requires. As part of the installation, PLTS may also install:

• Microsoft .NET Framework versions 1.03 and 1.1

• Microsoft Direct X

• Agilent IO Driver Libraries & VisaCom 

• Agilent T&M Programmers Toolkit Redistributable Package 1.0

• Crystal Reports 9.0 Runtime Engine (embedded components)

• Adobe1 Acrobat1 Reader 6.0 (if needed)

NOTE If you already have of these software packages installed on your PC, you will be 
asked if you want to upgrade to this version. If this version is newer than your 
version, please upgrade your software.

However, if your version is newer than the version PLTS wants to install, 
decline to load the PLTS version.

Use the following instructions to install PLTS depending on whether you have installed PLTS 
on your PC previously: 

• If you have not installed PLTS on your PC previously, follow the instructions in 
“Installation of PLTS for the First Time on your PC” on page 46. 

• If you are upgrading your computer with a new version of PLTS or just reinstalling PLTS 
after it was removed earlier, refer to “Installation of PLTS as a Software Upgrade” on 
page 56.

1. Adobe and Acrobat are trademarks of Adobe Systems Incorporated.
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Step 3. Install the Physical Layer Test System Software
Installation of PLTS for the First Time on your PC

1. Insert the PLTS software CD-ROM in your PC. The software should begin the installation 
process automatically. 

If the software does not start the automatic installation process, select Start > Run… in 
Windows as shown below. With the Run dialog box displayed, enter your CD-ROM drive 
letter followed by “\:Setup.exe”. For example, D\:Setup.exe. Then click OK and follow 
the onscreen instructions.

2. After the PLTS CD-ROM is started, the initial Agilent Physical Layer Test System Install 
Wizard screen is displayed. Select the Install Physical Layer Test System selection.
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The Agilent Physical Layer Test System Install Wizard screen also has selections that 
allow you to browse the CD, read the release notes, and visit the PLTS web site.

3. After you select the Install Physical Layer Test System selection, the Welcome to the 
Physical Layer Test System screen is displayed. Click the Next > button to continue the 
installation.
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4. Before installing PLTS, a license agreement is displayed. Read the agreement. You will be 
asked if you accept the terms of the license agreement. If you click No, the PLTS setup will 
close. To install PLTS, you must accept this agreement by clicking Yes.
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5. When asked to choose a destination location, you may use the default settings 
(recommended) or you may choose another directory. To use the default directory, just click 
the Next > button and continue with the installation. 

If you want to choose another directory, you may find and select the directory using the 
Browse… button.
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6. The PLTS InstallShield wizard asks you to review the settings. Use the default settings. 
Click Next > to continue copying the PLTS files to your PC.

7. The PLTS InstallShield wizard begins to install Microsoft.NET.
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8. After the Microsoft.NET installation is complete, you are prompted to restart your 
computer. Select Yes, I want to restart my computer now. 

9. After restarting your computer, restart the PLTS installation as described in step 1. You 
also need to repeat steps 2 through 7. 
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10.The PLTS InstallShield wizard begins the installation procedure again with Microsoft .Net 
program.
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11.After the Microsoft.NET Framework installation is complete, the PLTS InstallShield 
wizard begins to load the following support packages:

• Microsoft Direct X

• Agilent IO Driver Libraries & VisaCom 

• Agilent T&M Programmers Toolkit Redistributable Package 1.0

• Crystal Reports 9.0 Runtime Engine (embedded components)

• Adobe Acrobat Reader 6.0 (if needed)
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12.When the PLTS InstallShield wizard is complete, click the Finish button. The PLTS 
software installation is complete.
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13.PLTS communicates with instruments using a Microsoft Service, the PLTS Connection 
Manager. The log on for this service needs to be changed to from a local system account to 
a specific account. 

To make this change, select Start > Settings > Control Panel. From the Control Panel, 
select Administrative Tools and then Services. Double-click the Agilent PLTS 
Connection Manager selection. 

14. In the Agilent PLTS Connection Manager Properties dialog box window under the Log On 
tab, select the This account selection. Enter your user name with administrative 
privileges. Enter and confirm the password. Then click OK to save the change.

15.Continue with “Step 4. License the Physical Layer Test System Software” on page 68.
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Installation of PLTS as a Software Upgrade

1. Insert the PLTS software CD-ROM in your PC. The software should begin the installation 
process automatically. 

If the software does not start the automatic installation process, select Start > Run… in 
Windows as shown below. With the Run dialog box displayed, enter your CD-ROM drive 
letter followed by “\:Setup.exe”. For example, D\:Setup.exe. Then click OK and follow 
the onscreen instructions.

2. After the PLTS CD-ROM is started, the initial Agilent Physical Layer Test System Install 
Wizard screen is displayed. Select the Install Physical Layer Test System selection.
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The Agilent Physical Layer Test System Install Wizard screen also has selections that 
allow you to browse the CD, read the release notes, and visit the PLTS web site.

3. After you select the Install Physical Layer Test System selection, the Welcome to the 
Physical Layer Test System screen is displayed. Click the Next > button to continue the 
installation.
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4. The installation window for the PLTS version that is currently installed is displayed. 
Select the Remove selection and then click the Next > button.

5. Select the OK button to confirm the removal of the current PLTS version.

6. If you get the following dialog box, click the Don’t display this message again box and 
then click the Yes button.
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7. In some cases, the following dialog box may be displayed. If the dialog box is displayed, 
click the Don’t display this message again box and then click the Ignore button.

8. In some cases the following dialog box is displayed. If it is displayed, select the Yes, I want 
to restart my computer now selection. Then click the Finish button. 

The following message is displayed notifying you that a previous version of PLTS is being 
uninstalled (removed). 
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9. When the program has finished removing the original PLTS version and the following 
dialog box is displayed, click the Finish button.
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10.Before installing PLTS, a license agreement is displayed. Read the agreement. You will be 
asked if you accept the terms of the license agreement. If you click No, the PLTS setup will 
close. To install PLTS, you must accept this agreement by clicking Yes.
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11.When asked to choose a destination location, you may use the default settings 
(recommended) or you may choose another directory. To use the default directory, just click 
the Next > button and continue with the installation. 

If you want to choose another directory, you may find and select the directory using the 
Browse… button.
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12.The PLTS InstallShield wizard asks you to review the settings. Use the default settings. 
Click Next > to continue copying the PLTS files to your PC.
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13.The PLTS InstallShield wizard begins the installation procedure by installing the 
Microsoft .Net program.
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14.After the Microsoft.NET Framework installation is complete, the PLTS InstallShield 
wizard begins to load the following support packages:

• Microsoft Direct X

• Agilent IO Driver Libraries & VisaCom 

• Agilent T&M Programmers Toolkit Redistributable Package 1.0

• Crystal Reports 9.0 Runtime Engine (embedded components)

• Adobe Acrobat Reader 6.0 (if needed)
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15.When the PLTS InstallShield wizard is complete, click the Finish button. The PLTS 
software installation is complete.
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16.PLTS communicates with instruments using a Microsoft Service, the PLTS Connection 
Manager. The log on for this service needs to be changed to from a local system account to 
a specific account. 

To make this change, select Start > Settings > Control Panel. From the Control Panel, 
select Administrative Tools and then Services. Double-click the Agilent PLTS 
Connection Manager selection. 

17. In the Agilent PLTS Connection Manager Properties dialog box window under the Log On 
tab, select the This account selection. Enter your user name with administrative 
privileges. Enter and confirm the password. Then click OK to save the change.

18.Continue with “Step 4. License the Physical Layer Test System Software” on page 68.
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Step 4. License the Physical Layer Test System Software 
PLTS is sold with one of two type of licenses, either node-locked or network-server floating. 
The type of license that you have was decided when the software was purchased. 

A node-locked license entitles you to use the software on only one personal computer and 
the software enforces that restriction.

A network-server floating license entitles you to install the software license on only one 
server and check the license out to any personal computer on the server network that has 
PLTS installed. The software enforces the restriction that a license can checked out to one 
user at a time unless multiple PLTS network-server floating licenses are owned.

Stop! Determine the type of license that you own. Do not proceed until you have determined 
the type of license you own.

• If you own a node-locked license, continue with “Setting Up the Node-locked License” on 
page 68.

• If you own a network-server floating license, continue with “Setting Up the 
Network-Server Floating License” on page 70.

Setting Up the Node-locked License

This procedure instructs you how to license your Physical Layer Test System Software which 
is required before it can be used. The software is node-locked which means that license 
entitles you to use the software on only one personal computer (PC) and the software enforces 
that restriction. 

CAUTION The software is node-locked which means that license entitles you to use the 
software on only one personal computer and the software enforces that 
restriction. Make sure that you license the software to the correct PC.

During this procedure, you will identify the Host ID of that PC. The host ID is a unique 
identifier for that computer. Then, you will use the host ID to license the software to that 
unique identifier of your PC. Therefore, it is very important to affirm that you have loaded 
and are licensing the software to the correct PC.

1. In Windows, select Start > Programs and locate the Command Prompt selection on 
your PC. Open the Command Prompt window by clicking the Command Prompt 
selection. 
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2. In the Command Prompt window, change the directory to the License subdirectory in the 
PLTS subdirectory using the following command: 

The default directory that the software is loaded on is: C:\Program Files\Agilent. 
Therefore, enter the following command to change to the default directory:

 cd c:\Program Files\Agilent\PLTS\License 

Refer to the illustration in step 4 on page 69.

3. Run the lmhostid executable file that will display the host ID for the PC that you have 
installed the software on by entering the following command as shown in the following 
figure:

lmhostid

4. The host ID of the computer is displayed in window opened by the lmhostid.exe file. 
Write the host ID for your computer in the space provided below. You will need the host ID 
to license the software. 

5. Locate the Software Entitlement Certificate that was shipped with your software.

The certificate lists the Order Number and the Certificate Number for your software. 
These two numbers will also be used to license your software. It also lists the web site 
where you must register your software.

cd x:\dddd\ssss\PLTS\License
where, x is the letter of the drive the software was installed on.

dddd is the directory name the software was installed on.
ssss is any subdirectories the software was installed on.

Record the host ID 
for your computer here:
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6. Go to the Agilent web site listed on the Software Entitlement Certificate. Follow the 
instructions at the web site to receive your license file for the software. You will need to 
provide the following information:

• Order Number 
• Certificate Number
• Host ID for your computer that will run the PLTS Software

The web site will also ask you provide your e-mail address. The license file will be e-mailed 
to you promptly. 

7. Once you receive the E-mail with the attached license file, save the file to the “License” 
directory (the same directory that you used earlier to identify the host ID).

8. Make a back up of the license file and store in a safe location.

This back up file is very important! You may need this back up file if you encounter 
problems with your computer or if the license file is lost or erased.

9. Continue with “Step 5. Start the Physical Layer Test System Software” on page 76.

Setting Up the Network-Server Floating License 

This procedure instructs you how to set up PLTS with a Network License Server/Floating type 
of license. This type of license allows you use PLTS on one of many PCs (or clients), utilizing a 
single license on a common server. The server issues the license to any of the clients that 
attempt to run PLTS. If the license is already being used by another client, notification is 
provided that the license is in use. If you have multiple licenses of this type, multiple clients 
can be issued a license at the same time, up to the number of licenses installed.

CAUTION During this procedure, you will identify the Host ID of the server. The host ID is 
a unique identifier for a computer. Then, you will use the host ID to obtain a 
software license for that unique identifier of your server. Therefore, it is very 
important to affirm that you have loaded and are licensing the software to the 
correct server.

To use PLTS, the client PC must be on the same network as the license server.

NOTE With this type of license, a PC can be both a server and a client. This allows the 
PC to use the PLTS software or issue the license for other PCs on the network 
to use PLTS.

PLTS supports servers operating the Windows 2000 or Windows XP operating system.
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Preparing the License Server

To install Network License Server/Floating type of license after you have installed PLTS on 
your PC (one of the client machines): 

1. Copy the following files from your PC that has PLTS installed to the server: 

You will find these files in the license directory of the PLTS software. If you used the 
default path to set up PLTS on your PC, that path is:.

C:/Program Files/Agilent/PLTS/License

While you could save these files to any directory on your server, we recommend that you 
create a similar directory structure on your server.

Obtaining the License

2. On your license server, in Windows, select Start > Programs and locate the Command 
Prompt selection. Open the Command Prompt window by clicking the Command 
Prompt selection. 

3. In the Command Prompt window, change the directory to the License directory that you 
created to save the five files (the servers PLTS License directory): 

4. In the Command Prompt window, run the lmhostid executable file to display the host ID 
for the license server by typing:

lmhostid

5. The host ID of the server is displayed in the Command Prompt window. Write the host ID 
for your computer in the space provided below. You will need the host ID to license the 
software. 

agilent.exe lmgrd.exe lmhostid.exe lmtools.exe lmgrd.dl

cd x:\dddd\License
where, x is the letter of the drive where you created a directory for the 5 files.

dddd is all directory names between the drive letter and the License 
directory you created.

Record the host ID 
for your server here:
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CAUTION This software license is locked to a specific server that you provide information 
for when obtaining the license. Make sure that you obtain and provide the 
Host ID for the correct server when obtaining your license.

6. You also need the network computer name of the server to redeem license. To locate the 
network name of your server: From Windows Control Panel, double-click the System icon 
to open the System Properties dialog box. On the Network Identification tab, locate the 
Full Computer Name entry. The network computer name of the server is the first 
portion of the Full Computer Name. For example:

7. Locate the Software Entitlement Certificate that was shipped with your software.

The certificate lists the Order Number and the Certificate Number for your software. 
These two numbers will also be needed to license your software. 

The certificate also lists the web site where you must register your software.

8. Go to the Agilent web site listed on the Software Entitlement Certificate. Follow the 
instructions at the web site to receive your license file for the software. You will need to 
provide the following information:

• Order Number 
• Certificate Number
• Host ID for your PLTS license server
• Network Computer Name for your PLTS license server 

The web site will also ask you provide your e-mail address. The license file will be e-mailed 
to you promptly. 

Record the network computer 
name of your server here:
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Setting Up the License Server

9. Once you receive the E-mail with the attached license file, save the license file to the 
server’s PLTS License directory (the same directory that you created on your server to save 
the five files to earlier).

10.Make a back up of the license file and store in a safe location.

This back up file is very important! You may need this back up file if you encounter 
problems with your computer or if the license file is lost or erased.

11.In the server’s PLTS License directory, double click the lmtools.exe file to open the 
LMTools dialog box. Select the Config Services tab. On this tab:

a. In the Service Name list, select or enter AGILENT License Manager.
b. In the Path to the LMgrd.exe file text box, enter the path to the server’s PLTS 

license directory followed by the lmgrd.exe file name.
c. In the Path to the license file text box, enter the path to the server’s PLTS license 

directory followed by the file name of the license that you copied to the directory.
d. In the Path to the debug log file text box, enter the path to the server’s PLTS license 

directory followed by the lmgrd.dl file name.
e. Click the Use Services check box and then click the Start Server at Power Up check 

box to make the PLTS license available for PLTS on restart of the server.
f. Click the Save Service button to save the changes.
Chapter 3 73



Installing the Physical Layer Test System Software
Step 4. License the Physical Layer Test System Software
12.In the LMTools dialog box, select the Service/License File tab. On this tab, highlight 
AGILENT License Manager and click the Configuration using Services selection.
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13.In the LMTools dialog box, select the Start/Stop/Reread tab. On this tab, highlight 
AGILENT License Manager and click the Start Server button.

This step must be repeated each time the server is powered up if you did not click the 
Start Server at Power Up check box earlier in this procedure.

14.Continue with “Step 5. Start the Physical Layer Test System Software” on page 76.
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Step 5. Start the Physical Layer Test System Software 

1. Start the PLTS software by double-clicking the Launch Physical Layer Test System 
icon on the PC desktop.

You may also run the program by selecting Start, Programs, Agilent Technologies, 
Physical Layer Test System, Launch Physical Layer Test System.

2. The first time you start the software, you will be asked to identify the license type of the 
software. 
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When the dialog box is displayed:

• If you own a node-locked license:
Select Specify the License File and then click the Next > button. 

• If you own a network-server floating license:
Select Specify the License Server and then click the Next > button.

3. Based on the type of license you own:

• If you own a node-locked license: 

When this FLEXlm License Finder dialog box is displayed asking you to choose 
the license filename, click the Browse button and select the license file in the 
License directory. 

Once the directory and the license file is identified, the directory path is 
displayed in the FLEXlm License Finder dialog box. Select the Next> button.

• If you own a network-server floating license:

The client PC needs to be configured to look for the PLTS license on the Server. 
Enter the server’s network computer name that you recorded earlier.
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4. When the license is found and identified, select the Finish button to continue starting the 
software.

NOTE Make a back-up copy of the license file if you have not already done so.

5. After the licensing is completed, the software scans the GPIB bus to find the PLTS systems 
that are available to use.

The PLTS software looks for the following VNA-based and TDR-based PLTS systems:

• If the software recognizes one of the systems, it sets your software to make a 
measurement using the measurement wizard. You should review “Step 6. Familiarize 
Yourself with the PLTS Software Screen” on page 82.

Then, based on your PLTS system hardware, continue with either:

— Chapter 1 “Setting Up and Making Measurements using the VNA-Based PLTS” in 
the PLTS User’s Guide 

— Chapter 3 “Setting Up, Calibrating, and Making Measurements using the 
TDR-Based PLTS” in the PLTS User’s Guide

• If the software does not recognize one of the systems, it notifies you: “No instruments 
were detected. PLTS will operate in analysis-only mode.” This may be because:

You want to perform analysis only and do not have any PLTS system hardware 
connected to the GPIB. In this case, select the virtual instrument that be matches 

VNA-Based Systems: TDR-Based Systems:

N1957B (E8364B & N4421B) N1951A (8720ES & N4418A) Agilent 86100A/B/C

N1955B (E8363B & N4420B) N1948A (E8358A & N4417A) Tektronix CSA8000

N1953B (E8362B & N4419B) N1947A (E8803A & N4417A) Tektronix TDS8000

N1935A (N5230A Option 225 & N4419B)
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your PLTS system or if known, the system that was used to measure the data. 
Continue at “Step 6. Familiarize Yourself with the PLTS Software Screen” on 
page 82.

— PLTS does not recognize your system hardware or PLTS finds more than one system 
connected to your GPIB. Continue with the next step.

6. If the PLTS software does not recognize your system hardware or if it finds more than one 
system on the GPIB, it displays the Build Logical Measurement System dialog box. This 
dialog box allows you to identify your PLTS system hardware for the PLTS software.
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• To identify your VNA-based system (VNA with a test set) for the software:

a. In the Instruments Found list, click the model number of your network analyzer 
to highlight it. Then click the Primary Inst >> button which moves the model 
number to the text box at the right of the button. 

b. In the Instruments Found list, click the model number of your test set to highlight 
it. Then click the Secondary Inst >> button which moves the model number to the 
text box at the right of that button.

c. Click the Create System button which moves the combination of the devices to the 
Logical Measurement System box.

d. Click the OK button to save the system so the software identifies the PLTS system.

• To identify your TDR-based (or single-instrument) system for the software:

a. In the Instruments Found list, click the model number of your network analyzer 
to highlight it. Then click the Primary Inst >> button which moves the model 
number to the text box at the right of the button. 
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b. Click the Create System button which moves the device to the Logical 
Measurement System box. (Note that this step may be omitted for 
single-instrument systems, such as the TDR systems.)

c. Click the OK button to save the system so the software identifies the PLTS system.

NOTE If you can not get your system identifies, you can manually configure your 
system by selecting the Manual Configuration button to display the 
Hardware Configuration dialog box.

Select the primary instrument (typically at VNA or a TDR) from the Primary 
Instrument list. If necessary, select a secondary instrument (typically at test 
set) from the Secondary Instrument list. 

Enter the address for the primary instrument in the Analyzer Address text 
box and the secondary instrument in the Test Set Address text box. Also, 
enter the VISA Interface Name.
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Step 6. Familiarize Yourself with the PLTS Software Screen
This section describes the features of the Physical Layer Test System software. Refer to 
Figure 3-1, Main Window, for the locations of each of the software’s main features.

Figure 3-1 Main Window

Each of these areas are described in the remainder of this section. 

The software was designed with an informal flow down the left edge of the window in mind. It 
is an informal flow because with the flexibility of the software, this is an easy way, not the 

1. Title Bar 5. Parameter Bar 9. Marker Bar

2. Menu Bar 6. Format Bar 10. Plots Area

3. Toolbar 7. Scaling Bar 11. Measure Bar

4. Browser 8. Status Bar 
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only way to setup many of the features. For example, you may open a device file from areas 2 
and 3. Then you will select a data analysis that shows the open file in area 4. You will need to 
select parameters to display from area 5. If you need to change the format of the display, you 
change the format in area 6. Then you can adjust the scaling of the plots in area 7. 

1. Title Bar

The title bar (Figure 3-2) displays the title of the software. In the brackets, it also displays the 
file name of the data in the active plot window if the data has been saved. The data analysis 
type of the active plot window is also displayed. At the right side of the title bar, buttons are 
also provided quickly perform tasks at the program level. 

Figure 3-2 Title Bar

2. Menu Bar

The menu bar (shown in Figure 3-3) lists each of the drop down menu names currently 
available. When you click a menu name, the menu is displayed. The menu names and menus 
change to reflect appropriate choices for the data analysis type of the active plot window. 
Refer to Chapter 4, “Menu Reference,” for detailed information about each of the menu bar 
selections. 

When the active plot window is maximized, completely filling the plot area, the menu bar also 
displays three buttons to control the plot window.

Figure 3-3 Menu Bar

Clicking: Performs:

Minimizes the program window to the Windows task bar.

Toggles the program window to full screen mode.

Toggles the program window to partial screen mode.

Closes the program.
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3. Toolbar

The toolbar (Figure 3-4) provides buttons for beginning a new measurement, opening existing 
files, saving current data, copying current data, exporting data, removing plots, and printing.

Figure 3-4 Toolbar

Clicking: Performs:

Minimizes the plot window within the plot windows display area.

Toggles the plot window to partially fill the plot windows display area.

Closes the plot window.

Clicking: Performs:

New Starts the setup wizard so that a new measurement may be 
made.

Open Opens the Open dialog box so that an existing file may be opened.

Save Opens the Save As dialog box so that a file may be saved.

Copy Copies the active plot to the clipboard.

Export Bitmap Saves the active plot as a bitmap file (bmp).

Remove Plot Deletes the active plots.

Print Prints the active plots.

About Opens the About PLTS information.
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4. Browser

The browser (Figure 3-5) provides access to each measurement and data analysis type. 
Selecting a new Data Analysis type from the browser opens up a corresponding plot window. 
Each Data Analysis type may view multiple sets of data. 

• Clicking a bold label opens a new window in the plots area with that data analysis type.
• Clicking a non-bold label displays that plot and makes it the active plot in the plots area.
• Clicking the minus sign (−)hides the data selections for a given data analysis type.
• Clicking the plus sign (+) shows the data selections.

Figure 3-5 Browser
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5. Parameter Bar

The parameter bar (Figure 3-6) allows you to open a new plot, or add a new trace to an 
existing plot. Figure 3-6 shows the parameter bar for the balanced time domain plots. Each 
analysis type has a unique parameter bar specific to that type of analysis. Refer to Figure 
4-23, “Parameter Bars for Each Data Analysis Type” on page 114 to see all parameter bars.

Select New Plot and then click a parameter to display a new plot.

- or - 

Select New Trace and then click a parameter to overlay a new trace to an existing plot. 
Clicking the parameter a second time removes the added trace from the plot.

Figure 3-6 Parameter Bar for Balanced Time Domain Plots
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6. Format Bar

The format bar (Figure 3-7) is only available when the active plot window is a time domain or 
frequency domain selection. The format bars allow you to format the parameters for the active 
time domain or frequency domain plot window. To display the format bar, select Format Bar 
from the View menu. It is hidden with the same selection.

The time domain format bar differs from the frequency domain format bar. It has different 
format selections and it is divided into three areas. Therefore, the time domain format bar has 
three selections while the frequency domain format bar has one selection. Each format bar 
matches its corresponding Format menu (selected in the Menu bar.) The format bar and the 
title of each button for both time and frequency domain are shown below. 

Figure 3-7 Format Bars

For detailed information about each selection, 
refer to “Selecting Time Domain Display 
Formats” in the “Analyzing Data in the Time 
Domain” chapter of the PLTS User’s Guide.

For detailed information about each selection, 
refer to “Selecting Frequency Domain Display 
Formats” in the “Analyzing Data in the Frequency 
Domain” chapter of the PLTS User’s Guide.

Impulse Log Mag (default selection)

Step (default selection) Linear Mag

Volts (default selection) Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart

ns (default selection) Real

cm Imaginary
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7. Scaling Bar

The scaling bar (see Figure 3-8) allows you to change the scale on both the horizontal and 
vertical axis.

Figure 3-8 Scaling Bars

For time domain, the horizontal axis entries are units/division and delay. The vertical axis 
units are units/division and reference level.

For frequency domain and RLCG, the horizontal axis entries are the start frequency and the 
stop frequency. The vertical axis units are the units/division and the reference level.

NOTE When the time domain horizontal units per division is changed, the Delay 
value is reset to zero.
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8. Status Bar

The status bar (Figure 3-9) provides a visual indication of when conditions are happening 
within the software and the impedance associated with each system channel.

When any of the conditions listed below are active, an indicator adjacent to the condition title 
is displayed in a bright color. If the condition is not active, the color of the indicator is gray. 
The conditions are:

Figure 3-9 Status Bar

9. Marker Bar

The marker bar (Figure 3-10) allows you to add and display up to two markers to the active 
plot. The X-Y values of each cursor and the delta (the value of their difference) is displayed at 
the right edge of the plot. The eye diagram marker bar and the frequency domain polar and 
Smith chart marker bars differ slightly. Refer to “Markers” in the “Using Analysis Tools and 
Utilities” chapter of the PLTS User’s Guide for complete marker bar information.

Figure 3-10 Marker Bar

Measurement is bright when a measurement is being performed by the software.

Continuous sweep is bright when the measurement is being continuously swept.

De-Embedding is bright when the active plot has de-embedding data applied.

Port Rotation is bright when the active plot has reference impedance applied.

Hardware is bright when the hardware has been identified by the software.
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10. Plots Area

The plot windows (Figure 3-11) display the measurement results in the data analysis type 
selected. You select the data analysis type when you make a measurement, open existing data 
files, or make a selection in the browser. The Parameter Bar or the Data menu on the Menu 
bar allows you to display plots for all of the parameters or just the parameters you want to 
view. Multiple plot windows can be displayed in the plot window display area at the same time 
as shown in the figure.

Figure 3-11 Plot Windows in the Plots Area
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11. Measure Bar

The measure bar allows you to make measurements on your DUT without using the wizard. 
With a valid calibration file loaded, you may measure a single sweep or measure continuous 
sweeps.

Figure 3-12 Measure Bar
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Part II provides reference information related to operating the physical layer test system.

Chapter 4, “Menu Reference”

Provides you with descriptions of each menu bar selection in the test system 
software.

Chapter 5, “Specifications and Characteristics”

Provides you with the specifications and characteristics of the physical layer test 
system.

Chapter 6, “Test Set Front Panel and Rear Panel”

Provides you with specific information regarding each test set front panel and 
rear panel connector, switch, fuse, and LED indicator.

Chapter 7, “Troubleshooting and Maintenance”

Provides you with information about troubleshooting the test system, contacting 
Agilent for assistance, care of test cables and coaxial connectors, and 
electrostatic discharge.

Chapter 8, “Safety and Regulatory Information”

Provides you with information that will allow you to operate the test system 
safely. This chapter also lists the appropriate information required by regulatory 
agencies.
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Menu Reference
The following menus and each of their selections are described in detail in this chapter. Many 
of these menus are displayed only under specific measurement conditions. Refer to each 
specific menu on the pages listed for selections and conditions.

• File menu on page 97

• Measure menu on page 109

• View menu on page 111

• Utilities menu on page 117

• Tools menu on page 123

• Data menu on page 133

• Format menu on page 136

• RLCG menu on page 138

• Options menu on page 140

• Window menu on page 142

• Help menu on page 144
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File Menu
The File menu provides access to many standard software functions such as creating, 
opening, and saving data, importing and exporting files, creating a characterization report, 
printing, and exiting the software.

Figure 4-1 File Menu
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File Menu
New

Select New from the File menu to start a new measurement process and open the Startup 
Wizard window. 

Figure 4-2 Startup Wizard Window

Open

Select Open from the File menu to load a previously saved file.

Figure 4-3 Open Dialog Box
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Save

Select Save from the File menu to save the current measurement or calibration data. New 
data or imported data may be saved.

Until measurement data is saved, the plot window title bar is labeled PLTS along with the 
analysis type of the plot window and the sequential plow window number. Once the data is 
saved, the PLTS label is replaced with the name of the saved file. Figure 4-4 shows the plot 
window title bar before the data was saved and how it changes to match the file name 
(BTL_50M_6G_120PT.dut) after it is saved.

Figure 4-4 Plot Window Title Bar Changes After Data is Saved

Only one unsaved plot window may be open at a time. If you have one unsaved plot window, 
you must either save the data or delete the window before you can open another plot window 
with unsaved data.

Save As…

Select Save As… from the File menu to save new measurement or calibration data or 
existing data as a new file. 

Figure 4-5 Save As Dialog Box
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File Menu
Import

Select Import from the File menu to import a single-ended measurement data file. Then 
select either CITIFile to import a file in CITIfile format or Touchstone to import a file in 
Touchstone format. Then select from one of the port selections (either Port Configuration = 
1 & 3 -> 2 & 4 or Port Configuration = 1 & 2 -> 3 & 4) based on the system and calibration 
type used with the original measurement.

Figure 4-6 File Menu with Import and CITIFile Expanded

CAUTION PLTS will not import files with Power Sweep data. Attempting to import files 
with Power Sweep data could cause PLTS to close without notice.
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Figure 4-7 Balanced Transform Port Configuration Diagram

CITIFile

CITIFile imports data previously saved in CITIfile (*.cit) format. CITIfiles imported in this 
fashion can be used for comparison with other data sets using trace memory and math 
functions. Refer to Figure 4-7 and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using a TRL or LRM calibration or for all TDR 
measurements.

Touchstone

Touchstone imports data previously saved in Touchstone (*.S4P) format. Refer to Figure 4-7 
and choose from one of the following port selections.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using a TRL or LRM calibration or for all TDR 
measurements.

Export

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG….
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File Menu
Figure 4-8 File Menu with Export Expanded

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG….

Plot(s) to Clipboard exports the contents of the current plot window to the Windows 
clipboard.

Plot(s) to Image File exports the contents of the current plot window as an image file. When 
you export it, you may choose from Windows Bitmap (*.BMP), JPEG Bitmap (*.JPG), or Targa 
Bitmap (*.TGA) formats.

Frequency Domain exports the data of a single S-parameter (either single-ended or 
balanced) in one of four frequency domain formats: Real/Imaginary, Log Magnitude, Linear 
Magnitude, or Phase. All four formats are exported in tabular format as a text file, each with 
a header. The measured data is bounded by a BEGIN and an END message. The 
Real/Imaginary data of each measured point is exported as comma-separated values. 

Use the Frequency Domain Export dialog box shown in to select the S-parameter (all 
single-ended and balanced S-parameters are listed). Then click OK to export the data.
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Figure 4-9 Frequency Domain Export Dialog Box

CITIFile exports the current data in CITIfile format (*.cit).

Touchstone exports the current data in the S4P format which also has the following data 
format choices in which the data may be saved: 

• Magnitude, angle 

• dB, angle (power, angle)

• Real, imaginary

Figure 4-10 File Menu with Export and Touchstone Expanded
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Time Domain exports the current time domain data in text format (*.txt). It saves a name, 
the parameter and format information in a header. In the body, each X and Y measurement 
coordinate is displayed separated by a comma. These coordinates are bounded by a BEGIN 
and END message.

TDA MeasureXtractor exports measured data into the TDA MeasureXtractor format. Refer 
to the “TDA MeasureXtractor” section in the “Importing and Exporting” chapter of the user’s 
guide.

RLCG… exports the current W-element RLCG data into formats that can be used with either 
HSPICE or ADS applications.

Refer to the “RLCG” section in the “Importing and Exporting” chapter of the user’s guide for 
detailed information.

Characterization Report…

Click the File menu and then click Characterization Report… to start creating the 
characterization report. The Characterization Report dialog box is displayed. 

Figure 4-11 Characterization Report Dialog Box

For more information, refer to the “Characterization Report Generator” section in the “Using 
Analysis Tools and Utilities” chapter of the user’s guide.
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Print Setup…

Click the File menu and then click Print Setup… to review the printer settings. The Print 
Setup dialog box is displayed. The Print Setup dialog box allows you to select the destination 
printer and its properties, the paper size and printer paper source, additional network 
printers, and choose the orientation of the paper when printed.

Figure 4-12 Print Setup Dialog Box

If you are connected to other networks, click Network… to find additional printers.

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
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Print Preview…

Click the File menu and then click Print Preview… to review the active plot window prior 
to printing. The data is displayed in the preview window. The preview window allows you to 
move between multiple pages of data, zooming in and zooming out on displayed data, printing 
the data, and closing the window.

Figure 4-13 Displayed Data when Print Preview… is Selected
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Print…

Click Print… from the File menu to print the selected plots and display the Print dialog box. 
The Print dialog box allows you to select the destination printer and its properties, the range 
of pages to be printed, and the number of copies you wish to print.

Figure 4-14 Print Dialog Box

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
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Recent Files 

Open any of the four most recently accessed files by clicking the name of the file from this list. 
Only the four most recently accessed files are displayed. 

Figure 4-15 Opening Recently Accessed Files

Exit

Click Exit from the File menu to quit this program.
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Measure Menu
The Measure menu allows you to start a measurement, start and stop a continuous sweep 
measurement, and change the stimulus. 

Figure 4-16 Measure Menu

Continuous Sweep

Continuous Sweep sets the system to make measurements as the selected frequency span is 
swept continuously. After each measurement, the displayed data is updated.

To perform a continuous sweep measurement, select Continuous Sweep so that it has a 
check mark on its left side on the Measure menu. With Continuous Sweep active, the Start 
and Stop menu selections control continuous sweep. Select Start to begin a continuous 
measurement and select Stop to stop the measurement.

The Continuous sweep indicator on status bar means that system is currently in the 
continuous sweep mode. See Figure 4-17.

Figure 4-17 Continuous Sweep Indicator on the Status Bar

Start

Start begins a measurement when it is selected. When Continuous Sweep has a check 
mark, Start begins a continuous sweep measurement; otherwise it begins a single sweep 
measurement.

Stop

Stop stops a continuous sweep measurement.
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Stimulus…

Stimulus… opens the Modify Time and Frequency Parameters dialog box so that you can 
change the parameters. For detailed information regarding changing the stimulus 
parameters, refer to the stimulus information of the “Setting Up the Calibration and 
Measurement Parameters” section in the “Setting Up and Making Measurements using the 
VNA-Based PLTS” chapter of the user’s guide.
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View Menu
The View menu opens and closes the various tool bars. 

Figure 4-18 View Menu

Toolbar

The Toolbar provides quick access to several File menu features as well as two others. The 
features that are available on the Toolbar are New, Open, Save, Copy, Export Bitmap, 
Remove Plot, Print, and About.

Figure 4-19 Toolbar
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Status Bar

The Status Bar provides a graphic display of when several features are active. Each feature 
has a label on the left and an indicator just to the right side of the label. When a feature is 
active, the indicator is changed to a bright color. When the feature in not active, the indicator 
is gray. The impedance of each test system channel is displayed at the right side of this bar.

Figure 4-20 Status Bar

Browser

The Browser allows selection of data analysis type and the selection of plots to view. 
Selecting a data analysis type (a bold selection) opens a blank plot window for that analysis 
type. Selecting an existing plot (a non-bold selection) makes that plot active and displays it in 
the front of the plot window. 

Data analysis types that have a plot opened have either a “+” or a “−” to the left of the label. 
Select the “+” to display all plots of that type or the “−” to collapse and hide all plots.

Figure 4-21 Browser

Measurement is bright when a measurement is being performed
Continuous sweep is bright when a continuous sweep measurement is being performed
De-Embedding is bright when de-embedding is applied to the data
Port Rotation is bright when port rotation/extension is applied to the data
Hardware is bright when the software recognizes the GPIB-connected hardware
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Marker Bar

The Marker Bar allows you to add up to 2 markers to a plot. Simply select the plot, select the 
marker button, and click and drag the horizontal scroll bar in the window to move the marker 
in the plot. The marker X and Y values are displayed to the right of the plot. The frequency 
domain Smith Chart and Polar Chart formats allow you to choose between magnitude/phase 
and impedance styles. This is not available when time-domain gating is enabled.

Figure 4-22 Marker Bar

For marker information, refer to the “Markers” section in the “Using Analysis Tools and 
Utilities” chapter of the user’s guide.

Parameter Bar

The Parameter Bar displays each individual parameter for each specific data analysis type 
as well as the capability to display all of the parameters. See Figure 4-23 on page 114.

The time domain, frequency domain, and RLCG data analysis types also have the option to 
allow you to display multiple plots on the same plot or separate plots. For Time Domain, 
Frequency Domain, and Eye Diagram, refer to “Data Menu” on page 133 for detailed 
information. For RLCG, refer to “RLCG Menu” on page 138 for detailed information. 
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Figure 4-23 Parameter Bars for Each Data Analysis Type
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Gating Bar

The Gating Bar allows you to add up to 10 gates to a time domain plot. Select Gating from 
the Utilities menu to display this bar. After the time domain plot is displayed, slide the 
horizontal control to set the gate’s stop and start position and then press Add to add the gate 
to the plot. Gates may also be deleted and moved from this window. Refer to the “Gating” 
section in the “Removing Unwanted Effects from the Measurement” chapter of the user’s 
guide. This is only available when time domain Gating is enabled.

Figure 4-24 Gating Bar

Format Bar

The Format Bar displays the plot using the format selected from the bar. Format Bar is 
only available for Time Domain and Frequency Domain plots. As shown below, the Time 
Domain Format Bar differs from the Frequency Domain Format Bar. Refer to “Format Menu” 
on page 136 for a detailed description of each format item.

Time Domain Format Bar Frequency Domain Format Bar

For detailed information about each of the 
selections, refer to the “Selecting Time 
Domain Formats” section in the “Analyzing 
Data in the Time Domain” chapter of the 
user’s guide.

For detailed information about each of the 
selections, refer to the “Selecting Frequency 
Domain Formats” section in the “Analyzing 
Data in the Frequency Domain” chapter of 
the user’s guide.

Impulse Log Mag

Step Linear Mag

Volts Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart
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Scaling Bar

Scaling Bar allows you to change the scale of the active plot. There are two different scaling 
bars available. The analysis type determines the scaling bar that is displayed. Eye diagrams 
do not have an associated scaling bar.

Figure 4-25 Scaling Bar

Full Screen

Full Screen enlarges the Plot area to full screen by:

• Removing the Browser. The Browser may be turned on and off by selecting the View 
menu.

• Making the Parameter Bar, Scaling Bar, Format Bar, and Marker Bar free floating over the 
PLTS window. These tool bars may be turned on and off through the View menu.

Clinking the Full Screen selection again, turns of the Full Screen feature, returning the Plot 
area, Browser, and the tool bars back to normal.

ns (nanoseconds) Real

cm (centimeters) Imaginary

Time Domain Format Bar Frequency Domain Format Bar
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Utilities Menu
The Utilities menu provides access to calibration resources and several enhancement tools 
that you can use to provide a realistic analysis result.

Figure 4-26 Utilities Menu

Calibration

The Calibration selection allows you to start a calibration, characterize an adapter used for 
calibration, or edit the definition of mechanical calibration kits. 

Figure 4-27 Utilities Menu with Calibration Expanded
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Calibrate

Selecting Calibrate opens the wizard so that you may begin your calibration. Refer to the 
“Performing Error Correction on the VNA-Based PLTS” chapter of the user’s guide for 
detailed calibration information.

Figure 4-28 Calibration Wizard
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Characterize Adapter

Adapters used in measurements and calibration must be characterized to ensure accurate 
results. The Physical Layer Test System software has a wizard that steps you through this 
adapter characterization process. Select Characterize Adapter from the Utilities menu to 
start the Custom Adapter Characterization Wizard. This selection is available only when a 
network analyzer is the selected PLTS-based hardware.

Figure 4-29 Custom Adapter Characterization Wizard

A short/open/load calibration is performed directly at the network analyzer front panel test 
port with out any cables. Then the calibration is repeated with the adapter inserted. The 
resulting adapter S-parameters are saved in CITIfile format, which can later be de-embedded 
from the device measurement. 

To allow for best interpolation of adapters used in broadband measurements, characterize the 
adapter over the entire frequency range of the system with as many points as possible.

Your adapters must have an orientation, forward and reverse directions. Mark the connectors 
on the adapter as ports 1 and 2. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Refer to the “Characterizing Adapters” section in the “Performing Error Correction on the 
VNA-Based PLTS” chapter of the user’s guide for detailed instructions on performing adapter 
characterization.

Edit Cal Kit

The Edit Cal Kit feature gives you flexibility to make changes to your calibration kit 
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definition or to add new calibration kits. First, select the calibration type from the Select 
Calibration Type list. Then, from the Cal Kit column, select your calibration kit model 
number to edit an existing kit or select USER_DEF to define a new calibration kit.

Figure 4-30 Select Cal Kit Dialog Box

An Edit Calibration Kit dialog box is displayed allowing you to change the calibration kit 
parameters. The USER_DEF selection provides a blank dialog box that you can enter new 
parameter values. Refer to the list below for an illustration showing each of the Edit 
Calibration Kit dialog boxes and the location of detailed instructions for completing the 
calibration kit definitions.

Calibration Type To define the calibration kit, refer to the following sections

SOLT Refer to the “Defining a SOLT Calibration Kit” section in the 
“Performing Error Correction on the VNA-Based PLTS” chapter of 
the user’s guide.

TRL Refer to the “Defining a TRL Calibration Kit” section in the 
“Performing Error Correction on the VNA-Based PLTS” chapter of 
the user’s guide.

LRM Refer to the “Defining a LRM Calibration Kit” section in the 
“Performing Error Correction on the VNA-Based PLTS” chapter of 
the user’s guide.

4-Channel TDR Refer to the “To Define a Calibration Kit” section in the “Setting Up, 
Calibrating, and Making Measurements using the TDR-Based PLTS” 
chapter of the user’s guide.
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Reference Plane Adjustment…

Select Reference Plane Adjustment… from the Utilities menu to open the Reference Plane 
Adjustment dialog box. Use the Reference Plane Adjustment dialog box to add de-embedding, 
perform port rotation/extension, and change port impedances. 

Figure 4-31 Reference Plane Adjustment Dialog Box

Refer to the “To Use Port Reference Adjustment” section in the “Removing Unwanted Effects 
from the Measurement” chapter of the user’s guide.

One of two indicators can be lit when Port Reference Adjustments features are used. The 
De-Embedding indicator and the Port Rotation indicators are accessed in this dialog box.

Figure 4-32 De-Embedding and Port Rotation Indicators on the Status Bar
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Gating

Gating the time domain response provides the ability to mathematically remove the effect of a 
particular circuit element. By observing the original frequency domain response and the 
transformed frequency domain response, the effect of the gating operation on the S-parameter 
data can be seen. Refer to the “Gating” section in the “Removing Unwanted Effects from the 
Measurement” chapter of the user’s guide for additional information.

Click Gating from the Utilities menu. Then click either Gating (Single-Ended) or Gating 
(Differential) depending on whether your Time Domain plot is single-ended or differential.

Figure 4-33 Utilities Menu with Gating Expanded

Gating (Single-Ended)

Select Gating (Single-Ended) when you are planning to gate a single-ended Time Domain 
plot.

Gating (Differential)

Select Gating (Differential) when you are planning to gate a differential Time Domain plot.

Data Sharing

Data Sharing is used to overlay the plot of one measurement over the plot of another so that 
differences and similarities between the two plots can easily be viewed.

Refer to the “Data Sharing” section in the “Using Analysis Tools and Utilities” chapter of the 
user’s guide for additional information.
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Tools Menu
The Tools menu allows access to the Math, Bit Pattern, and T-Line Characteristics features. 
It also allows you to launch the startup wizard, set the velocity factor, change the time domain 
windowing, set the time domain start and stop times, and scan or select new data acquisition 
hardware.

Figure 4-34 Tools Menu

Math

The Math feature allows you to design and save a mathematical formula and to apply that 
formula to compare measured parameters. For example, you could use the math feature to 
determine noise immunity on a balanced line by calculating the common mode rejection ratio 
(CMRR) using the following equation:

You could also characterize the loss of a single-ended frequency domain measurement using 
the following equation:

CMRR SDD21( ) SCC21( )⁄=

Loss
1

2
------- S21 jS31+( )=
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Figure 4-35 Tools Menu with Math Expanded

Design

To create a formula for use with the measured data, select Design from the Math choice of 
the Tools menu. Select the domain, either Freq or Time and either SE (single-ended), Diff 
(differential for time domain) or Bal (balanced for frequency domain) in the Domain area. 
Click the Formula box and begin entering the equation using the buttons in the Data, Key 
Pad, and Functions areas. Enter your equation from left to right. When you have finished, 
enter a name in the Formula Name box and click the Save Formula button. When you have 
finished inputting equations, click the Close button. For more details, refer to the “Creating a 
Math Formula” section in the “Using Analysis Tools and Utilities” chapter of the user’s guide.

Figure 4-36 Create Formulas Dialog Box
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Apply

To apply a formula to the active data, display the Choose Variable Traces to Display dialog box 
by selecting Apply from the Math choice of the Tools menu. Then select the formula name 
from those displayed in the list. Click the Apply button to apply the formula to the active 
data and display a trace showing the data with the formula applied. 

Remove removes the selected formula from the active data and removes the trace shown 
when Apply was clicked. Delete removes the selected variable from the list in the dialog box. 
Exit closes the dialog box. 

Figure 4-37 Choose Variable Traces to Display Dialog Box

Bit Pattern

The Bit Pattern feature allows you to design a digital pattern and save the pattern. Then you 
can apply the digital pattern to eye diagram plots.

Figure 4-38 Tools Menu with Bit Pattern Expanded
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Design

Select Design from the Bit Pattern choice in the Tools menu to design a digital pattern 
using the Digital Pattern Generator. The Digital Pattern Generator allows you to create a 
pattern of between 8 and 32 bits. You may create the pattern in one of two ways, either 
clicking the numbered keys (0 to 31) or by typing the numeric value in either Binary (base 2), 
Octal (base 8), or Hexadecimal (base 16) formats. As you enter the pattern inputs, the pattern 
is displayed in the upper portion of the Bit Representation area.

Figure 4-39 Digital Pattern Generator

After the pattern has been created and is displayed correctly, save the pattern by entering a 
pattern name in the Save Pattern box and values in the Rise/Fall Time (pS), Data Rate 
(Gb/s), and Pattern Length boxes. Then select OK to save the digital pattern.

Apply

Apply a digital pattern to an eye diagram using the Choose a Digital Pattern for Eye 
Generation dialog box. This dialog box also allows you to change the values for the rise/fall 
time, data rate, pattern length, and number of patterns (arbitrary bitstream only). A digital 
pattern must be applied to view data using the eye diagram data analysis type.
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Figure 4-40 Choose a Digital Pattern for Eye Generation Dialog Box

After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.

• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
condition (or the time that it takes a signal to transition from a high to a low condition). 
Refer to the illustration titled “Rise/Fall Time and Data Rate” of the “Designing a Bit 
Pattern for Eye Diagrams” section in the “Analyzing Data using Eye Diagrams” chapter of 
the user’s guide for additional information regarding transition time.

• Data Rate (Gb/s) is the speed that data is transferred over a circuit or a communications 
line. Refer to the illustration titled “Rise/Fall Time and Data Rate” of the “Designing a Bit 
Pattern for Eye Diagrams” section in the “Analyzing Data using Eye Diagrams” chapter of 
the user’s guide for additional information regarding data rate.

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. 

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

For additional information, refer to the “Viewing Data using Eye Diagrams” section in the 
“Analyzing Data using Eye Diagrams” chapter of the user’s guide.

NOTE You may change the digital pattern using the dialog box shown in Figure 4-40 
by selecting Bit Pattern then Apply… from the Tools menu.
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T-Line Characteristics

T-Line Characteristics displays the RLCG data analysis T-Line Characteristics dialog box. 
This is the same dialog box that is displayed when any RLCG analysis is selected. Enter the 
length of the transmission line (in meters) and the highest frequency (in megahertz) in this 
dialog box to change the existing transmission line characteristics.

Figure 4-41 T-Line Characteristics

W-Element Display Configuration…

W-Element Display Configuration… displays the RLCG data analysis W-Element Display 
Configuration dialog box. This dialog box allows you to select either Fitted or Smoothed 
data traces to compare against the RLCG (W-Element) extracted data traces. When 
Smoothed data traces is selected, you may enter an odd-numbered integer to set the number 
of traces used in the smoothing mask. 

Figure 4-42 W-Element Display Configuration Dialog Box

For additional information, refer to the “Viewing Fitted and Smoothed RLCG W-Element 
Traces” section in the “Analyzing Transmission Line Parameters” chapter of the user’s guide.
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Tools Menu
Launch Startup Wizard

When Launch Startup Wizard is selected, this menu choice starts the Physical Layer 
Test System Startup Wizard. See Figure 4-43.

Figure 4-43 Startup Wizard

Set Velocity Factor

When Set Velocity Factor is selected from the Tools menu, the dialog box shown in Figure 
4-44 is displayed. Enter the new velocity factor in the Current Velocity Factor box and click 
OK. The maximum allowable value is 1.000000.

Figure 4-44 Set Velocity Factor Dialog Box
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Menu Reference
Tools Menu
Time Domain Window…

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed (see Figure 4-45). This dialog box allows you to set the Time Domain 
Window setting to one of three defined levels, Flat Response, Nominal (the default value), 
and Fast Rise Time or to a level you define. Refer to the “Time Domain Windowing” section 
in the “Analyzing Data in the Time Domain” chapter of the user’s guide for additional 
information.

Figure 4-45 Time Domain Window Dialog Box

• Flat Response gives the minimum side lobes and this provides the greatest dynamic 
range.

• Nominal gives reduced side lobes and is normally the most useful. This is the default 
setting.

• Fast Rise Time is essentially no window and therefore gives the highest side lobes.

• Custom allows you to create your own time domain window by selecting the spinner or 
entering a value in the box.

Time Domain Start and Stop Time…

When Time Domain Start and Stop Time… is selected, you can change the start and stop 
time values for your time domain plots that were converted from frequency domain 
parameters (S-parameters). The Time Domain Start and Stop Time dialog box is opened. See 
Figure 4-46. You can have these plots displayed in their full time range, automatically 
optimized, or you may change the start and stop time values manually. Refer to the 
“Optimizing the Time Domain Scale for Viewing” section in the “Analyzing Data in the Time 
Domain” chapter of the user’s guide for additional information.
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Tools Menu
Figure 4-46 Time Domain Start and Stop Time Dialog Box

Acquisition Hardware

Acquisition Hardware allows you to select Choose Data Acquisition Device… or Scan 
for New Hardware.

Figure 4-47 Tools Menu with Acquisition Hardware Expanded
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Tools Menu
Choose Data Acquisition Device…

The Choose Data Acquisition Device… selection displays all of the hardware that is 
detected in the Select Measurement System dialog box. See Figure 4-48. For example, the left 
dialog box shown in shows both an 86100A TDR-based PLTS, as well as an 8753ES 
VNA-based PLTS. When no hardware is detected, the software displays virtual PLTS 
hardware systems (two VNA-based and two TDR-based systems). A virtual PLTS hardware 
system allows you to use the software just like you would while using actual PLTS hardware 
with the exception of making a measurement. 

Figure 4-48 Select Measurement System Dialog Box

Select your hardware and click the OK button to change your hardware.

Scan for New Hardware

The Scan for New Hardware selection causes the PLTS software to check the GPIB bus for 
connected hardware. After the bus has been scanned, the Select Measurement System dialog 
box that is shown in Figure 4-48 is displayed.
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Data Menu
Data Menu
The Data menu displays each individual parameter for each specific data analysis type as 
well as the capability to display all of the parameters. The time domain and frequency domain 
data analysis types also have the option to allow you to display multiple plots on the same plot 
or separate plots. Figure 4-49 shows each of the data menus and their selections. See also 
“Parameter Bar” on page 113.

Figure 4-49 Data Menu

Individual Parameter Selections

The individual parameter selections are based on the specific data analysis type. The 
following lists each data analysis type and its associated parameters:

• Time Domain (Differential)

TDD11, TDD12, TDD21, TDD22, TDC11, TDC12, TDC21, TDC22, 
TCD11, TCD12, TCD21, TCD22, TCC11, TCC12, TCC21, TCC22 
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Data Menu
• Time Domain (Single-Ended)

T11, T12, T13, T14, T21, T22, T23, T24, T31, T32, T33, T34, T41, T42, T43, T44

• Frequency Domain (Balanced)

SDD11, SDD12, SDD21, SDD22, SDC11, SDC12, SDC21, SDC22, 
SCD11, SCD12, SCD21, SCD22, SCC11, SCC12, SCC21, SCC22 

• Frequency Domain (Single-Ended)

S11, S12, S13, S14, S21, S22, S23, S24, S31, S32, S33, S34, S41, S42, S43, S44

• Eye Diagram (Differential)

TDD12, TDD21, TDC12, TDC21, TCD12, TCD21, TCC12, TCC21

• Eye Diagram (Single-Ended)

T12, T13, T14, T21, T23, T24, T31, T32, T34, T41, T42, T43

All

Selecting All displays: 

• All 16 of the time domain parameters if the active plot window is a time domain window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• All 16 of the frequency domain parameters if the active plot window is a frequency domain 
window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• 4 of the eye diagram parameters if the active plot window is a differential eye diagram 
window.

• All 12 of the eye diagram parameters if the active plot window is a single-ended eye 
diagram window.
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Data Menu
New Plot

When New Plot is chosen, selecting any of the time or frequency domain parameters will 
display a new plot with that parameter within the active plots window. If New Plot is chosen, 
selecting All displays all 16 of the time or frequency domain parameters on individual plots in 
one window. 

New Trace

When New Trace is chosen, selecting any of the time or frequency domain parameters will 
display a new trace within the active plot. If New Trace is chosen, selecting All displays all 
16 of the time or frequency domain parameters on a single plot.
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Format Menu
Format Menu
There are two versions of the Format menu, one for active displays in the time domain and 
another for active displays in the frequency mode. The Format menu is not displayed for 
displays in other modes. See also “Format Bar” on page 115.

Time Domain Format Menu

Figure 4-50 Format Menu for Time Domain Measurements

Refer to the “Selecting Time Domain Display Formats” section in the “Analyzing Data in the 

Impulse Sets the active time domain plot to show the response with an impulse 
stimulus.

Step Sets the active time domain plot to show the response with a step-voltage 
stimulus. This is the default setting.

Volts Sets the active time domain plot’s vertical axis to Volts mode. This is the 
default setting. 

Real Sets the active time domain plot’s vertical axis to Real mode.

Log Mag Sets the active time domain plot’s vertical axis to Log Mag mode.

Impedance Sets the active time domain plot’s vertical axis to impedance mode. Active 
only for reflection plots with a step stimulus.

ns Sets the active time domain plot’s horizontal axis to nanoseconds (ns). 
This is the default setting.

cm Sets the active time domain plot’s horizontal axis to centimeters (cm).
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Format Menu
Time Domain” chapter of the user’s guide for more information.

Frequency Domain Format Menu

Figure 4-51 Format Menu for Frequency Domain Measurements

Refer to the “Selecting Frequency Domain Display Formats” section in the “Analyzing Data in 
the Frequency Domain” chapter of the user’s guide for more information.

Log Mag Displays the active frequency domain plot in Log Magnitude format. This 
is the default setting.

Linear Mag Displays the active frequency domain plot in Linear Magnitude format.

Phase Displays the active frequency domain plot in Phase format.

Group Delay Displays the active frequency domain plot in Group Delay format.

Smith Chart Displays the active frequency domain plot in Smith Chart format.

Polar Chart Displays the active frequency domain plot in Polar Chart format.

Real Displays the active frequency domain plot in Real format.

Imaginary Displays the active frequency domain plot in Imaginary format.
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RLCG Menu
RLCG Menu
When any of the RLCG data analysis types are selected, the RLCG menu is displayed. Each 
of the four RLCG data analysis types has its own menu. Refer to Figure 4-52.

Figure 4-52 RLCG Menus

Individual Parameter Selections

The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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RLCG Menu
All

If New Plot is chosen, selecting All displays all eight parameters on individual plots in one 
window. If New Trace is chosen, selecting All displays all eight parameters on a single plot.

New Plot

When New Plot is chosen, selecting any of the RLCG parameters will display a new plot with 
that parameter within the active plots window. If New Plot is chosen, selecting All displays 
all eight parameters on individual plots in one window. 
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Options Menu
Options Menu
The Options menu provides access to the User Preferences dialog box

Figure 4-53 Options Menu

User Preferences

The User Preferences dialog box allows you to customize your Physical Layer Test System 
software. This dialog box has the following three tabs to choose from: General, 
Measurement, and Load/Save.

Figure 4-54 User Preferences Dialog Box

General

The General tab (see Figure 4-54) has the following choices:

• Perform Setup - when selected, the PLTS software, when it is next started, will operate 
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Menu Reference
Options Menu
as if it has just been installed and go through a complete setup routine. At the conclusion 
of this routine, the Perform Setup option is automatically turned off.

• Display feedback during operations - controls the display of informational and 
progress windows for various operations, such as the file conversion summary window and 
the measurement post-processing progress window. When selected, these windows are 
displayed; otherwise, these windows are hidden. This option’s default setting is ON. 

• Display Resource usage meter - controls the display of resource use meter in the tool 
bar above the plot windows. The resource usage meter displays the current plot usage and 
the analysis file capacity usage. This meter is turned ON when the usage reaches a critical 
stage. This option’s default setting is OFF. 

Figure 4-55 Resource Usage Meter

Measurement

The Measurement tab (see Figure 4-54) has the following choices:

• Beep when measurement is complete - when checked, the PC emits a beep to indicate 
that the measurement is complete.

• Show warning before uncalibrated measurements - when checked, a message is 
displayed confirming that you are making an uncalibrated measurement.

• Always optimize the Start and Stop Times when calculating the time domain 
data from frequency domain data - when checked, the time domain start and stop 
times are optimized for best viewing. This selection affects the Time Domain Start and 
Stop Time dialog box default optimize selection. Refer to the “Automated Start and Stop 
Settings in the Time Domain” section in the “Analyzing Data in the Time Domain” chapter 
of the user’s guide.

Load/Save

The Load/Save tab (see Figure 4-54) has the following choices:

• Save data in BMS Format - when checked, data is saved in Balanced Measurement 
System format.
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Window Menu
Window Menu
The Window menu provides an efficient method of working with analysis windows. It gives 
you the ability to add new analysis windows, arrange open analysis windows for optimum 
viewing, arrange the minimized analysis window icons, and select/display individual analysis 
windows.

Figure 4-56 Window Menu

New Window

New Window adds a new analysis window to the display area. The new window will display 
the analysis type that is currently selected.

Cascade

Cascade arranges all of the open plot windows to optimum and equal size with the active 
window arranged on top so that is fully displayed. Any window may be accessed by a single 
click.

Tile

Tile displays all open plot windows completely in the plot window area. Each plot window is 
reduced in size to accommodate new plot windows.

List of Open Analysis Windows

The Window menu also lists the open analysis windows below the standard Window menu 
selections. Each open analysis window is listed in the order they were opened with the most 
recent window listed at the bottom. The active analysis window is shown with a check mark 
displayed at its left side. Selecting a window from the list displays the window in the display 
area.
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Window Menu
Figure 4-57 List of Open Data Analysis Windows
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Help Menu
Help Menu
The Help menu provides access to information about the software.

Figure 4-58 Help Menu

Help…

The Help… selection displays the user’s guide in pdf format.

About PLTS…

The About PLTS… window displays the software version information.

Figure 4-59 About PLTS… Window
Chapter 4144



5 Specifications and Characteristics
145



Specifications and Characteristics
Definitions
NOTE For specifications and characteristics on the Physical Layer Test System model 
numbers listed below, refer to page 301 in Appendix B, “Reference Information 
for Discontinued Physical Layer Test System Hardware.”

N1947A, N1948A, N1951A, N1953A, N1957A

Definitions
All specifications and characteristics apply over a 25 °C ±5 °C range (unless otherwise stated) 
and 90 minutes after the instrument has been turned on.

Specification (spec.) Warranted performance. Specifications include guard bands to 
account for the expected statistical performance distribution, 
measurement uncertainties, and changes in performance due to 
environmental conditions.

Characteristic (char.) A performance parameter that the product is expected to meet 
before it leaves the factory, but that is not verified in the field 
and is not covered by the product warranty. A characteristic 
includes the same guard bands as a specification.

Typical (typ.) Expected performance of an average unit which does not 
include guard bands. It is not covered by the product warranty.

Nominal (nom.) A general, descriptive term that does not imply a level of 
performance. It is not covered by the product warranty.

Calibration The process of measuring known standards to characterize the 
system's systematic (repeatable) errors.

Corrected (residual) Indicates performance after error correction (calibration). It is 
determined by the quality of calibration standards and how 
well “known” they are, plus system repeatability, stability, and 
noise.

Uncorrected (raw) Indicates instrument performance without error correction. The 
uncorrected performance affects the stability of a calibration.
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Specifications and Characteristics
N1935A Electrical Specifications and Characteristics
N1935A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −5 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E5230A Option 225

Test Set: Agilent N4419B

Calibration Kit: Agilent 85052D 3.5 mm

Test Port Cables: Agilent N4419B Option B20

Calibration Technique: Four-Port SOLT

Table 5-1 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHz 60 dB (char.)

45 MHz to 500 MHz 70 dB

500 MHz to 2.0 GHz 100 dB

2.0 GHz to 10.0 GHz 100 dB

10.0 GHz to 20.0 GHz 70 dB
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Specifications and Characteristics
N1935A Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 5-2 Measurement Port Characteristics

Description Characteristic

45 MHz
to

2.0 GHz

2.0 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

Directivity 56 dB 42 dB 40 dB

Source Match 42 dB 36 dB 33 dB

Load Match 56 dB 42 dB 40 dB

Reflection Tracking ± 0.0025 dB ± 0.009 dB ± 0.013 dB

Transmission Tracking ± 0.020 dB ± 0.032 dB ± 0.050 dB
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Specifications and Characteristics
N1935A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 5-1 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 5-2 3.5 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1935A Electrical Specifications and Characteristics
Test Set Performance
Table 5-3 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 10 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 5.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 20.0 GHz 18 to 25 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

8.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 20 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
3.5 mm Connectors
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N1935A Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 5-4 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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Specifications and Characteristics
N1953B Electrical Specifications and Characteristics
N1953B Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −5 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8362B Options 014 and UNL

Test Set: Agilent N4419B

Calibration Kit: Agilent 85052D 3.5 mm

Test Port Cables: Agilent N4419B Option B20

Calibration Technique: Four-Port SOLT

Table 5-5 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHz 60 dB (char.)

45 MHz to 500 MHz 70 dB

500 MHz to 2.0 GHz 100 dB

2.0 GHz to 10.0 GHz 100 dB

10.0 GHz to 20.0 GHz 85 dB
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Specifications and Characteristics
N1953B Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 5-6 Measurement Port Characteristics

Description Characteristic

45 MHz
to

2.0 GHz

2.0 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

Directivity 56 dB 42 dB 40 dB

Source Match 42 dB 36 dB 33 dB

Load Match 56 dB 42 dB 40 dB

Reflection Tracking ± 0.0025 dB ± 0.009 dB ± 0.013 dB

Transmission Tracking ± 0.020 dB ± 0.032 dB ± 0.050 dB
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Specifications and Characteristics
N1953B Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 5-3 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 5-4 3.5 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1953B Electrical Specifications and Characteristics
Test Set Performance
Table 5-7 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 10 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 5.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 20.0 GHz 18 to 25 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

8.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 20 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
3.5 mm Connectors
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Specifications and Characteristics
N1953B Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 5-8 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
N1955B Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8363B Options 014 and UNL

Test Set: Agilent N4420B

Calibration Kit: Agilent 85056A 2.4 mm

Test Cables: Agilent N4420B Option B20

Calibration Technique: Four-Port SOLT

Table 5-9 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHz 55 dB (char.)

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 40.0 GHz 55 dB
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 5-10 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

40.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
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Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 5-5 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure 5-6 2.4 mm Reflection Magnitude and Phase Uncertainty
Chapter 5 159



Specifications and Characteristics
N1955B Electrical Specifications and Characteristics
Test Set Performance
Table 5-11 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 10 MHz to 40.0 GHz 

Transition Time 
(10 to 90%, TR=.72/BW)

18 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 40.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 40 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
2.4 mm (m) Connectors
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N1955B Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 5-12 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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N1957B Electrical Specifications and Characteristics
N1957B Electrical Specifications and Characteristics

The following specifications are applicable for the systems in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8364B Options 014 and UNL

Test Set: Agilent N4421B

Calibration Kit: Agilent 85056A 2.4 mm

Test Cables: Agilent N4421B Option B20

Calibration Technique: Four-Port SOLT

Table 5-13 System Dynamic Range

Frequency Range Specification Supplemental 
Information

10 MHz to 45 MHz 55 dB (char.)

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 50.0 GHz 55 dB
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Specifications and Characteristics
N1957B Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 5-14 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

50.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
Chapter 5 163



Specifications and Characteristics
N1957B Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure 5-7 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure 5-8 2.4 mm Reflection Magnitude and Phase Uncertainty
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N1957B Electrical Specifications and Characteristics
Test Set Performance
Table 5-15 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 10 MHz to 50.0 GHz 

Transition Time 
(10 to 90%, TR=.72/BW)

14 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 50.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 50 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
2.4 mm (m) Connectors
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Specifications and Characteristics
N1957B Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 5-16 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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General Characteristics
General Characteristics
The test set environmental operating conditions and physical characteristics are displayed on 
the following pages.

Environmental Operating Conditions

The environmental operating conditions for the test set are listed below.

This product is designed for use in INSTALLATION CATEGORY II and POLLUTION 
DEGREE 2, per IED 61010-1 and 664, respectively.

Table 5-17 Test Set Environmental Operating Conditions

Description Conditions

Operating Environment Indoor use

Altitude

Operating: 0 to 2.0 km (6,560 ft)

Storage: 0 to 15.24 km (50,000 ft)

Temperature 0 °C to 40 °C

Maximum Relative Humidity 80% for temperatures up to 31 °C decreasing 
linearly to 50% for a temperature of 40 °C
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General Characteristics
Physical Characteristics

The weight and dimensions for the test sets are listed below.

Weight and Dimensions

Table 5-18 Test Set Weight and Dimensions

 Model Number Weight Dimensions

Height (A) Width (B) Depth (C)

N4419B 9.0 kilograms
(19.9 pounds)

3.0 in
(7.62 cm)

16.75 in
(42.55 cm)

19.25 in
(48.90 cm)

N4420B and N4421B 9.0 kilograms
(19.9 pounds)

5.5 in
(13.97 cm)

16.75 in
(42.55 cm)

16.75 in
(42.55 cm)
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Test Set Front Panel and Rear Panel
This chapter provides a graphical overview of the test sets used as part of the physical layer 
test system. This chapter also illustrates the front and rear panels of the S-parameter test 
sets separately. The features of each front and rear panel (such as connectors, switches, LEDs, 
and fuses) are identified and briefly described.

The individual network analyzer features are described in the network analyzer 
documentation. They are not be described in this document!

The front and rear panel of each S-parameter test set model is illustrated and described. Refer 
to the page number listed below for your test set model number.

NOTE For front and rear panel information on the test set model numbers listed 
below, refer to page 322 in Appendix B, “Reference Information for 
Discontinued Physical Layer Test System Hardware.”

N4415A, N4416A, N4417A, N4418A, N4419A, N4421A

For Model Number: Refer to:

N4419B page 172

N4420B page 176

N4421B page 180
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N4419B
N4419B 

N4419B Front Panels

ID 
Number

Front Panel 
Feature

Feature Description 

1 REFERENCE 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 SOURCE OUT connector using a semirigid cable.

2 REFERENCE 1 
RCVR R1 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 RCVR R1 IN connector using a semirigid cable.

3 PORT 2 PORT 2 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB STATUS Three LEDs (R, T, and L) that display the GPIB status of the test set 
when it is communicating with the network analyzer. R = Remote 
Operation, T = Talk mode, L = Listen mode.

5 POWER ON/OFF switch that disconnects the mains circuits from the mains 
supply before other parts of the test set. The front panel POWER 
switch disconnects the mains circuits from the mains supply after 
the EMC filters and before other parts of the instrument.

6 PORT 4 PORT 4 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)
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7 REFERENCE 2 
RCVR R2 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 RCVR R2 IN connector using a semirigid cable.

8 REFERENCE 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 SOURCE OUT connector using a semirigid cable.

9 PORT 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 2 
SOURCE OUT connector using a semirigid cable.

10 PORT 2 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR ARM connector using a semirigid cable.

11 PORT 2 RCVR 
B IN

SMA (f) connector that is connected to the network analyzer PORT 2 
RCVR B IN connector using a semirigid cable.

12 PORT 2 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR THRU connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the Agilent 
N4430A/B ECal module to provide ECal capability.

14 PORT 1 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR THRU connector using a semirigid cable.

15 PORT 1 RCVR 
A IN

SMA (f) connector that is connected to the network analyzer PORT 1 
RCVR A IN connector using a semirigid cable.

16 PORT 1 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR ARM connector using a semirigid cable.

17 PORT 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 1 
SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description 
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N4419B Rear Panel

ID 
Number 

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number 

Rear Panel 
Feature

Feature Description
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N4420B

N4420B Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)
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6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.

7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4420B Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  2.4 mm (f) connector, used as an output reference signal

2 REF 2 R IN  2.4 mm (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

4 REF 1 R IN 2.4 mm (f) connector, used as an input reference signal

5 REF 1 R OUT 2.4 mm (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250 Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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N4421B

N4421B Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)
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6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.

7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4421B Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  2.4 mm (f) connector, used as an output reference signal

2 REF 2 R IN  2.4 mm (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

4 REF 1 R IN 2.4 mm (f) connector, used as an input reference signal

5 REF 1 R OUT 2.4 mm (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250 Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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Electrostatic Discharge
Electrostatic Discharge
Although protected internally, test systems are sensitive to electrostatic discharge (ESD). 
Static discharges too small to feel can damage or degrade the test equipment or your devices.

Use standard precautions to protect against ESD before using the test system for calibration 
or measurement.

Use the following illustration and list of equipment to set up a static-safe workstation.

Figure 7-1 Static-Safe Workstation

• static-control table mat and earth ground wire: part number 9300-0797

• wrist-strap cord: part number 9300-0980

• wrist-strap: part number 9300-1367

• heel-straps: part number 9300-1308

• floor mat: not available through Agilent Technologies
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PLTS Installation Troubleshooting
This troubleshooting section is included to help you correct a variety of issues that you may 
encounter when you install PLTS. This section provides some background and gives solutions 
for correcting these PLTS installation problems. The issues that are covered in this section 
are:

• “Issues with .NET and the T&M Toolkit Versions” on page 188

• “Problems with the Agilent USB to GPIB Adapter” on page 190

• “Problems with the VISA Layer” on page 191

• “Problems with VISA COM (SOAP Error)” on page 191

• “Problems with using National Instruments I/O Devices” on page 194

• “I/O Troubleshooting Steps” on page 196

• “Upgrading from PLTS 1.102” on page 210

• “Missing Microsoft Component” on page 210
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Issues with .NET and the T&M Toolkit Versions

PLTS v2.x contains new functionality called the PLTS Connection Manager, that is designed 
to communicate with instruments and to scan for instruments connected to the bus. The PLTS 
Connection Manager is built on Agilent's Test and Measurement Programmers Tool Kit (T&M 
Toolkit), which requires Microsoft's .NET package. Figure 7-2 shows PLTS and it’s 
dependencies on other software products and how it communicates with instruments. 

Figure 7-2 PLTS v2.x Instrument Communication Hierarchy

• Microsoft .NET:

Microsoft .NET V1.0 must be installed on your PC. There are two revisions of .NET. They 
are 1.0 and 1.1. NET can be installed three ways. 

1. Load the runtime libraries (redistribution package) as with the PLTS installation.
2. Install the .NET Framework (downloadable from Microsoft).
3. Install a purchased version of Visual Studio .NET.

Multiple versions of the runtime libraries (in our redistribution package or downloaded 
from Microsoft) can be loaded at the same time. The studio version and the runtime 
libraries can also be loaded at the same time and may be different versions.
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• Agilent T&M Toolkit:

Agilent T&M Toolkit Version 1.0 must be installed on your PC. There are two versions of 
the T&M Toolkit. They are versions 1.0 and 1.1. T&M Toolkit can be installed two ways.

1. Load the redistribution package as with the PLTS installation.
2. Install a purchased version of the T&M Toolkit Development Environment product.

Only one version of the T&M Toolkit Development Environment can be loaded at the same 
time. However, one version of the development environment can be loaded with one or 
more redistribution packages.

• PLTS Connection Manager:

PLTS Connection Manager is automatically installed with PLTS v2.x. The PLTS 
Connection Manager is compiled against T&M Toolkit 1.0 and .NET 1.0. This means that 
some version of T&M Toolkit 1.0 and .NET 1.0 MUST be loaded on the computer for 
PLTS v2.x to work. T&M Toolkit was built such that it does not migrate forward, meaning 
that applications, like PLTS Connection Manager, that are built on T&M Toolkit 1.0 will 
not work on newer T&M Toolkit versions unless they are recompiled. The same is true of 
the .NET. PLTS requires .NET 1.0; T&M Toolkit will not work with .NET 1.1. Depending 
on what products have been previously installed, there may be different versions of these 
tools loaded. This means that a version of both .NET 1.0 and T&M Toolkit 1.0 must be 
loaded! See Table 7-1 for different supported configuration cases. 

Table 7-1 .Net − T&M Toolkit Configuration Matrix

Application Case Case

1 2 3 4 5 6 7 8 9

.NET runtime version 1.0 N/A 1.0 N/A 1.0 N/A 1.1 N/A, 
1.0, 
or 1.1

N/A, 
1.0, 
or 1.1

.NET Visual Studio or 
Framework version

N/A 1.0 N/A 1.0 1.0 or 
1.1

1.1 N/A 
or 1.1

N/A, 
1.0, 
or 1.1

N/A, 
1.0, 
or 1.1

T&M Toolkit 
redistribution version

1.0 N/A N/A 1.0 1.0 1.0 or 
1.1

1.0 or 
1.1

1.1, 
or 1.2

N/A, 
1.1, 
or 1.2

T&M Toolkit product 
version

N/A 1.0 1.0 N/A 1.0, 
1.1, 
or 1.2

1.0, 
1.1, 
or 1.2

1.0, 
1.1, 
or 1.2

N/A, 
1.1, 
or 1.2

1.1, 
or 1.2

PLTS Connection 
Manager works

Yes Yes Yes Yes Yes No No No No

N/A - Not Available (or Not Loaded)
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Case Descriptions:

• Cases 1, 2, 3, 4, and 5:PLTS Connection Manager works because some version of .Net 1.0 
and T&M Toolkit 1.0 are loaded.

• Cases 6 and 7: PLTS Connection Manager does not work because no version of 
.Net 1.0 is loaded.

• Cases 8 and 9: PLTS Connection Manager does not work because no version of 
T&M Toolkit 1.0 is loaded.

Problems with the Agilent USB to GPIB Adapter

Several problems can occur with the Agilent USB to GPIB adapter (Agilent 82357A). The 
Microsoft driver that was written for the adapter has some limitations. 

1. If the computer goes into hibernation with the adapter connected, the adapter will not 
work when the computer comes out of hibernation. 

2. If the adapter is connected to a docking station and the laptop is powered up (or rebooted), 
sometimes the adapter will not work. 

To get the adapter to work for either case, make sure the PC is fully powered up and Windows 
is functional, then unplug the USB connection and reconnect the adapter. The Microsoft 
Operating System will find the new hardware and a dialog box similar to Figure 7-3 will be 
displayed. It should remember your previous settings for the interface names, so click the 
Accept button and the adapter should operate correctly.

Figure 7-3 Agilent 82357A USB/GPIB Interface Detected Dialog Box
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Problems with the VISA Layer

For PLTS Connection Manager to operate correctly and consistently, the Agilent VISA needs 
to be the primary (or the only) VISA installed. If the NI VISA is installed first, it usually 
assumes the primary position. When loading the Agilent I/O libraries second (as with PLTS), 
the Agilent VISA should be set as the primary VISA. Problems may occur leaving the Agilent 
VISA as secondary VISA. Refer to Figure 7-5 through Figure 7-8 for more details. To quickly 
check the VISA status, see “I/O Troubleshooting Steps” on page 196 for directions.

Problems with VISA COM (SOAP Error)

The error message shown in Figure 7-4 may be displayed when running PLTS. This error is 
generated because the VISA COM was not loaded with the Agilent IO libraries. 

Figure 7-4 Scanning for Instruments Error Message

The VISA COM must be loaded for PLTS Connection Manager to work. If the IO libraries are 
already installed, uninstall then re-install the IO libraries. This can be done by re-installing 
PLTS or by down loading the IO libraries from the Agilent ADN web page: 

http://www.agilent.com/find/iolib

Choose the Full Installation selection during the PLTS installation. See Figure 7-5.
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Figure 7-5 Agilent IO Libraries M.01.01.04 Select Installation Option Screen

The Full Installation selection automatically loads the Agilent VISA COM and sets it as the 
primary VISA. See Figure 7-6.

Figure 7-6 Agilent IO Libraries M.01.01.04 Current Settings Screen

If you chose the Custom Installation selection, you must now choose how to install the 
VISA. Choose Option 1 Full install with Agilent VISA as primary (this method is used 
when loaded with PLTS) or Option 3 Runtime install with Agilent VISA as primary. See 
Figure 7-7.
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Figure 7-7 Agilent IO Libraries M.01.01.04 Select Type of Installation Screen

If you chose Option 6 Select individual components or reinstallation from the PLTS disk, 
you may get the display shown in Figure 7-8. 

Figure 7-8 Agilent IO Libraries version M.01.01.04 Screen

If so, make sure that the VISA and Make Agilent VISA Primary selections are selected.

A VISA COM only loader is available on the ADN web page: 

http://www.agilent.com/find/iolib
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Problems with using National Instruments I/O Devices

If you are using a PCMCIA or PCI NI GPIB, card, the NI software drivers should be loaded 
first before loading PLTS. There have been occasions where loading the NI software has been 
problematic. The installation may complete without any apparent errors. However, when 
running the National Instruments/NI488.2/Getting Started, an error is displayed indicating 
that the software was not loaded correctly and must be reloaded. Occasionally, getting past 
this problem has been difficult. Reloading does not seem to help. Sometimes there is a 
problem identifying the I/O card and getting it to work. In all cases, contact National 
Instruments technical support representative.

With the NI GPIB-USB-B adapter shown in Figure 7-9, use the latest NI drivers.

Figure 7-9 National Instruments GPIB-GPIB Adapter

The latest NI drivers can be downloaded from:

ftp://ftp.ni.com/support/gpib/ni488221/ni488221.exe (104 MB)

The NI VISA code can be downloaded from:

ftp://ftp.ni.com/support/visa/drivers/win32/3.0.1/visa301full.exe (68 MB)

If problems occur when trying to use the NI GPIB-USB-B interface, it may be necessary to 
force a clean installation by performing the following steps:

1. Uninstall PLTS v2.x.

2. Uninstall “all” NI products using Start, Settings, Control Panel, and Add/Remove 
Programs.

3. Reboot your computer.

4. Uninstall Agilent IO Libraries using Start, Settings, Control Panel, and Add/Remove 
Programs.

5. Uninstall Agilent VISA Com using Start, Settings, Control Panel, and Add/Remove 
Programs.

6. Uninstall the Agilent T&M Toolkit using Start, Settings, Control Panel, and 
Add/Remove Programs.
Chapter 7194



Troubleshooting and Maintenance
PLTS Installation Troubleshooting
7. Reboot your computer.

8. Install the new NI driver.

Reboot your computer if prompted.

9. Install NI VISA.

Reboot your computer if prompted.

10.Install PLTS v2.x. Ensure that the Agilent VISA Layer is the primary VISA. See 
Figure 7-18 on page 200.

11.For NI Labview code to run properly, you will need to enable TULIP Passport in NI 
Labview.
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I/O Troubleshooting Steps

This section provides some steps to troubleshooting the I/O section of the PLTS system. The 
steps include:

1. Troubleshooting the National Instruments (NI) software, hardware, and connections on 
page 197

2. Troubleshooting the Agilent I/O libraries on page 200

3. Verifying that the PLTS Connection Manager Service is configured correctly on page 205
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Troubleshooting the NI Software, Hardware, and Connections

If you are using a National Instruments (NI) GPIB card, troubleshoot the NI software, 
hardware, and connection by doing the following:

1. Click Start, Programs, National Instruments, NI-488.2, Getting Started Wizard to 
run the NI-488.2 Getting Started Wizard. See Figure 7-10.

Figure 7-10 National Instrument Getting Started Menu Selection

2. The NI-488.2 Getting Started Wizard (shown in Figure 7-11) is displayed. This wizard 
checks the status of the NI software and GPIB card. Click the Verify your hardware 
and software installation selection. 

Figure 7-11 NI-488.2 Getting Started Wizard

A dialog box similar to Figure 7-12 is displayed, indicating if the software and cards are 
working properly. If errors are identified, they must be resolved before continuing to the 
next step.
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Figure 7-12 NI-488.2 Troubleshooting Wizard

3. Click Start, Programs, National Instruments, NI-488.2, Explore GPIB as shown in 
Figure 7-13 to verify the NI driver and card can communicate with the instruments.

NOTE Make sure the GPIB interface cable is connected to the instruments. 

Figure 7-13 National Instrument Explore GPIB Menu Selection

4. When the Measurement & Automation Explorer window is displayed (Figure 7-14), click 
the “+” on the Devices and Interfaces item to show the configured interface cards. 
Right-click the interface and select Scan for Instruments. This starts a scan to detect all 
instruments connected to that interface card. 
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Figure 7-14 NI Measurement & Automation Explorer Window

The detected instruments are shown in the center pane of the window. See Figure 7-15.

If the connected instruments are correctly listed, then the National Instruments software, 
driver, GPIB card, and connection to the instruments are all properly working. If not, 
resolve the problem before continuing to the next step.

Figure 7-15 Center Pane of NI Measurement & Automation Explorer Window
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Troubleshooting the Agilent I/O Libraries

Troubleshoot the Agilent I/O libraries by doing the following:

1. When the Agilent IO Control is running, a blue IO icon is displayed in the task bar as 
shown in Figure 7-16. Right-click the IO icon. 

Figure 7-16 Agilent IO Control Icon

If the Agilent IO Control is not already running, start run it by clicking Start, 
Programs, Agilent IO Libraries, and IO Control.

2. Select About Agilent IO Libraries Control to verify that the Agilent libraries are 
installed and Agilent VISA is set as the primary VISA.

Figure 7-17 About Agilent IO Libraries Control Menu Selection

The displayed Agilent IO Libraries Control dialog box should indicate that the Agilent 
SICL libraries are installed and the Agilent VISA is set as the primary VISA. This is 
required for PLTS to work correctly. If either of these is not correct, reload the Agilent IO 
libraries.

Figure 7-18 Agilent IO Libraries Control Dialog Box
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3. Right-click the IO icon and select Run IO Config to run the IO Libraries Configuration. 
See Figure 7-19.

Figure 7-19 Run IO Config Menu Selection

This displays the Agilent IO Libraries Configuration – IO Config dialog box shown in 
Figure 7-20. Check that the desired GPIB interface is configured. If it is not, configure the 
interface by either selecting Auto Config or manually configure the interface by selecting 
the interface and clicking the Edit… button.

Figure 7-20 Agilent IO Libraries Configuration – IO Config Dialog Box
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4. For all GPIB interfaces used with PLTS, the VISA Interface Name and SICL Interface 
Name must be the same (including the case). For NI GPIB interfaces, the NI GPIB 
Board name must also be the same as shown in Figure 7-21. 

Click OK to complete the manual configuration and return to the Agilent IO Libraries 
Configuration – IO Config dialog box. 

Figure 7-21 GPIB Using NI-488.2 -- Configuration Dialog Box

5. Close the Agilent IO Libraries Configuration – IO Config dialog box by clicking the OK 
button.
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6. Right-click the IO icon and select Run VISA Assistant to confirm the GPIB card controls 
the instruments.

Figure 7-22 Run VISA Assistant Menu Selection

When the VISA Assistant is started, the instruments connected to the GPIB interface 
should be displayed in the VISA Assistant dialog box. See the right side of the VISA 
Assistant dialog box in Figure 7-23.

Figure 7-23 VISA Assistant Dialog Box -- Instrument Driver Tab
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7. To send a command to the instrument, select the Formatted I/O tab shown in Figure 
7-24.

Figure 7-24 VISA Assistant Dialog Box - Formatted I/O Tab

8. In the VISA Assistant dialog box, select a GPIB address in the right pane, and then select 
IEEE 488.2 in the Instr. Lang. area.

9. Click the *RST button to send a reset command to the instrument. Then click the *IDN? 
button to query the instrument for its ID string. 

The instrument information is displayed which verifies that the GPIB interface, driver 
and libraries are properly loaded and working, as well as the NI card, if it is being used.
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Verify that the PLTS Connection Manager Service is Configured Correctly

PLTS uses a program that runs as a service to communicate with instruments using the GPIB 
interface standard. When PLTS is installed the service is automatically installed and started. 
When using HP or Agilent GPIB cards everything works fine and nothing needs to be done. A 
defect in the VISA library can cause potential problems when using National Instruments 
GPIB cards. It is recommended that the “Logon as” for the service be changed from the default 
“Local System account” to a valid user on the network. Any user with administrator privileges 
will work. There are no registry entries for “Local System account”. Normal users have 
registry entries. To change to a valid network user, follow the instructions below. This only 
needs to be done once after PLTS is installed.

Check that the PLTS Connection Manager Service is configured correctly and running by 
doing the following:

1. Click the Start button then click Settings, Control Panel. See Figure 7-25.

Figure 7-25 Control Panel Menu Selection
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2. Double-click Administrative Tools in the Control Panel. See Figure 7-26.

Figure 7-26 Administrative Tools Menu Selection in Control Panel

3. Double-click Services in the Administrative Tools dialog box. See Figure 7-27.

Figure 7-27 Services Menu Selection in Services Dialog Box
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4. In the Services dialog box, double-click Agilent PLTS Connection Manager to display 
its properties. See Figure 7-28.

Figure 7-28Agilent PLTS Connection Manager Selection - Services Dialog Box

CAUTION If you have an Agilent Connection Manager selection as shown in 
Figure 7-29, do not change that service because it is not used by PLTS.

Figure 7-29Beware of Similar Connection Manager Selections

Agilent Connection Manager is used with other applications.
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5. First, click the Stop button to stop the running service and then select the Log On tab. 
See Figure 7-30.

Figure 7-30 Agilent PLTS Connection Manager Properties - General Tab
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6. Change the "Logon As" to a valid user on the network by selecting This account choice 
and then entering a valid user name (including the domain name followed by a backslash) 
and password as shown in Figure 7-31.

Figure 7-31 Agilent PLTS Connection Manager Properties - Log On Tab

7. Then click the OK button.

8. When the warning dialog box that is displayed, click the OK button. 

9. Select the General tab and then click Start button to restart the service.

10.Click the OK button to close the Agilent PLTS Connection Manager Properties dialog box 
for the service.
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Upgrading from PLTS 1.102

If version 1.102 of PLTS is loaded on the computer, it must be removed before installing PLTS 
v2.x. This can be done by starting the PLTS installation process using the PLTS v1.102 disk 
and selecting the Remove option as shown in Figure 7-32:

Figure 7-32 PLTS Installation Wizard - Remove Selection

CAUTION Any previously loaded PLTS versions must be removed before PLTS v2.x will 
load properly.

Be sure to reboot the computer after removing PLTS.

Start the PLTS v2.x installation process again. This time PLTS v2.x will load correctly.

Missing Microsoft Component

When installing PLTS, if the following error is displayed, comctl32.ocx has to be installed and 
registered.

'Component 'comctl32' or one of its dependencies not 
correctly registered: a file is missing or invalid'
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PLTS Hardware Troubleshooting 
Use Table 7-2 to help troubleshoot your Physical Layer Test System VNA-based hardware.

Table 7-2 Troubleshooting the PLTS VNA-Based Hardware

Symptom Cause Cure

One or more biases not 
applied.

Bias fuse blown. Check bias fuses. Replace blow 
fuse with fuse of the same type 
and rating. Refer to the test set 
rear-panel information in 
Chapter 6.

Control computer can't 
communicate with the test 
set.

Accidental change to GPIB 
switch settings.

Set the GPIB address as needed. 
Restart the test system. See 
“Step 7. Set Up the General 
Purpose Interface Bus (GPIB)” on 
page 29.

The test set does not come on 
the first time you use it.

Line fuse not installed, or 
incorrect line fuse installed.

Install the line fuse. Refer to 
“Replacing the Test Set Line 
Fuse” on page 219.

Excessive ripple in data. Load termination damaged by 
excessive RF power.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 237 for more information.

Loose connections between 
VNA and test set and/or 
between test set and DUT.

Check and torque the connectors.

Poor test cable repeatability. Replace test cables as needed. 
You can replace a single cable, 
without replacing the entire set.

High loss on one path with 
poor raw data match (as seen 
during analyzer sweep) or 
inability to make a good 
calibration.

Possible signal channel 
damage.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 237 for more information.
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Troubleshooting PLTS Using a Tektronix CSA8000 or TDS8000

PLTS is designed to use the following Tektronix equipment.

• Tektronix CSA8000 Communications Signal Analyzer equipped with one or two 80E04 
Dual Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or greater

• Tektronix TDS8000 Digital Sampling Oscilloscope equipped with one or two 80E04 Dual 
Channel, 20 GHz TDR Sampling Modules using Firmware Revision 1.3.3 or greater

If you are having problems getting PLTS to work with this equipment, the following is a basic 
troubleshooting procedure that should help you isolate the problem.

1. First, this procedure instructs you how to make sure the Tektronix equipment has basic 
operational functions. 

2. Then, this procedure instructs you how to make sure your PC has basic communication 
functions with the Tektronix equipment.

3. Finally, this procedure instructs you how to make sure PLTS is communicating with the 
Tektronix equipment.

Verifying the Tektronix System is Operational

The first step is verifying that the Tektronix instrument is operational. The first part of this 
step is to check that the instrument’s stimulus and receiver for each channel is operating. 
Then, the next part of this step is performing the compensation utility on the instrument and 
verifying the main frame and both channels of each 80E04 TDR sampling module pass.

Check each Channel’s Stimulus and Receivers are Operational  
Perform this procedure with nothing (no cables, connectors, or standards) connected to the 
TDR sampling module channel connectors.

1. Using the mouse, from the Setup menu, click Display for the Disp tab on the Setups 
window. With Normal selected, click the Show Vectors check box.

2. Select the TDR tab on the Setups window.

3. On TDR tab, for C1:

a. In the TDR Step area:

• Click the On check box
• Make sure the waveform is positive going 

b. In the ACQ area:

• Click the On check box
Chapter 7212



Troubleshooting and Maintenance
PLTS Hardware Troubleshooting
• Set the Units to volts (V)

c. In the Preset area:

• Click the C1 button

4. On the TDR sampling module, verify that the red TDR LED and the yellow SELECT 
ON/OFF LED for channel 1 (CH 1) is lit.

5. Verify that the display shows Channel 1 with an initial step 250 mV and a subsequent step 
of 250 mV because of the open circuit response.

6. Repeat for steps 3, 4, and 5 for each of the other channels to verify that each channel is 
operational. 

7. If the instrument does not match these results, contact your Tektronix representative.

Perform the Compensation  
Perform this procedure to verify that the instrument is operating with the instrument’s 
Compensation utility. The firmware will only allow you to start this utility after the 
instrument is sufficiently warmed. Typically, the longer the instrument has been powered on; 
the stability of the instrument is increased and results in better performance.

1. Under Utilities menu, select Compensation…

2. Make sure that Compensate in the Select Action area is selected. Then, select All from 
the list below. Choose Execute button to start the compensation utility on the mainframe 
and of all the TDR sampling module channels.

3. When the Compensation utility has finished (after approximately five minutes), make sure 
that the mainframe and each of the four module channels has passed.

4. Save the compensation data by selecting Save in the Select Action area and then 
choosing the Execute button.

5. Click the Close button to exit the Compensation utility.

6. If the Compensation utility fails, contact your Tektronix representative.

Verifying the GPIB Communication between the PC and the Tektronix System

The next step is verifying that the PC and the Tektronix instrument have two-way 
communication over the GPIB. To check the GPIB communication:

1. Check the GPIB address of the Tektronix instrument:

a. Select User Preferences on the Utilities menu.

b. Select the GPIB Configuration tab on the User Preferences window.
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c. Locate the address in the GPIB Address box.

d. Make sure that GPIB Talk/Listen is selected in the GPIB Mode area.

2. Click the Start button in the lower left corner of the PC. Then select Programs, Agilent 
IO Libraries, then VISA Assistant to open the Visa Assistant dialog box.

3. In Visa Assistant dialog box, make sure the Tektronix instrument’s GPIB address found in 
step 1 is listed the window. See Figure 7-33.

Figure 7-33 Instrument GPIB Address Displayed in VISA Assistant

4. Verify the PC and the Tektronix instrument have two-way communication over the GPIB:

a. Select the GPIB address listed in step 3, and then select the Formatted I/O tab. See 
Figure 7-34.
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Figure 7-34 Tektronix CSA8000 Response to *IDN? Button

b. Select IEEE 488.2 in the Inst. Lang. area.

c. Click the *IDN? button.

The PC queries the instrument at the address requesting instrument information. The 
Tektronix instrument should reply with a response that lists the manufacturer, the 
model number, and some additional information that includes the firmware version 
(FV).

If this response is received, two-way communication over the GPIB between the PC and 
the instrument is occurring.

5. If communication is not occurring, investigate your GPIB for problems.

Verifying PLTS is Operating with the Tektronix System

The first step is verifying that PLTS recognizes the Tektronix instrument. The next part is 
performing a basic PLTS calibration and measurement with the Tektronix instrument.

Verify PLTS Recognizes the Tektronix Instrument  
Start PLTS to ensure that PLTS finds and identifies the Tektronix instrument. This section 
does not go into detail with each PLTS step. Locate specific PLTS information in the PLTS 
User’s Guide.
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1. Start the PLTS software. PLTS scans for possible PLTS hardware on the GPIB.

• If the Tektronix instrument is found and displayed in the Select Measurement System 
dialog box (Figure 7-35) upon PLTS startup, skip the remaining steps and continue 
with “Verify the Tektronix Instrument Makes a PLTS Measurement”.

• If the Tektronix instrument is not found and displayed in the Select Measurement 
System dialog box upon PLTS startup:

a. From the PLTS Tools menu, select Acquisition Hardware, and then choose 
Choose Data Acquisition Device… to display the Select Measurement System 
dialog box manually.

b. If the Tektronix instrument is found and displayed in the Select Measurement 
System dialog box, skip the remaining steps and continue with “Verify the Tektronix 
Instrument Makes a PLTS Measurement”.

Figure 7-35 Select Measurement System Dialog Box

2. If the Tektronix instrument is not displayed in step 1:

a. From the PLTS Tools menu, select Acquisition Hardware, and then choose Scan for 
New Hardware to force PLTS to rescan for PLTS hardware on the GPIB. 

b. After the scan is complete, from the PLTS Tools menu, select Acquisition Hardware, 
and then choose Choose Data Acquisition Device… to display the Select 
Measurement System dialog box manually.

c. Check for the Tektronix instrument in the Select Measurement System dialog box. 
If it is found, continue with “Verify the Tektronix Instrument Makes a PLTS 
Measurement”. If it is not found, contact Agilent for assistance.

Verify the Tektronix Instrument Makes a PLTS Measurement  
After PLTS has found and identified the Tektronix instrument, make a basic measurement 
using the following instructions. This section does not go into detail with each PLTS step. 
Locate specific PLTS information in the PLTS User’s Guide.
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1. Select the Tektronix instrument in the Select Measurement System dialog box.

2. Start the PLTS measurement process. Use the default parameters for the TDR Setup and 
Calibration and Measurement Parameters wizard windows. Use the Generic 3.5mm 
calibration kit for the calibration.

3. For the measurement, connect a thru device between channel 1 and channel 3 and another 
thru device between channel 2 and channel 4.

4. Compare the Time Domain Differential results with the measurement plots shown in 
Figure 7-36. Each measurement plot has been autoscaled.

Figure 7-36 PLTS-Tektronix Measurement Example Plots

5. If your measurement results are similar to the measurement results shown above, your 
Tektronix instrument operates with the PLTS software. If it is not found, contact Agilent 
for assistance.
Chapter 7 217



Troubleshooting and Maintenance
Maintenance
Maintenance
This section provides basic maintenance information such as cleaning, fuse replacement, 
cable care, and connector care.

Cleaning

Clean the cabinet, using a dry or damp cloth only.

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A/B, N4420B, and N4421A/B) 
S-parameter test set from mains before cleaning. Use a dry cloth or one 
slightly dampened with water to clean the external case parts. Do not 
attempt to clean internally.
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Replacing the Test Set Line Fuse

To replace the line fuse, disconnect the power cord from the rear of the test set, use a small 
screwdriver to pry open the line fuse holder and slide it open until it reaches its stop. Replace 
the fuse in use with the spare fuse and slide the fuse holder back into the instrument. 

WARNING For continued protection against fire hazard replace the test set line 
fuse only with same type and rating (115V and 230V operation: T2.5A 
250V). The use of other fuses or material is prohibited.

Figure 7-37 Line Fuse Replacement
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Care of Test Cable Assemblies

Proper use and care of your test cable assemblies will yield positive results including:

• longer life

• higher performance

• better repeatability

Performing the routine inspection and cleaning of the test cable assemblies, especially the 
connectors, is very important to making the best possible measurements.

Connector Mating

Alignment of the center lines of the connectors of the test cables with the test set and DUT 
connectors before mating is important. It is possible to start the threads on the connector nuts 
without good alignment, but this will result in bent pins and damaged inserts. Resistance 
encountered while turning the connector nut may be due to one of the following:

• The pins are not aligned.

• The coupling nut is cross-threaded.

• The connector (or its mate) has been damaged by excessive torque.

Stop and determine the reason. To proceed without doing so risks the destruction of the 
assembly and the mating connector.

Holding a connector nut stationary while screwing the socket into the connector will wear 
away the connector plating and score the connector parts. If the pins lock up, serious damage 
can be caused.

Connector Torque

Make sure to grasp the body of the connector before applying final torque. If the connector 
body is allowed to rotate with the nut, the connector plating, outer interface rim, or pin 
assembly may be damaged. Excess torque applied to the connector will be transferred to the 
cable assembly. Refer to “Care of RF and Microwave Coaxial Connectors” on page 222 for more 
information. 
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Depending on the connector, over-torque can cause damage to connectors in a variety of ways: 

• mushroomed outer interface shells

• mushroomed pin shoulders

• recessed or protruding pins

• recessed or protruding dielectrics

• bent pins

• chipped plating

• coupling nut retaining ring damage

• damage to coupling threads

Cable Handling

The test cables have a 1 inch minimum bend radius. Exceeding this radius can result in poor 
measurements and poor repeatability. Be alert to tight bends where they are not necessarily 
obvious — like at the end of connector strain relief tubing.

Swept 90° adapters may be used (typically, at the test set front panel) to minimize cable 
bending. However, if the adapters are used, they must be in place during the calibration.

Cables are often stored in a coiled configuration. Coiled cable “set” (the tendency to stay 
coiled) can occur if the cables are left coiled. Use large coil diameters (one or two feet) to 
minimize cable set. Unroll coiled cables prior to use – never just pull out the loops.

Avoid pinching, crushing, or dropping objects on cable assemblies. Dragging a cable over a 
sharp edge will tend to flatten one side, and it is highly likely that the minimum bend radius 
will be exceeded.
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Care of RF and Microwave Coaxial Connectors

Proper connector care is critical for accurate and repeatable measurements. The following 
information will help you preserve the precision and extend the life of your connectors - saving 
both time and money. Prior to making connections to your test system, review the connector 
care information within this section.

This section is made up of three main subjects:

• Connector Care Reference
which contains information about:
❏ Safety Reminders
❏ Connector Cleaning Supplies
❏ Connector Care Quick Reference

• Connector Care Concepts
which contains information about:
❏ Connector Service Life
❏ Connector Grades and Performance
❏ Adapters as Connector Savers
❏ Connector Mating Plane Surfaces
❏ Gaging Fundamentals
❏ Handling and Storing Connectors

• Connector Care Procedures
which contains information about:
❏ Inspecting Connectors
❏ Cleaning Connectors
❏ Making Connections
❏ Separating Connections
❏ Gaging Connectors
❏ Using a Torque Wrench
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Connector Care Reference

This section includes the following information:

• Safety Reminders

• Connector Cleaning Supplies

• Connector Care Quick Reference

Safety Reminders  When cleaning connectors:

• Always use protective eyewear when using compressed air or nitrogen.

• Keep isopropyl alcohol away from heat, sparks and flame. Use with adequate ventilation. 
Avoid contact with eyes, skin and clothing. 

• Avoid electrostatic discharge (ESD). Wear a grounded wrist strap (having a 1 MΩ series 
resistor) when cleaning device, cable or test port connectors. 

Connector Cleaning Supplies  Products commonly used to clean connectors are listed 
below. To order these and other connector care products, contact Agilent Technologies.

Table 7-3 Connector Cleaning Supplies

Cleaning Supplies Description Agilent Part Number

Lint-Free Swabs, small 100 ct. 9301-1243

IPA 99.5% alcohol, 30 ml bottle 8500-5344

Compressed Air, 235 ml can 8500-6659
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Connector Care Quick Reference  Use the following table as a quick guide for connector 
care:

Table 7-4 Connector Care Quick Reference

Handling and Storage

Do Keep connectors clean Do Not Touch mating-plane surfaces

Extend sleeve or connector nut Set connectors contact-end down

Use plastic end-caps during storage

Visual Inspection

Do Inspect all connectors carefully Do Not Use a damaged connector - ever

Look for metal particles, scratches, 
and dents

Connector Cleaning

Do Try compressed air first Do Not Use any abrasives

Use isopropyl alcohol Get liquid into plastic support 
beads

Clean connector threads

Gaging Connectors

Do Clean and zero the gage before use Do Not Use an out-of-spec connector

Use the correct gage type

Use correct end of calibration block

Gage all connectors before first use

Making Connections

Do Align connectors carefully Do Not Apply bending force to connection

Make preliminary connection lightly Over tighten preliminary 
connection

Turn only the connector nut Twist or screw any connection

Use a torque wrench for final 
connect

Tighten past torque wrench 
“break” point
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Connector Care Concepts

This section includes the following concepts:

• Connector Service Life

• Connector Grades and Performance

• Adapters as Connector Savers

• Connector Mating Plane Surfaces

• Gaging Fundamentals

• Handling and Storing Connectors

Connector Service Life  Even though calibration standards, cables, and test set connectors 
are designed and manufactured to the highest standards, all connectors have a limited service 
life. This means that connectors can become defective due to wear during normal use. For best 
results, all connectors should be inspected and maintained to maximize their service life.

Visual Inspection should be performed each time a connection is made. Metal particles from 
connector threads often find their way onto the mating surface when a connection is made or 
disconnected. See Inspection procedure.

Cleaning the dirt and contamination from the connector mating plane surfaces and threads 
can extend the service life of the connector and improve the quality of your calibration and 
measurements. See Cleaning procedure.

Gaging connectors not only provides assurance of proper mechanical tolerances, and thus 
connector performance, but also indicate situations where the potential for damage to another 
connector may exist. See “Gaging Fundamentals” on page 228.

Proper connector care and connection techniques yield:

• Longer Service Life

• Higher Performance

• Better Repeatability
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Connector Grades and Performance  The three connector grades (levels of quality) for the 
popular connector families are listed below. Some specialized types may not have all three 
grades.

• Production grade connectors are the lowest grade and the least expensive. It is the 
connector grade most commonly used on the typical device under test (DUT). It has the 
lowest performance of all connectors due to its loose tolerances. This means that 
production grade connectors should always be carefully inspected before making a 
connection to the analyzer. Some production grade connectors are not intended to mate 
with metrology grade connectors. 

• Instrument grade is the middle grade of connectors. It is mainly used in and with test 
instruments, most cables and adapters, and some calibration standards. It provides long 
life with good performance and tighter tolerances. It may have a dielectric supported 
interface and therefore may not exhibit the excellent match of a metrology grade 
connector. 

• Metrology grade connectors have the highest performance and the highest cost of all 
connector grades. This grade is used on calibration standards, verification standards, and 
precision adapters. Because it is a high precision connector, it can withstand many 
connections and disconnections and, thus, has the longest life of all connector grades. This 
connector grade has the closest material and geometric specifications. Pin diameter and 
pin depth are very closely specified. Metrology grade uses an air dielectric interface and a 
slotless female contact which provide the highest performance and traceability.

NOTE In general, Metrology grade connectors should not be mated with Production 
grade connectors.

Adapters as Connector Savers  Make sure to use a high quality (Instrument grade or 
better) adapter when adapting a different connector type to the analyzer test ports. It is a 
good idea to use an adapter even when the device under test is the same connector type as the 
analyzer test ports. In both cases, it will help extend service life, and protect the test ports 
from damage and costly repair. 

The adapter must be fully inspected before connecting it to the analyzer test port and 
inspected and cleaned frequently thereafter. Because calibration standards are connected to 
the adapter, the adapter should be the highest quality to provide acceptable RF performance 
and minimize the effects of mismatch. 
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Connector Mating Plane Surfaces  An important concept in RF and microwave 
measurements is the reference plane. For a network analyzer, this is the surface or point that 
measurements are referenced to at calibration. In connectors, the reference plane is defined 
as the plane where the mating plane surfaces meet. Good connections require perfectly flat 
contact between connectors at all points on the mating plane surfaces (see Figure 7-38).

Figure 7-38 Connector Mating Surfaces (Reference Plane)
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Gaging Fundamentals  Connector gages are important tools used to measure center 
conductor pin depth in connectors. See Figure 7-39. Connector pin depth is generally the 
distance between the mating plane of the outer conductor and the end of the center conductor, 
or the shoulder of the center conductor for a stepped male pin. 

Figure 7-39 Typical Connector Gage
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Recession and Protrusion  Pin depth is negative (recession) if the center conductor is 
recessed below the outer conductor mating plane, usually referred to as the “reference plane”. 
Pin depth is positive (protrusion) if the center conductor projects forward from the connector 
reference plane. See Figure 7-40.

Figure 7-40 Connector Pin Depth

1. Recession of female contact

2. Recession of male pin shoulder

Some connectors, like Type-N connectors, have the mating plane of the center conductors 
offset from the connector reference plane. In this case the zero setting “gage masters” 
generally offset the nominal distance between the center conductor mating plane and the 
connector reference plane.

When to Gage Connectors  Connectors should be gaged at each of the following events:

• Before using a connector or adapter the first time.

• When visual inspection or electrical performance suggests the connector interface may be 
out of range.

• After every 100 connections, depending on use. 
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Connector Gage Accuracy  Connector gages (those included with calibration and 
verification kits), are capable of performing coarse measurements only. This is due to the 
repeatability uncertainties associated with the measurement. It is important to recognize 
that test port connectors and calibration standards have mechanical specifications that are 
extremely precise. Only special gaging processes and electrical testing (performed in a 
calibration lab) can accurately verify the mechanical characteristics of these devices. The pin 
depth specifications in the Agilent calibration kit manuals provide a compromise between the 
pin depth accuracy required, and the accuracy of the gages. The gages shipped with 
calibration and verification kits allow you to measure connector pin depth and avoid damage 
from out-of-specification connectors. 

NOTE Before gaging any connector, the mechanical specifications provided with that 
connector or device should be checked.

Handling and Storing Connectors   Use the following precautions when handling or 
storing connectors.

• Install protective end caps when connectors are not in use.

• Never store connectors, airlines, or calibration standards loose in a box. This is a common 
cause of connector damage.

• Keep connector temperature the same as analyzer. Holding the connector in your hand or 
cleaning connector with compressed air can significantly change the temperature. Wait for 
connector temperature to stabilize before using in calibration or measurements.

• Do not touch mating plane surfaces. Natural skin oils and microscopic particles of dirt are 
difficult to remove from these surfaces.

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).
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Connector Care Procedures

This section includes the following procedures:

• Inspecting Connectors

• Cleaning Connectors

• Making Connections

• Separating Connections

• Gaging Connectors

• Using a Torque Wrench

Inspecting Connectors  Use the following procedures when inspecting connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use a magnifying glass (>10×) and inspect the connector for the following conditions:

• Badly worn plating or deep scratches

• Deformed threads

• Metal particles on threads and mating plane surfaces 

• Bent, broken, or misaligned center conductors

• Poor connector nut rotation

CAUTION A damaged or out-of-specification device can destroy a good connector attached 
to it even on the first connection. Any connector with an obvious defect should 
be marked for disposal or sent out for repair. 
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Cleaning Connectors  Use the following procedures when cleaning connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use clean, low-pressure air to remove loose particles from mating plane surfaces and 
threads (see Figure 7-41). Inspect connector thoroughly. If additional cleaning is required, 
continue with the following steps.

Figure 7-41 Removing Loose Particles using Clean, Low Pressure Air

3. Moisten-do not saturate-a lint-free swab with isopropyl alcohol. See Cleaning Supplies for 
recommended type.

4. Clean contamination and debris from mating plane surfaces and threads. When cleaning 
interior surfaces, avoid exerting pressure on center conductor and keep swab fibers from 
getting trapped in the female center conductor. See Figure 7-42.

Figure 7-42 Cleaning Surfaces using a Lint-Free Swab

5. Let alcohol evaporate-then use compressed air to blow surfaces clean.

6. Inspect connector. Make sure no particles or residue remains.

7. If defects are still visible after cleaning, the connector itself may be damaged and should 
not be used. Determine the cause of damage before making further connections. 
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Gaging Connectors  Use the following procedures when gaging connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Select proper gage for device under test (DUT).

3. Inspect and clean gage, gage master, and DUT.

4. Zero the connector gage.

a. While holding gage by the barrel, carefully connect gage master to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection. If needed, use additional wrench to 
prevent gage master (body) from turning.

c. The gage pointer should line up exactly with the zero mark on gage. If not, adjust “zero 
set” knob until gage pointer reads zero. On gages having a dial lock screw and a 
movable dial, loosen the dial lock screw and move the dial until the gage pointer reads 
zero. Gages should be zeroed before each set of measurements to make sure zero setting 
has not changed.

d. Remove gage master.

5. Gage the DUT.

a. While holding gage by the barrel, carefully connect DUT to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection and, if needed, use additional 
wrench to prevent DUT (body) from turning.

c. Read gage indicator dial for recession or protrusion and compare reading with device 
specifications. 

CAUTION If the gage indicates excessive protrusion or recession, the connector should be 
marked for disposal or sent out for repair.

6. For maximum accuracy, measure the device a minimum of three times and take an 
average of the readings. After each measurement, rotate the gage a quarter-turn to reduce 
measurement variations.

7. If there is doubt about measurement accuracy, be sure the temperatures of the parts have 
stabilized. Then perform the cleaning, zeroing, and measuring procedure again.
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Making Connections  Use the following procedures when making connections.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Inspect, clean, and gage connectors. All connectors must be undamaged, clean, and within 
mechanical specification.

3. Carefully align center axis of both devices. The center conductor pin-from the male 
connector-must slip concentrically into the contact finger of the female connector. See 
Figure 7-43.

Figure 7-43 Aligning the Center Axis of Both Connectors

4. Carefully push the connectors straight together so they can engage smoothly. Rotate the 
connector nut (not the device itself) until finger-tight, being careful not to cross the 
threads. See Figure 7-44.

Figure 7-44 Pushing the Connectors Together and Rotating the Nut
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5. Use a torque wrench to make final connection. Tighten until the “break” point of the 
torque wrench is reached. Do not push beyond initial break point. Use additional wrench, 
if needed, to prevent device body from turning. See Figure 7-45.

Figure 7-45 Using a Torque Wrench to Make the Final Connection

Separating Connections  Use the following procedures when separating connections.

1. Support the devices to avoid any twisting, rocking or bending force on either connector.

2. Use an open-end wrench to prevent the device body from turning.

3. Use another open-end wrench to loosen the connector nut.

4. Complete the disconnection by hand, turning only the connector nut.

5. Pull the connectors straight apart.
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Using a Torque Wrench  Use the following procedures when using a torque wrench.

1. Make sure torque wrench is set to the correct torque setting. 

2. Position torque wrench and a second wrench (to hold device or cable) within 90° of each 
other before applying force. Make sure to support the devices to avoid putting stress on the 
connectors. See Figure 7-46.

Figure 7-46 Positioning the Wrenches

3. Hold torque wrench lightly at the end of handle-then apply force perpendicular to the 
torque wrench handle. Tighten until the “break” point of the torque wrench is reached. Do 
not push beyond initial break point. See Figure 7-47.

Figure 7-47 Torquing with the Torque Wrench
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Contacting Agilent

You may use the following table to contact Agilent Technologies for assistance with any 
Agilent product.

Table 7-5 Contacting Agilent

Online assistance: www.agilent.com/find/assist

United States
(tel) 1 800 452 4844

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

New Zealand
(tel) 0 800 738 378
(fax) (+64) 4 495 8950

Japan
(tel) (+81) 426 56 7832
(fax) (+81) 426 56 7840

Malaysia
(tel) 1 800 828 848
(fax) 1 800 801 664

India
(tel) 1-600-11-2929
(fax) 000-800-650-1101

Taiwan
(tel) 0800-047-866
(fax) (886) 2 25456723

Hong Kong
(tel) 800 930 871
(fax) (852) 2506 9233

Canada
(tel) 1 877 894 4414
(fax) (905) 282-6495

Europe
(tel) (+31) 20 547 2323
(fax) (+31) 20 547 2390

Australia
(tel) 1 800 629 485
(fax) (+61) 3 9210 5947

Singapore
(tel) 1 800 375 8100
(fax) (65) 836 0252

Thailand
(tel) outside Bangkok: (088) 226 008
(tel) within Bangkok: (662) 661 3999
(fax) (66) 1 661 3714

People’s Republic of China
(tel) (preferred): 800-810-0189
(tel) (alternate): 10800-650-0021
(fax) 10800-650-0121

Philippines
(tel) (632) 8426802
(tel) (PLDT subscriber only): 1 800 16510170

(fax) (632) 8426809
(fax) (PLDT subscriber only): 1 800 16510288 
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Make sure have the following information readily available when you call:

• the serial number of the test set

• a list of any options or accessories installed in or in use with the test set

• the type of GPIB board in your computer

• any information you can supply about the DUT

• the nature of the problem

• the version number of software

Shipment for Service 

If you are sending the instrument to Agilent Technologies for service, ship the test set to the 
nearest service center for repair, including a description of any failed test and any error 
message. Ship the instrument using the original or comparable antistatic packaging 
materials.

Refer to “Contacting Agilent” on page 237 for additional information.
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Safety Information
Safety Information
Review to the safety information in this section before operating your physical layer test 
system. 

Safety Symbols 

The following safety symbols are used throughout this manual. Familiarize yourself with each 
of the symbols and its meaning before operating the physical layer test system.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not correctly 
performed or adhered to, would result in damage to or destruction of the 
instrument. Do not proceed beyond a caution note until the indicated conditions 
are fully understood and met.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if 
not correctly performed or adhered to, could result in injury or loss of 
life. Do not proceed beyond a warning note until the indicated 
conditions are fully understood and met.
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Instrument Markings

Familiarize yourself with each of the markings and its meaning before operating the physical 
layer test system.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The AC symbol. The AC symbol is used to indicate the required nature 
of the line module input power.

The instruction documentation symbol. The product is marked with 
this symbol when it is necessary for the user to refer to the instructions 
in the documentation.

The CE mark is a registered trademark of the European Community. 
(If accompanied by a year, it is when the design was proven.)

The CSA mark is a registered trademark of the Canadian Standards 
Association.

This is a symbol of an Industrial Scientific and Medical Group 1 Class 
A product.

ICES / NMB-001 This is a marking to indicate product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

The C-Tick mark is a registered trademark of the Australian Spectrum 
Management Agency.
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Safety Considerations 

Familiarize yourself with each of the safety considerations before operating the physical layer 
test system.

NOTE Positioning the Test System for Use

When setting up the physical layer test system for use, position the equipment 
so that the front panel power switch is easy to reach.

NOTE This instrument has been designed and tested in accordance with the 
standards listed on the Manufacturer’s Declaration of Conformity and has been 
supplied in a safe condition. This instruction documentation contains 
information and warnings which must be followed by the user to ensure safe 
operation and to maintain the instrument in a safe condition.

Safety Earth Ground 

WARNING This is a Safety Class 1 product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor, inside or outside the 
instrument, is likely to make the instrument dangerous. Intentional 
interruption is prohibited.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause product 
damage.
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Before Applying Power 

CAUTION Install the instrument so that the ON/OFF switch is readily identifiable and is 
easily reached by the operator. The ON/OFF switch or the detachable power 
cord is the instrument disconnecting device. It disconnects the mains circuits 
from the mains supply before other parts of the instrument. Alternately, an 
externally installed switch or circuit breaker (which is readily identifiable and 
is easily reached by the operator) may be used as a disconnecting device.

CAUTION Before switching on this instrument, make sure that the correct fuse is 
installed and the supply voltage is in the specified range.

Servicing 

WARNING No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock, do not remove covers.

WARNING These servicing instructions are for use by qualified personnel only. To 
avoid electrical shock, do not perform any servicing unless you are 
qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose dangerous 
voltages. Disconnect the instrument from all voltage sources while it is 
being opened.

WARNING The power cord is connected to internal capacitors that may remain 
live for 5 seconds after disconnecting the plug from its power supply. 

WARNING For continued protection against fire hazard replace line fuse only 
with same type and rating (115V and 230V operation: T2.5A 250V). The 
use of other fuses or material is prohibited.
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General 

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A/B, N4420B, and N4421A/B) 
S-parameter test set from mains before cleaning. Use a dry cloth or one 
slightly dampened with water to clean the external case parts. Do not 
attempt to clean internally.

WARNING If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

CAUTION This product is designed for use in Installation Category II and Pollution 
Degree 2 per IEC 1010 and 664 respectively.

CAUTION VENTILATION REQUIREMENTS: When installing the product in a cabinet, 
the convection into and out of the product must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4° C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater that 800 watts, 
then forced convection must be used.
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The Agilent Technologies S-Parameter test system complies with the regulatory requirements 
listed in this section.

Compliance with Canadian EMC Requirements 

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB du Canada.

Compliance with German Noise Requirements 

This is to declare that this instrument is in conformance with the German Regulation on 
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordung −3. GSGV 
Deutschland).

Acoustic Noise Emission/Geraeuschemission 

LpA <70 dB LpA <70 dB

Operator position am Arbeitsplatz

Normal position normaler Betrieb

per ISO 7779 nach DIN 45635 t. 19
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Part III is a collection of supplementary information that you may find useful.

Appendix A, “Glossary”

Defines terms that you may encounter while performing measurements using 
the physical layer test system.

Appendix B, “Reference Information for Discontinued Physical Layer Test 
System Hardware”

Provide general information, interconnection diagrams, specifications and 
characteristics, and front and rear panel information for discontinued PLTS 
hardware.
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Glossary
− Symbols −

.SnP .SnP data format creates component data files that describe frequency 
dependent linear network parameters for n port components. This 
format is used to import/export S-parameter data. Also see 
“Touchstone” on page 276.

γ (Gamma) Gamma is the complex propagation constant. γ = α + jβ where α is the 
attenuation per length and β is related to the wave velocity.

Γ (Gamma) In network analysis, Γ (Gamma) is the ratio of the reflected voltage 
signal level to the incident signal voltage level 
(Γ = Vreflected/Vincident). It is the complex reflection coefficient that 
consists of magnitude (ρ) and phase (Φ) components.

δ (delta) Skin depth. A measure of the depth of current penetration towards the 
center of a conductor from the perimeter at a particular frequency.

Tan δ Loss tangent of a material. This is mostly a measure of the ease at 
which electric fields penetrate (or propagate through) a material. 
Typical values in electronic materials are in the 0.001 – 0.025 range.

εr  εr is the relative permittivity of a material (also referred to as 
dielectric constant), which is mostly a measure of a material’s density. 
Most insulators used in electronics are in the range of 3 to 10. εo is the 

permittivity of air, which is 8.85e−12.

µ (mu) µ (mu) is the relative permeability of a material. A measure of how 
easily a material is magnetized. Most all non-magnetic materials have 
a value of 1. µo is the permeability of a vacuum, which is 4πe−7.

µW 1. Microwave. See “Microwave” on page 264. 

2. Microwatts (one-millionth of a watt)

ρ (rho) 1. (Material properties) Bulk resistivity of a material (e.g. 
Cu = 1.7e−8 ohm-meters). A measure of a materials resistance to 
current flow.

2. (Network analysis) Magnitude portion of the complex reflection 
coefficient (Γ). The magnitude of the ratio between the reflected 
and the incident voltages.
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σ (sigma) 1. (Material properties) Bulk conductivity of a material (the inverse of 
resistivity).

2. (Statistics) Standard deviation, which is the measure of the 
dispersion or spread of the statistical average of all results for a 
particular measurement. See “Standard Deviation” on page 273.

τ (tau) In network analysis, τ (tau) is the magnitude portion of the complex 
transmission coefficient (T). The magnitude of the ratio between the 
transmitted and the incident voltages.

T (Tau) T (Tau) is the ratio of the transmitted voltage signal level to the 
incident signal voltage level (T = Vtransmitted/Vincident). It is the 
complex transmission coefficient that consists of magnitude (τ) and 
phase (ø) components.

ø (phi) In network analysis, ø (phi) is the phase angle portion of the complex 
transmission coefficient (the ratio between the transmitted and the 
incident voltages).

Φ (Phi) In network analysis, Φ (Phi) is the phase angle portion of the complex 
reflection coefficient (the ratio between the reflected and the incident 
voltages).

− Numeric −

2-Level (PAM2) A 2-level data signal generates 1 bit per symbol.

4-Level (PAM4) A 4-level data signal generates 2 bits per symbol consuming half the 
bandwidth of a 2-level signal.

− A −

Active Device An active device is a device that requires a source of energy to add gain 
to a signal or control a circuit. Examples of active device are LEDs, 
transistors, and integrated circuits.

American Wire 
Gauge (AWG)

AWG is the standard for determining wire size. The gauge number 
varies inversely with the diameter of the wire. 

Analog Analog is a method of transmitting information. Analog is 
characterized by adding data of continuously varying frequency or 
amplitude to carrier waves. Digital transmissions depend on the 
varying between two discrete levels. An analog signal responds to 
changes in light, sound, heat and pressure.
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Arbitrary 
Bitstream (ABS)

Arbitrary Bitstream is a random-like bit stream used to generate eye 
diagrams. The "number of bits" and the "number of patterns" user 
inputs is used to create the ABS. The "number of bits" entry identifies 
the number of unique bit patterns that are available. The "number of 
patterns" identifies the number of these unique bit patterns that are 
used to create the eye diagram. Using both of these values, a random 
number generator selects unique bit patterns until the appropriate 
number of bit patterns is identified. Each of these unique bit patterns 
are then used to create the eye diagram, one bit pattern at a time.

Attenuation Attenuation is a reduction in signal amplitude. The difference between 
transmitted and received power due to loss through equipment, lines, 
or other transmission devices; usually expressed in decibels.

Averaging Averaging is a waveform acquisition mode in which the instrument 
acquires waveforms from multiple data acquisitions and then averages 
the waveforms together, point by point. Averaging significantly 
reduces noise and improves resolution of the displayed waveform. The 
noise sources can average to zero over time while the underlying 
waveform is preserved. The effective resolution of the displayed 
waveform increases as more acquisitions are averaged together. This 
improves the stability of both the display and waveform 
measurements. 

− B −

Backplane A backplane is a circuit board that has sockets and circuitry and 
serves as an interconnection between other cards (circuit boards) that 
are plugged into the sockets. Typically refers to a special, heavy-duty 
printed or discrete wired circuit board. In terms of PCs, this circuit 
board is synonymous with the motherboard. Typically the backplane is 
designed for a longer life than the daughter cards and has improved 
signal integrity. It is often manufactured out of more expensive PCB 
materials.

Backplanes are either active (also called intelligent) or passive. Active 
backplanes also contain a microprocessor or circuitry that performs 
computing functions. Passive backplanes have no computing circuitry.

Balanced Device A balanced device is composed of two nominally identical halves. 
Practically speaking, the signals on each side of the device can have 
any relative amplitude and phase relationship, but they can be 
decomposed into a differential-mode (anti-phase) component, and a 
common-mode (in-phase) component. 
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Balanced 
Measurement 
System (BMS)

The BMS is the predecessor to the Physical Layer Test System. The 
BMS acquires 2-, 3-, or 4-port frequency domain test data using a 
network analyzer and multiport test set and displays the data in 
either frequency or time domain. ATN Microwave originally developed 
this product before being acquired by Agilent Technologies.

Balun A balun (balanced-unbalanced) is an impedance matching device used 
to connect a balanced line or device with an unbalanced coaxial line or 
device. 

Bandwidth In analog terms, bandwidth is the difference between the maximum 
and minimum frequency. It is measured in hertz (Hz). 

In digital terms, bandwidth is the data transmission capacity of an 
electronic circuit or system. It is measured in bits (or bytes) per 
second.

Baud Baud refers to the number of level transitions through a device in a 
one second period. One baud is one state-transition or level-transition 
per second. In the past, baud was the accepted units for data 
transmission rate. However, bits per second (bps) is replacing baud as 
a more accepted unit of measure. 

Bit Bit is an abbreviation of the term "Binary Digit". A bit is the smallest 
unit of computer data. It is a single digit number, either a one or a 
zero. A collection of bits makes up a group called a "byte" or a "word" 
which is equivalent to one alphanumeric character.

Bit Pattern A bit pattern is a series of bits that are convolved with a time domain 
impulse response of a system to create an eye diagram.

Bits Per Second 
(bps)

Bits per second (bps) is the unit of measure for the rate or speed of 
data transfer. Refer to “Data Transfer Rate” on page 256.

Bit Rate Bit rate is the number of bits that are sent through a circuit per 
second, calculated as inverse of the bit period (1/bit period). The bit 
period is a measure of the horizontal opening of an eye diagram at the 
crossing points of the eye.

Broadband Broadband is high-speed transmission. Although not a standard, it 
commonly refers to computer data and telecommunication rates in 
excess of 1.544 Mbps, the rate of T1 lines. Broadband often refers to 
Internet access using cable modems and DSL. A broadband network 
can carry voice, video and data all at the same time.
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Bus A collection of wires in a cable (or copper traces on a circuit board) that 
serve as a common data path between multiple devices. The bus is 
used to transmit signals (data, status, and control) between the 
devices that share the bus. Bus typically refers to a parallel data 
transmission structure (1 clock, multiple data channels). As designs 
transition from parallel to serial with data rates in excess of 1 Gbps 
barrier, the terms "Channel" or "Lane" may become more commonly 
used than "Bus". 

Byte A byte is a unit of data that is eight bits in length. A byte represents a 
single character, such as a letter, number, or symbol. "Byte" may be 
preceded with Kilo (Kilobyte) for 1 thousand bytes, Mega (Megabyte) 
for 1 million bytes, or Giga (Gigabyte) for 1 billion bytes.

− C −

C (capacitance) Capacitance (farads) is a measure of stored electric charge.

Calibration In network analyzer systems, calibration is the process of removing 
systematic errors from measurements (also known as accuracy 
enhancement or error correction). See “SOLT Calibration” on page 272 
and “Thru Reflect Line (TRL) Calibration” on page 275.

Calibration Kit A calibration kit contains hardware and software required to perform 
error correction on a network analyzer for a specific measurement 
and/or test set.

Characteristic 
Impedance (Zo)

Characteristic impedance is the impedance looking into the end of an 
infinitely long lossless transmission line.

Coaxial Cable 
(Coax)

Coaxial cable is a cable with the inner solid or stranded wire acting as 
the primary conductor wire that is surrounded by a solid or braided 
metallic shield serving as the ground with an insulating medium 
between the two. 
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Common 
Instrumentation 
Transfer and 
Interchange File 
(CITIfile)

CITIfile is an ASCII data format that is useful when exchanging data 
between different computers and instruments. CITIfile is a data 
storage convention designed to be independent of the operating 
system, and therefore may be implemented by any file system that has 
the ability to transfer ASCII files. 

A typical CITIfile package is divided into two sections, the header and 
the data. The header section contains information about the data that 
will follow. It may also include information about the setup of the 
instrument that measured the data. The Data is a numeric array of 
data that is arranged with one data element per line. The data section 
may contain more than one array of data. Arrays of data start after the 
BEGIN keyword, and the END keyword follows the last data element 
in an array. 

Common Mode Common mode is the in-phase mode of a balanced measurement.

Continuous 
Sweep Mode

Continuous sweep mode is the vector network analyzer condition 
where traces are automatically updated each time trigger conditions 
are met.

Crossing 
Percentage (Eye)

Crossing percentage (eye) is a measure of the amplitude of an eye 
diagram crossing points relative to the one level and zero level.

Crossing percentage = 100 (Vcross − Vzero level) / (Vone level − Vzero level))

Crossing Point 
(Eye)

Crossing point (eye) is the point in time, in an eye diagram, where the 
rising edge of a waveform intersects with the falling edge.

Crossstalk Crosstalk is the occurrence of a signal at one port of a device being 
affected by a signal in any other path. Isolation is a description of each 
signal path (or channel's or lane's) immunity from noise from other 
channels or outside sources.

− D −

Data Sharing Data Sharing is a Physical Layer Test System utility that is used to 
overlay the plot of one measurement parameter over the plot of the 
same measured parameter from a different data set so that differences 
and similarities can be readily seen.
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Data Transfer 
Rate

The number of bits that are sent during a one second period. This is 
generally associated with high-speed serial data transfer systems. The 
base unit of measure is bits per second (bps). "bps" may be preceded 
with K (Kbps) for 1000 bits per second, M (Mbps) for 1,000,000 bits per 
second, or G (Gbps) for 1,000,000,000 bits per second.

De-embedding De-embedding eliminates the effects (loss, phase shift, mismatch) of 
the test fixture, connectors, cables and other equipment. 
De-embedding combines these effects with the errors determined 
during a coaxial calibration to account for errors of all of the 
equipment required to measure the DUT. This characterized data is 
mathematically removed from the measured data, thus ensuring that 
only the effects of the DUT are displayed. This technique is very useful 
for measuring DUTs that require fixtures, such as wafers and 
packages.

Deterministic 
Jitter

Deterministic jitter is the deviation of a transition from its ideal time 
caused by reflections relative to other transitions or events happening 
on neighboring lines. It is pattern dependent, occurring in a 
predictable, systematic manner due to the varying data patterns. It 
adds linearly and is measured in peak-to-peak means. 

Differential Mode Differential mode is the anti-phase mode of a balanced measurement.

Direct Current 
(DC)

Direct Current is electron flow at zero hertz. 

DUT DUT is an acronym commonly used for the device under test.

Dynamic Range Dynamic range specifies the amplitude (size) of a signal that can be 
input into the instrument at a particular vertical scale without 
overdriving the front end, resulting in an inaccurate acquisition of 
data. 

− E −

Electromagnetic 
Interference 
(EMI)

Any electromagnetic energy created by an outside source that 
interrupts, degrades, or limits the performance of electronics 
equipment or systems. It can result from unintentional sources, such 
as spurious emissions and responses, or it can be induced 
intentionally, as a form of electronic warfare.
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Electronic 
Calibration 
(ECal)

Electronic calibration performs a SOLT (Short-Open-Load-Thru) 
calibration on the Physical Layer Test System using an ECal module 
controlled by the N1930A software. The ECal module is a 
state-of-the-art, solid-state device with programmable and highly 
repeatable impedance states that provide consistent calibrations and 
eliminate operator errors while bringing convenience and simplicity to 
your calibration routine. The PLTS uses the N4430A and N4430B 
ECal modules to calibrate to maximum frequencies of 6 GHz and 9 
GHz, respectively.

Ethernet Ethernet is a network that adheres to the IEEE 802.3 Local Area 
Network standard.

Extinction Ratio Extinction ratio is the ratio of the one level and the zero level of an eye 
diagram. This measurement is made in a section of the eye referred to 
as the eye window. 

Eye Amplitude Eye amplitude is the difference between the logic 1 level and the logic 
0 level histogram mean values of an eye diagram.

Eye Diagram or 
Pattern

An eye diagram is a waveform display that has a specific number of 
bits sliced and folded on top of one another to produce an overlaid 
display. In PLTS, the eye diagram is produced by convolving the time 
domain impulse response of SDD21 with a repetitive bit pattern, 
which is wrapped.

Eye Height Eye height is a measure of the vertical opening of an eye diagram. 

Eye Opening 
Factor 

Eye Opening Factor is a measure of the vertical opening of an eye 
diagram.

Eye Width Eye width is a measure of the horizontal opening of an eye diagram. 

Eye Window The eye window provides the time boundaries within which signal 
parameters for eye diagrams are measured. 

− F −

Fall Time Fall time is the transition time for the falling edge of a pulse to 
decrease from 90% of its peak value to 10% of its peak value. 

Fast Fourier 
Transform (FFT)

The Fast Fourier Transform is an algorithm for transforming data 
from the time domain to the frequency domain.
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Fixturing Fixturing is the process of using a test fixture as an interface between 
your test equipment and your device under test (DUT). See “Test 
Fixture” on page 275.

Forward 
Orientation

Forward orientation is the direction an adapter is inserted into the 
Physical Layer Test System equipment setup. An adapter is "forward 
oriented" when the end labeled "1" at the PLTS test cable and the end 
labeled "2" will be connected to the DUT. See “Orientation” on page 
266.

FR-4 FR-4 is a common epoxy resin glass laminate that is used as substrate 
for PC boards. 

Frequency Frequency is the number of periodic oscillations, vibrations, or waves 
per unit of time, usually expressed in cycles per second, or Hertz (Hz).

Frequency 
Accuracy

Frequency accuracy is the uncertainty with which the frequency of a 
signal or spectral component is indicated, either in an absolute sense 
or relative to another signal or spectral component. Absolute and 
relative frequency accuracies are specified independently.

Frequency Band Frequency band is a term that identifies a range of frequencies in the 
electromagnetic spectrum.

Frequency Range Frequency range is the range of frequencies over which a device or 
instrument performance is specified.

Frequency 
Response

In frequency mode, frequency response is the peak-to-peak variation 
in the displayed amplitude response over a specified center frequency 
range. Frequency response is typically specified in terms of dB, 
relative to the value midway between the extremes.

Frequency Span Frequency span is represented by the horizontal axis of the display. 
Generally, frequency span is given as the total span across the full 
display. Sometimes frequency span (scan width) is represented as a 
per-division value.

Functions (Math) Functions (Math) are mathematical operations (such as Add, Subtract, 
Multiply, Integrate, Versus for XY plots) that can be performed on 
input waveforms, stored waveform memories, or even other functions. 

− G −

G (conductance) Conductance is the resistive component in shunt impedance from a 
signal to ground or across transmission lines.
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Gating Gating enables a network analyzer to remove displayed data between 
specific intervals. This function is used in the time domain mode to 
separate device connector and coupling effects.

General Purpose 
Interface Bus 
(GPIB)

The GPIB bus provides an easy and reliable interface between GPIB 
instruments and a computer GPIB interface card using GPIB cables. 
These cables are available in various lengths. Multiple cables can be 
daisy-chained together to simplify the system interconnection.

Gigabits per 
Second (Gbps)

Gigabits per second or one billion bits per second. Refer to “Data 
Transfer Rate” on page 256.

Gigabyte Gigabyte is generally defined as either 1,000 or 1,024 megabytes. See 
“Byte” on page 254.

Gigahertz (GHz) One billion cycles per second. Refer to “Frequency” on page 258.

Golden Device A device under test that is measured and its test results are saved for 
comparison against future measurements as a metric of calibration 
quality and repeatability.

Graticule Graticules are the horizontal and vertical grid lines making up the 
plot area. Graticules allow for easier, more accurate viewing of the 
waveform data and markers. 

Group Delay A measure of the transit time of a signal through a DUT versus 
frequency. Group delay can be calculated by differentiating the DUT's 
insertion-phase response versus frequency.

−∆ Phase / (∆f) (360)

where, ∆ Phase is the phase difference between two adjacent 
frequencies, ∆f.

− H −

Hertz (Hz) One cycle per second. Refer to “Frequency” on page 258.

Horizontal Scale Horizontal scale is an instrument control that controls the x-axis (time 
or frequency per division) of displayed waveforms. Horizontal scale is 
often referred to as sweep speed in some instruments. 

HSPICE HSPICE is a circuit simulation tool based on SPICE (Simulation 
Program for Integrated Circuits Emphasis). Physical Layer Test 
System data can be exported in an HSPICE format. HSPICE is a 
product of Synopsys, Inc.
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Hub A hub is a central connection point for devices in a network. It receives 
a signal from one device and retransmits the signal to one or more 
devices. Passive hubs are data conduits that just connect devices, 
adding nothing to the data passing through them. Active hubs 
regenerate the data bits in order to maintain a strong signal. 
Intelligent hubs have additional features that monitor traffic. 
Switching hubs read the destination address of each packet of 
information and then forward the information to the proper 
destination.

− I −

IEEE 802 IEEE 802 is a series of documents that define the standards for Local 
and Metropolitan Area Networks. The Institute of Electrical and 
Electronics Engineers, Inc. (IEEE) publish these standards. The 
following is a list of subjects that the standards define:

IEEE Std 802: Overview and Architecture
IEEE Std 802.1: Bridging and Management
IEEE Std 802.2: Logical Link Control
IEEE Std 802.3: CSMA/CD Access Method
IEEE Std 802.5: Token Ring Access Method
IEEE Std 802.6: DQDB Access Method
IEEE Std 802.7: Broadband LAN
IEEE Std 802.10: Security
IEEE Std 802.11: Wireless LANs
IEEE Std 802.12: Demand Priority Access Method
IEEE Std 802.15: Wireless Personal Area Networks
IEEE Std 802.16: Broadband Wireless Metropolitan Area 
Networks

Imaginary Imaginary is a format that displays the reactive portion of the 
measured data on a Cartesian format. This is the corollary to the Real 
format where the resistive portion is displayed.

Impedance Impedance is the ratio of voltage to current at a port of a circuit, 
expressed in ohms.

Insertion Loss Insertion loss is the difference between the power measured before 
and after the insertion of a device or the attenuation between the 
input and output of a device.
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Inverse Fast 
Fourier 
Transform

The Inverse Fast Fourier Transform is an algorithm for transforming 
data from the frequency domain to the time domain.

Isolation Isolation is the specification or measure of the immunity that one 
signal has to being affected by another adjacent signal. Low isolation 
in digital systems manifests itself as crosstalk or noise on the victim 
channel.

− J −

Jitter Jitter is the measure of the time variances of the rising and falling 
edges of an eye diagram as these edges affect the crossing points of the 
eye. 

− K −

K28.5 K28.5 is an industry standard, finite length, specific bit sequence than 
includes a comma character and 8B/10B encoding. 

Kilobits per 
Second (Kbps)

Kilobits per second or one thousand bits per second. Refer to “Data 
Transfer Rate” on page 256.

Kilobyte Kilobyte is generally defined as either 1,000 or 1,024 bytes. See “Byte” 
on page 254.

Kilohertz (kHz) One thousand cycles per second. Refer to “Frequency” on page 258.

− L −

L (inductance) Inductance (henries) is stored magnetic charge.

Line Reflect 
Match (LRM) 
Calibration

LRM calibration is a calibration type that utilizes three simpler, more 
convenient standards to define the error terms to be removed from the 
measurement. The measured parameters of the Line, Reflect, and 
Match standards in a LRM calibration kit provides the same 
information as a SOLT calibration via a different algorithm.

A calibration at the coaxial ports of the test system removes the effects 
of the system and any cables or adapters before the fixture; however, 
the effects of the fixture itself are not accounted for. An in-fixture 
calibration is preferable, but SOLT standards may not be readily 
available to allow a conventional full 4-port calibration at the desired 
measurement port of the device. 
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Line Reflect 
Match (LRM) 
Calibration 
(continued)

LRM calibration is convenient because calibration standards can be 
fabricated for the specific measurement environment. The 
characteristic impedance of these fabricated transmission lines can be 
determined from the physical dimensions and substrate's dielectric 
constant. The LRM calibration relies on the characteristic impedance 
of simple transmission lines.

Linear Device A linear device is a device that only modifies phase or magnitude of 
frequency components present on the input signal. 

Linear Mag Linear Mag is the display mode in which the vertical deflection is 
presented in linear function (vertical divisions are uniformly space). 
This format is used for unit-less measurements, such as reflection 
coefficient magnitude and for linear measurement units. It is used to 
display conversion parameters and time domain transform data.

Load 1) A load is a one-port microwave device used to terminate a path in its 
characteristic impedance.

2) A load is a calibration standard that is an actual line that 
terminates a path with the path's characteristic impedance. See 
“SOLT Calibration” on page 272. 

Load Match Load match is a measure of how close the device's terminating load 
impedance is to the ideal transmission line impedance. Match is 
usually measured as return loss or standing wave ratio (SWR) of the 
load.

Log Display Log display (logarithmic display) is the display mode in which vertical 
deflection is a logarithmic function of the input signal amplitude. The 
display calibration is set by selecting the value of the reference level 
position and scale factor in dB per division. 

Log Mag Log Mag is the display mode in which vertical deflection is a 
logarithmic function of the input signal amplitude. Log Mag is also 
called logarithmic display.
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Low Voltage 
Differential 
Signals (LVDS)

LVDS is a high-speed (gigabits per second), low-noise, low-power, low 
voltage method of transmitting digital information. The differential 
signals are transmitted over two traces or over balanced cable using a 
very low voltage swing between high (binary 1) and low (binary 0). The 
low swing voltage means that data can switched very quickly which 
provides the higher data transfer rate. LVDS uses the two traces 
(cables) for two signals, which are 180 degrees out of phase from each 
other. Thus, the noise travels at the same level making filtering very 
effective. This mode of transmission is often used with SCSI hardware.

− M −

Magnitude Magnitude is the amplitude of a signal measured in its characteristic 
impedance without regard to phase.

Markers Marker lines are used to determine the position or amplitude of the 
selected point on the display graticule. Marker lines can be positioned 
on either: 

• A selected waveform source (input channel, waveform memory, or 
waveform function)

• Independently, anywhere on the display graticule

Mask A mask is a template consisting of numbered, shaded regions on the 
instrument display screen. The input waveform must remain within 
these regions in order to comply with industry standards. The 
waveforms that intrude these regions are mask violations. 

Masking Time domain responses are most accurate closest to the location of the 
source. A discontinuity in the DUT will reflect some power back to the 
source, meaning less power is transmitted to the rest of the DUT. This 
loss of power going away from the source is referred to as masking, and 
allows the true impedance of the next discontinuity to be 
misrepresented.

Mask Test A mask test is a test process used to verify that waveforms generated 
by a test device conform to industry standards. 
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Measurement 
Uncertainty

Measurement uncertainty is the quantified amount of error in a 
measurement situation. Calibrations are intended to reduce the 
amount of uncertainty. The following are sources of measurement 
errors that lead to uncertainty: 

• Systematic errors (imperfections in calibration standards, 
connectors, cables, and instrumentation) 

• Random errors (noise, connector repeatability)
• Drift (source and instrumentation) 

Megabits per 
Second (Mbps)

Megabits per second or one million bits per second. Refer to “Data 
Transfer Rate” on page 256.

Megabyte Megabyte is generally defined as either 1,000 or 1,024 kilobytes. See 
“Byte” on page 254.

Megahertz (MHz) One million cycles per second. Refer to “Frequency” on page 258.

Microprocessor 
Unit (MPU)

A microprocessor is a computer (central processing unit, CPU) on a 
single digital semiconductor chip. It performs math and logic 
operations and executes instructions from memory. A microprocessor 
requires a power supply, clock and memory to function as a computer.

Microstrip Microstrip is a planar transmission line that consists of a thin 
conductive trace (or traces) printed or etched on the top side of an 
insulating substrate with a parallel ground plane on the other side of 
the substrate. Microstrips are also used for antennas and antenna 
arrays.

Microwave Microwave is the frequency band where radio waves are very short. 
This band ranges from approximately 1 GHz to 40 GHz, within the 
UHF, SHF, and EHF frequency bands. 

Mixed Mode 
S-parameters

Mixed-mode S-parameters describe the performance of a device when 
measuring a balanced device. Each balanced port will support both a 
common-mode and a differential-mode signal. 
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Mode Conversion Mode conversion is a measure of isolation when making balanced 
S-parameter measurements where there is a:

• Differential-mode stimulus with a common-mode response 
(SCDXX). Mode conversion in this configuration can result in 
device asymmetry and generation of electromagnetic interference 
(EMI).

• Common-mode stimulus with a differential-mode response 
(SDCXX). Mode conversion in this configuration can result in 
device asymmetry and susceptibility to EMI.

− N −

Near End 
Crosstalk (NEXT)

Signal distortion as a result of signal coupling from one wire pair to 
another wire pair at various frequencies. When measuring the NEXT, 
it is usually the resultant voltage excursion expressed as a percentage 
of the incident voltage swing of the culprit line. 

Network Analysis Network analysis is the characterization of a device, circuit, or system 
derived by comparing a signal input going into the device to a signal or 
signals coming out from the device. 

Noise Noise is an unwanted disturbance (voltage or current) superimposed 
on a useful waveform.

Non-insertable 
Calibration

A non-insertable calibration is one in which the test port connectors 
are of the same gender (male-to-male or female-to-female).

Non-linear Device A non-linear device is a device in which frequency components are 
added or deleted (not just modified) from the original signal.

Non-Return to 
Zero (NRZ) 
Signaling

NRZ signaling is used in differential signaling to describe that swing 
about some offset voltage do no return to 0 volts.

Normalize To normalize is to subtract one trace from another to eliminate 
calibration data errors or to obtain relative information.

− O −

Offset Offset is used to move or set off a determined amount. Used in 
instruments for offsetting frequencies, limits, delay, loss, impedance, 
etc.
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One Level One level is a measure of the mean value of the logical 1 of an eye 
diagram. 

Open An Open is a calibration standard that is an actual line that 
terminates a path with an electrical open. See “SOLT Calibration” on 
page 272. 

Orientation Orientation is the direction that an adapter is inserted between the 
Physical Layer Test System port's coaxial test cable and the DUT. 
Each end of the adapter should be labeled: either "1" or "2". Identifying 
the adapter orientation is important when calibrating the test system. 
An adapter is "forward oriented" when the end labeled "1" at the test 
cable and the end labeled "2" will be connected to the DUT. An adapter 
is "reverse oriented" when the end labeled "2" at the test cable and the 
end labeled "1" will be connected to the DUT.

− P −

Passive Device A passive device is a device that requires only a signal to perform its 
function. It does not require a source of power for its operation and it 
provides no gain to a circuit. Examples of passive devices are resistors, 
inductors, capacitors, cables, and filters.

Pattern Length Pattern length is the number of bits that are used to create a bit 
pattern used to create an eye diagram in the Physical Layer Test 
System. Bit patterns may be between 8 and 32 bits long.

Phase The fractional part of a cycle through which an oscillation has 
advanced, measured from an arbitrary starting point; usually 
measured in radians or degrees. In network analysis, the phase 
response of the device under test is the change in phase as a function 
of frequency between the input stimulus and the measured response. 
In network analysis, the phase response of the device under test is the 
change in phase as a function of frequency between the input stimulus 
and the measured response.

Phase Rotation See “Phase Skew” on page 267.

Phase Shift Phase shift is the change in phase of a signal between two points of 
time. Phase shift is expressed in degrees of lead or lag.
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Phase Skew Phase skew is a technique to remove the time delay caused by a 
fixture. Since the SOLT calibration only calibrates to the end of the 
test cables, the effects added by the test fixture can be removed 
mathematically. Phase skew moves the reference plane from the end of 
the test cables to the connection between the fixture and the DUT by 
accounting for the electrical length of each fixture path. Other terms 
for phase skew are phase rotation, port extension, port rotation, and 
reference plane rotation.

Physical Layer The physical layer is layer 1, the lowest layer, of the seven-layer Open 
System Interconnection model. In broad terms, the physical layer is 
responsible for activating and using physical connections for transfer 
of electronic bits (zeros and ones) between a device and its 
transmission medium. The physical layer defines the electrical, 
mechanical, and handshaking protocols that govern transmission 
media and signals over the interface connecting a device to the 
transmission medium. In doing so, the physical layer insulates the 
data link layer (layer 2) from the physical characteristics of the 
transmission medium, such as baseband, broadband, or fiber-optic 
transmission. The physical layer is subdivided into the physical 
medium-dependent sublayer and the transmission convergence 
sublayer. Physical layer has three basic mediums: electrical (where 
SIO is focused), wireless/over air, and optical. All three are used in 
today's communications systems.

Polar Chart The Polar chart is a format where each point corresponds to a 
particular value of both magnitude and phase. Quantities are read 
vectorally: the magnitude at any point is determined by its 
displacement from the center (which has zero value), and the phase by 
the angle counterclockwise from the positive x-axis. Magnitude is 
scaled in a linear fashion, with the value of the outer circle set to a 
ratio value of 1. Since there is no frequency axis, frequency 
information is read from the markers. The default marker readout for 
the polar format is in linear magnitude and phase.

Port Port is a network-analysis term for the path that sends/received data 
to/from the DUT. In logic analysis and oscilloscope terminology a port 
is more like a channel. A channel in a logic analyzer or an oscilloscope 
is usually unidirectional (acquisition only) where as a port in a 
network analyzer is bi-directional. A port is also equivalent to the 
"pin" of an IC or board tester, which is usually bi-directional as well. So 
a port is similar to a pin on a package or connector.
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Port Extension See “Phase Skew” on page 267.

Port Rotation See “Phase Skew” on page 267.

Power Level Power level (dBm) is the stimulus level at the test port required for the 
measurement of the device under test.

Probe A probe is the test device is connected to the Physical Layer Test 
System (or some other electronic device) that is used to make contact 
with a DUT to deliver or detect a signal for the purpose of on-circuit 
measurements. It is often a stylus-like device having multiple 
conductors for signal and ground paths. The tip is also often spring 
loaded to apply a constant pressure to the DUT.

Probing In the frequency domain, probing is the process of using a probe to 
perform on-circuit measurements.

In the time domain, probing typically refers to the technique of either 
browsing (single probe) or attaching (multiple probes, as in a logic 
analyzer) to the DUT and attempting to be non-intrusive with respect 
to the signal. Oscilloscope or logic analyzer-based measurements 
probing is designed to be as non-intrusive to the active electrical signal 
as possible while retaining the high bandwidth required to make 
accurate measurements.

Pseudo-Random 
Binary Sequence 
(PRBS)

Pseudo-Random Binary Sequence is a fixed length, somewhat random, 
digital signal pattern. 

Pulse Width Pulse width is the difference in time between the rising and falling 
edges of a signal that is transitioning, away from and then back to, its 
steady state. 

− R −

R (resistance) Resistance (ohms) is the opposition to the flow of current in a 
conductor.

Rack Units A rack unit (U) is the vertical distance (height) between screw holes in 
an equipment rack. One rack unit (1U) equals 1.75 inches (44.45 mm) 
of rack space for equipment. 2U provides 3.5 inches of rack space for 
equipment, and so forth.
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Radio Frequency 
(RF) 

RF is the frequency band where radio waves are below the microwave 
band. The RF band ranges from approximately 50 kHz to 3 GHz, 
within the LF, MF, HF, VHF, and UHF frequency bands. 

Range Resolution Range resolution is defined as the ability to locate a single response in 
the time domain. If only one response is present, range resolution is a 
measure of how closely you can pinpoint the peak of that response. The 
range resolution is equal to the digital resolution of the display, which 
is the time domain span divided by the number of points on the 
display. The range resolution is always much finer than the response 
resolution.

Real Real is a format that displays the resistive portion of the measured 
data on a Cartesian format. This is the corollary to the Imaginary 
format where the reactive portion is displayed.

Record Length In frequency domain, record length refers to number of frequency 
points measured by the network analyzer. A longer record length 
(number of points) in a VNA implies either more resolution (closer 
points in the frequency domain) or a wider bandwidth measurement.

In time domain, record length refers to the number of time points or 
instances acquired by the scope or logic analyzer. A longer record 
length (also occasionally called "points") means greater resolution for 
any given time duration.

Reference Level Reference level is an instrument function that allows the user to set 
the amplitude value at the reference position. On network analyzers, 
the reference position is also selectable. 

Reference Plane A reference plane is the electrical location at which a network analyzer 
assumes the system connectors and fixturing ends and the device 
under test (DUT) begins. The reference plane is set by using 
calibration standards with known electrical lengths. The closer the 
reference plane is to the DUT, the better the characterization of the 
device because of the elimination of test system uncertainties.

Reference Plane 
Rotation

See “Phase Skew” on page 267.

Reflection Reflection is the phenomenon in which a traveling wave strikes a 
discontinuity and returns to the original medium.
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Reflection 
Coefficient

The reflection coefficient is the ratio of the reflected voltage to the 
incident voltage into a transmission line or circuit. If a transmission 
line is terminated in its characteristic impedance, the reflection 
coefficient is zero. If the line is shorted or open, the coefficient is 1. 

Reflection 
Measurements

Reflection measurements characterize the input and output behavior 
of the device under test. Measured as the ratio of the reflected signal 
to the incident signal as a function of frequency. Parameters are called 
return loss, reflection coefficient, impedance match, and standing 
wave ratio (SWR), all as a function of frequency.

Response The Physical Layer Test System applies reference signals that are 
transmitted through the DUT or are reflected from the DUT's input. 
The transmitted or reflected signal is then detected and compared 
against the reference signal. A detected signal is called the "response". 
A reference signal is called the stimulus.

Response 
Resolution

Response resolution is defined as the ability to resolve two closely 
spaced responses, or a measure of how close two responses can be to 
each other and still be distinguished from each other in the time 
domain.

Reverse 
Orientation

Reverse orientation is the direction an adapter is inserted into the 
Physical Layer Test System equipment setup. An adapter is "reverse 
oriented" when the end labeled "2" at the PLTS test cable and the end 
labeled "1" will be connected to the DUT. See “Orientation” on page 
266.

Rise Time Rise time is the transition time for the leading edge of a pulse to rise 
from 10% of its peak value to 90% of its peak value.

RMS RMS is the root-mean-square (rms) of the voltage values of a 
waveform. Typically, the rms is taken over the first period of the 
displayed waveform. 
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Router 
(Networking)

A router is an electronic device that links local and wide area networks 
(LANs and WANs), allowing them to talk to one another even though 
the networks may be based on different standards. Using routing 
tables and protocols, routers read the network address in each 
transmitted frame and decide how to send it based on the most 
expedient route. Gateway is a generic term for a router.

Most routers are specialized computers that are optimized for 
communications; however, router functions can also be implemented 
by adding routing software to a file server.

− S −

S-parameters 
(Scattering 
Parameters)

A convention used to characterize the way a device modifies signal 
flow. A four-port device has sixteen S-parameters: four forward 
transmission parameters, four reverse transmission parameters, four 
forward reflection parameters, and four reverse reflection parameters.

Scale (horizontal) Horizontal scale is an instrument control that controls the x-axis or 
time per division of displayed waveforms. Horizontal scale is often 
referred to as sweep speed in some instruments.

Scale (vertical) Vertical scale is an instrument control that controls the y-axis or volts 
per division for the selected channel. This control allows you to adjust 
the sensitivity of the instrument.

Serializer-Deseria
lizer (SERDES)

SERDES is a term applied to the serialization (conversion from 
parallel to serial) and deserialization (conversion from serial to 
parallel) of data. The serialization portion usually merges clock and 
data and performs encoding while the deserialization typically 
performs decoding and clock/data recovery. SERDES are commonly 
used in high-speed serial links.

Short A Short is a calibration standard that is an actual line that terminates 
a path with a precision electrical short. See “SOLT Calibration” on 
page 272. 

Signal-to-Noise 
Ratio

Signal-to-noise is the ratio of the amplitude of a signal relative to the 
amplitude of the noise on the signal.

Signal Integrity 
Engineering

Signal Integrity Engineering is using digital design and analog circuit 
theory along with accurate models and simulation to design circuits 
correctly the first time to save time and cost. When problems do occur 
signal integrity engineering quickly finds the root cause of signal 
distortions and fixes them. 
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Single-ended A singled-ended or unbalanced device, having all of its signals 
referenced to a common ground potential.

Single-ended 
Device

A single-ended device has all of its signals referenced to a common 
ground potential.

Single-Ended 
Mode (SEM)

Single-ended mode is a method of sending SCSI signals along a cable. 
Single-ended mode uses one wire for the signal, which is compared to a 
common ground. The signal is the voltage difference between the two 
wires. Cable lengths for single-ended mode are restricted to between 6 
and 1.5 meters (20 to 5 ft.) with the length decreasing as the data 
speed increases.

Skew Skew changes the horizontal position of a waveform on the display 
independent of any other waveforms on the display. Skew is typically 
used for overlaying waveforms, or eliminating timing difference 
caused by different cable and probe lengths. The time base position 
control moves all of the waveforms on the display at the same time, 
whereas skew moves individual waveforms.

Skin Effect Skin effect is the tendency of high-frequency currents to flow close to 
the surface of the conductor restricting the flow to a small part of the 
conductor's cross-sectional area. As frequency increases, so does the 
resistance and thus the loss also increases due to skin effect.

Small Computer 
System Interface 
(SCSI)

SCSI (pronounced "skuzzy") is a standardized hardware interface for a 
computer that acts as an I/O bus that can be used to connect the 
computer to several peripheral devices, such as printers, disk drives, 
CD-ROM, CD-R, Zip drives, and scanners.

SOLT Calibration SOLT is a calibration using four known standards: 
Short-Open-Load-Thru. 
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Smith Chart The Smith chart is the most common way to display complex 
impedance. The Smith chart is a circular chart with a bisecting 
horizontal line. The amount of reflection that occurs when 
characterizing a device depends on the impedance the incident signal 
sees. Since any impedance can be represented as a real and imaginary 
part (R+jX or G+jB), these quantities can be plotted on a rectilinear 
grid (known as the complex impedance plane). 

All values of reactance and all positive values of resistance from 0 to 
infinity fall within the outer circle of the Smith chart. Impedances on 
the chart are always normalized to the characteristic impedance of the 
test system. A perfect termination (Zo) appears in the center of the 
chart. A pure open appears at the left end of the bisecting horizontal 
line (infinity on the x-axis), while a pure short appears at the right end 
of the same line (zero on the x-axis). Loci of constant resistance now 
appear as circles, and loci of constant reactance appear as arcs. 
Inductance (positive reactance) is displayed in the upper half of the 
Smith chart, while capacitance (negative reactance) is displayed in the 
lower half.

Source The source (input channel, function, waveform memory, or constant) 
used when performing tasks, such as measurements, math, or mask 
tests.

Standard 
Deviation

Standard deviation, represented by the Greek letter sigma (σ), is the 
measure of the dispersion or spread of the statistical average of all 
results for a particular measurement. In a Gaussian distribution, two 
sigma, or within ±1σ of the mean is where 68.3 percent of the data 
points reside. Six sigma, or within ±3σ of the mean is where 99.7 
percent of the data points reside. 

Start Frequency Start frequency is the start point of the frequency domain 
measurement range, or the lowest frequency measured. Together with 
the stop frequency, they determine the span of the measurement 
range.

Stimulus The Physical Layer Test System applies reference signals that are 
transmitted through the DUT or are reflected from the DUT's input. 
The transmitted or reflected signal is then detected and compared 
against the reference signal. A reference signal is called the 
"stimulus". A detected signal is called the response.
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Stop Frequency Stop frequency is the stop point of the frequency domain measurement 
range, or the highest frequency measured. Together with the start 
frequency, they determine the span of the measurement range.

Stripline A stripline is a planar transmission line structure that consists of a 
thin conductive trace (or traces) printed or etched within an insulating 
substrate with parallel ground planes on both sides of the substrate. 

Sweep A sweep is the ability of the source to provide a specified signal level 
over a specified frequency range in a specified time period. 

Sweep Cycle Time Sweep cycle time is the time required for making a complete sweep 
and preparing for the next sweep. It can be measured as the time from 
the start of one sweep to the start of the next sweep. 

Sweep Mode Sweep mode is the way in which a sweep is initiated or selected.

Sweep Type Sweep type is the method of sweeping the source, e.g., linear, log, or 
frequency step. 

− T −

T-carrier T-carrier is a full-duplex digital transmission type that uses four wire 
cables. One pair is used to transmit; the other pair is used to receive. 
The cable types were originally twisted pairs, but now include coaxial 
cable, digital microwave, optical fiber, and other media. Other 
T-carrier characteristics are:

• Symmetry: the same amount of bandwidth is provided in each 
direction.

• Time Division Multiplexing: multiple transmissions can be 
supported over multiple channels by interleaving the signals over a 
given carrier frequency. 

• Unbiasing: all applications and data types are treated the same. 
Every bit of each transmission is treated the same, regardless of 
whether it's a voice bit, a data bit, or a video bit. 

T1 T1 lines are a standard for broadband digital transmission over 
telephone lines. T3 lines consist of 24 channels at 1.544 Mbps. These 
lines are generally used by Internet Service Providers. See “T-carrier” 
on page 274.
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T3 T3 lines consist of 672 channels at 44.736 Mbps. These lines are 
generally used by Internet Service Providers and are also referred to 
as DS3 lines. See “T-carrier” on page 274.

Termination A termination is a load connected to a transmission line or other 
device.

Test Fixture A test fixture is a fixture used to hold the DUT, route signals to and 
from the DUT, and to apply bias voltages and ground paths to the 
DUT.

Test Set A test set is the arrangement of hardware (switches, couplers, 
connectors and cables) that connect a test device input and output to 
the network analyzer's source and receiver to make S-parameter 
measurements.

Thru A Thru (through) is a calibration standard that is an actual through 
line. See “SOLT Calibration” on page 272. 

Thru Reflect Line 
(TRL) Calibration

TRL calibration is a calibration type that utilizes three simpler, more 
convenient standards to define the error terms to be removed from the 
measurement. The measured parameters of the Thru, Reflect, and 
Line standards in a TRL calibration kit provides the same information 
as a SOLT calibration via a different algorithm.

A calibration at the coaxial ports of the test system removes the effects 
of the system and any cables or adapters before the fixture; however, 
the effects of the fixture itself are not accounted for. An in-fixture 
calibration is preferable, but SOLT standards may not be readily 
available to allow a conventional full 4-port calibration at the desired 
measurement port of the device. 

TRL calibration is convenient because calibration standards can be 
fabricated for the specific measurement environment. The 
characteristic impedance of these fabricated transmission lines can be 
determined from the physical dimensions and substrate's dielectric 
constant. The TRL calibration relies on the characteristic impedance 
of simple transmission lines.

Time Domain 
Network Analysis 
(TDNA)

TDNA includes both time domain reflectometry (TDR) and time 
domain transmission (TDT) measurements to characterize a network. 
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Time Domain 
Reflectometry 
(TDR)

TDR gives an intuitive measurement of any discontinuities in a 
circuit. It measures the location, electrical length, nature of the circuit 
(resistive, capacitive, inductive), and amount of reflection from 
discontinuities.

Time Domain 
Transmission 
(TDT)

TDT is a measurement technique that measures both attenuation and 
propagation delay of your device under test. 

Topology Topology is the way that circuits are connected to link the network 
nodes together. Several network topologies are listed: 

• Bus topology: A topology in which all nodes, i.e., stations, are 
connected together by a single bus.

• Fully connected topology: A topology in which every node has a 
direct path to every other node.

• Hybrid topology: A combination of any two or more other 
topologies.

• Mesh topology: A topology in which there is a minimum of two 
nodes with each having a minimum of two (often more) paths.

• Ring topology: A topology in which every node has exactly two 
branches connected to it forming a ring when all connections are 
made.

• Star topology: A topology in which peripheral nodes are connected 
to a central node. The central node rebroadcasts all transmissions 
received from any peripheral node to all peripheral nodes on the 
network.

• Tree topology: A topology in which multiple star topologies are 
connected together when their central nodes are connected to a 
higher level central node. In turn, this central node may be 
connected to other higher-level central nodes.

Touchstone Touchstone data files, also known as .Snp files, are ASCII text files 
used to import and export S-parameter data. This file format displays 
the data line-by-line, one line per data point, in increasing order of 
frequency. Each line of data consists of a frequency value and one or 
more pairs of values for the magnitude and phase of each S-parameter 
at that frequency. Values are separated by one or more spaces. 
Comments are preceded by an exclamation mark (!). Comments can 
appear on separate lines, or after the data on any line or lines. 
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Trace A series of data points containing frequency/time and amplitude 
information on a plot. In the Physical Layer Test System, a plot may 
have only one trace or it may be defined to have multiple traces. 

Transition Time Transition time is the time duration that a pulse takes to rise from the 
10% level to the 90% level when turning on (the rise time) or the time 
duration that a pulse takes to fall from the 90% level to the 10% level 
when turning off (the fall time).

Transmission 
Measurements

The characterization of the transfer function of a device, that is, the 
ratio of the output signal to the incident signal. Most common 
measurements include gain, insertion loss, transmission coefficient, 
insertion phase, and group delay, all measured over frequency.

Twisted Pair A twisted pair is a cable that is made up of one or more separately 
insulated twisted-wire pairs which reduces susceptibility to RF noise.

− U −

Uncorrected 
Measurements

Uncorrected measurements are measurements made without 
performing calibration (error correction).

uW See “Microwave” on page 264. 

− V −

Velocity Factor Velocity factor is a numerical value related to the speed of energy 
through transmission lines with different dielectrics (.66 for 
polyethylene). In making time domain measurements, a velocity factor 
of 1 = speed of light = 299.7925 x 106 m/s.

Vertical 
Resolution

Vertical resolution is the degree to which an instrument can 
differentiate amplitude between two signals. 

Via A via is a hole filled or lined with a conducting material which is used 
to link two or more conducting layers of a PC board. There are blind 
vias (a via that connects two or more layers including the top or bottom 
layer), buried vias (a via that connects two or more layers that does not 
include the top or bottom layer), and through-hole vias (a via that 
connects all layers). 

− W −

Waveform A waveform is a representation of a signal plotting amplitude versus 
time. 
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Wavelength Wavelength is the physical distance that an electromagnetic wave 
travels during the time it completes one cycle. The distance between 
points of corresponding phase of two consecutive cycles of a wave. The 
wavelength (l) is related to the propagation velocity (v) and the 
frequency (f) by l = v / f. 

Windowing Windowing is a time domain feature that smooths (filters) overshoot 
and ringing displayed in time domain plots. Overshoot and ringing are 
caused by the abrupt transitions of start and stop frequencies used in 
frequency domain measurements. 

− Z −

Zero Level Zero level is a measure of the mean value of the logical 0 of an eye 
diagram.

Zo Zo is the characteristic impedance of a transmission line.
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Reference Information for Discontinued Physical Layer Test System Hardware
The following hardware has been discontinued. However, if you are using any of this 
equipment, it is still documented in this chapter.

Table B-1 Discontinued PLTS Hardware Model Numbers

PLTS Systems: N1947A, N1948A, N1951A, N1953A, N1957A

PLTS Test Sets: N4415A, N4416A, N4417A, N4418A, N4419A, N4421A

PLTS Network Analyzers: 8753ES
8720ES/8722ES
E8356A/E8357A/E8358A
E8362A/E8363A/E8364A
E8801A/E8802A/E8803A
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Discontinued System Information for Chapter 1. Installing 
the VNA-Based Physical Layer Test System Hardware
Table B-2 Physical Layer Test System Configurations

Test Set
Model 

Number

System
Frequency

Range

Supported Network Analyzer

Model 
Number

Optionsa

a. This table lists only the most specifically relevant options. For compatibility with options not 
listed here, contact the factory.

Required Compatible Incompatible

N4415A 30 kHz to 
6.0 GHz

8753ES 006b, 014

b. Option 006 required only for operation above 3 GHz.

002, 004, 010, 1D5 011, 075, H16

N4416A 300 kHz to 
6.0 GHz

E8356Ac/7A/8A

c. Using this network analyzer, the maximum operating frequency is limited to 3 GHz.

015 010, 1D5

N4417Ad

d. E8356A family requires N4417A Option 103; E8801A family requires N4417A Option 104.

300 kHz to 
9.0 GHz

E8356Ac/7Ae/8A

e. Using this network analyzer, the maximum operating frequency is limited to 6 GHz.

015 010

E8801Ac/2Ae/3A 014 010, 1E1, 1E5

N4418A 50 MHz to 
20 GHz

8720ES H32 or H42
010, 012, 400 007, 085, 089

8722ESf

f. When an 8722ES is used with an N4418A, the N4418A requires Option 302. The system’s maximum
operating frequency is limited to 20.0 GHz.

H32 or H44

N4419A 45 MHz to 
20 GHz

E8362A 014 010, 022, 711, UNL

N4420B 45 MHz to 
40 GHz

E8363A 014 010, 022, 711, UNL

N4421A 45 MHz to 
50 GHz

E8364A 014 010, 022, 711, UNL
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NOTE For PNA models E8356A/E8357A/E8358A: If the rear panel USB port is 
oriented horizontally, then you have an older CPU board. We strongly 
recommend that you install 128 MB of memory if any firmware revision above 
2.62 is desired. While this is not an absolute necessity, performance will be very 
sluggish without this extra memory. Even with this extra memory, using more 
than 1601 points will slow the responsiveness of the analyzer. The memory type 
needed is: 128MB SDRAM SODIMM, PC66 or PC100.
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
Using Table B-3, verify that your network analyzer options are compatible with the physical 
layer test system. Incompatible options are shaded.

Table B-3 Common Hardware Option Number Descriptions for Network Analyzers

8753ES Network Analyzer Options

002 Harmonic-Measurement Upgrade 004 Step Attenuator Upgrade

006 6 GHz Upgrade for Standard Units 010 Time Domain Capability

011 Receiver Configuration 014 Configurable Test Set

075 75 Ohm Impedance 1D5 High Stability Frequency Reference

H16 Low Noise Floor

8720ES and 8722ES Network Analyzer Options

007 Mechanical Transfer Switch 010 Time Domain Capability

012 Direct Sampler Access 085 High-Power Test System

089 Frequency Offset Mode 1D5 High Stability Frequency Reference

400 Four-Sampler Test Set H32 Front panel access to A and B samplers 
and Port 1 and Port 2 switch and coupler

H42 8719/8720 only: Front panel access to all 
samplers and Port 1 and Port 2 switch 
and coupler (installs options 400 & 012) 

H44 8722 only: Front panel access to R1, R2, 
A, and B samplers, and Port 1 and Port 2 
switch and coupler ports (installs options 
400 & 012) 

E8356A, E8357A, and E8358A Network Analyzer Optionsa

a. Network analyzer should have firmware revision A.03.53 or later. Contact the factory for 
information regarding PLTS support of earlier firmware revisions.

010 Time Domain Capability 015 Configurable Test Set

E8801A, E8802A, and E8803A Network Analyzer Optionsa

010 Time Domain Capability 014 Configurable Test Set

1E1 Extended Power Range 1E5 High Stability Timebase

E8362A, E8363A, and E8364A Network Analyzer Optionsa

010 Time Domain Capability 014 Configurable Test Set

016b

b. This option has not been tested and is not specified with the Physical Layer Test System.

Add Receiver Attenuators 022 Extended Memory

080b Frequency Offset 081b External Reference Switch

083b Frequency Converter Measurement 
Application

711 Standard Power Range

UNL Extended Power Range with Bias Tees
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PLTS System Interconnection Diagrams between the S-Parameter 
Test Set and the Network Analyzer

Locate your system or test set and network analyzer listed below. Refer to the page indicated 
for information describing the interconnections between the test set and the network 
analyzer.

Table B-4 PLTS Interconnection Diagrams List for Discontinued Hardware

Test System 
Model Number

Test Set 
Model Number

Network Analyzer 
Model Number

Refer
to:

N1957A
N/A

N1953A
N1951A
N1948A
N1947A

N/A
N/A

N4421A
N4420B
N4419A
N4418A
N4417A
N4417A
N4416A
N4415A

E8364A
E8363A
E8362A
8720ES, 8722ES
E8356A, E8357A, E8358A
E8801A, E8802A, E8803A
E8356A, E8357A, E8358A
8753ES

page  285
page  287
page  289
page  291
page  293
page  295
page  297
page  299
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N1957A Test System or N4421A Test Set with E8364A Network Analyzer 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
N4420B Test Set with E8363A Network Analyzer Interconnections 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 Z5623-20215 REF 1 SOURCE OUT REF 1 R1 OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 R2 OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
N1953A Test System or N4419A Test Set with E8362A Network Analyzer

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 AD00756-1 REF 1 SOURCE OUT REF 1 SOURCE OUT
2 AD00756-1 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 AD00756-1 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 AD00756-1 REF 2 SOURCE OUT REF 2 SOURCE OUT
5 AD00756-2 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 AD00756-2 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 AD00756-2 PORT 2 CPLR THRU PORT 2 CPLR THRU
8 AD00756-2 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
9 AD00756-3 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 AD00756-3 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 AD00756-3 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 AD00756-3 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 AD00756-4 REF 1 on rear panel of the test set
14 AD00756-4 REF 2 on rear panel of the test set
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
N1951A Test System or N4418A Test Set with 8720ES or 8722ES Network Analyzer 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
Network Analyzer

To
Test Set

1 AD00599-2 PORT 1 SWITCH PORT 1 SWITCH
2 AD00599-1 A IN A IN
3 AD00599-2 PORT 1 BIAS TEE PORT 1 COUPLER
4 AD00599-1 A OUT A OUT
5 AD00599-2 PORT 2 BIAS TEE PORT 2 COUPLER
6 AD00599-1 B OUT B OUT
7 AD00599-4 R CHANNEL OUT R OUT
8 AD00599-3 R CHANNEL IN R IN
9 AD00599-2 PORT 2 SWITCH PORT 2 SWITCH
10 AD00599-1 B IN B IN
11 AD00599-5 REF 1 on rear panel of the test set
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N1948A Test System Interconnections 

(or N4417A Option 104 Test Set with E8356A, E8357A, or E8358A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
Network Analyzer

To
Test Set

1 AD00653-2 R1 IN R1 IN
2 AD00653-2 A IN A IN
3 AD00653-2 COUPLER IN COUPLER IN
4 AD00653-2 COUPLER IN COUPLER IN
5 AD00653-2 B IN B IN
6 AD00653-2 R2 IN R2 IN
7 AD00653-1 R1 OUT R1 OUT
8 AD00653-1 A OUT A OUT
9 AD00653-1 SOURCE OUT SOURCE OUT
10 AD00653-1 SOURCE OUT SOURCE OUT
11 AD00653-1 B OUT B OUT
12 AD00653-1 R2 OUT R2 OUT
13 AD00653-3 REF 1 on rear panel of the test set
14 AD00653-3 REF 2 on rear panel of the test set
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N1947A Test System Interconnections 

(or N4417A Option 103 Test Set with E8801A, E8802A, or E8803A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
Network Analyzer

To
Test Set

1 AD00653-2 R1 IN R1 IN
2 AD00653-2 A IN A IN
3 AD00653-2 COUPLER IN COUPLER IN
4 AD00653-2 COUPLER IN COUPLER IN
5 AD00653-2 B IN B IN
6 AD00653-1 R1 OUT R1 OUT
7 AD00653-1 A OUT A OUT
8 AD00653-1 SOURCE OUT SOURCE OUT
9 AD00653-1 SOURCE OUT SOURCE OUT
10 AD00653-1 B OUT B OUT
11 AD00653-3 REF 1 on rear panel of the test set
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
N4416A Test Set with the E8356A, E8357A, or E8358A Network Analyzer 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
Network Analyzer

To
Test Set

1 AD00653-2 R1 IN R1 IN
2 AD00653-2 A IN A IN
3 AD00653-2 COUPLER IN COUPLER IN
4 AD00653-2 COUPLER IN COUPLER IN
5 AD00653-2 B IN B IN
6 AD00653-2 R2 IN R2 IN
7 AD00653-1 R1 OUT R1 OUT
8 AD00653-1 A OUT A OUT
9 AD00653-1 SOURCE OUT SOURCE OUT
10 AD00653-1 SOURCE OUT SOURCE OUT
11 AD00653-1 B OUT B OUT
12 AD00653-1 R2 OUT R2 OUT
13 AD00653-3 REF 1 on rear panel of the test set
14 AD00653-3 REF 2 on rear panel of the test set
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Discontinued System Information for Chapter 1. Installing the VNA-Based Physical Layer Test System Hardware
N4415A Test Set with the 8753ES Network Analyzer

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page  22 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
Network Analyzer

To
Test Set

1 AD00632-2 Port 1 Switch Switch
2 AD00632-1 A OUT A OUT
3 AD00632-2 Port 1 Coupler Coupler
4 AD00632-1 A IN A IN
5 AD00632-2 Port 2 Coupler Coupler
6 AD00632-1 B IN B IN
7 AD00632-2 Port 2 Switch Switch
8 AD00632-1 B OUT B OUT
9 AD00632-3 R Channel In R IN
10 AD00632-3 R Channel Out R OUT
11 AD00632-4 REF 1 on rear panel of the test set
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Specifications and Characteristics
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N1947A and N1948A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +10 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent E8803A Option 014 (N1947A System)

Agilent E8358A Option 015 (N1948A System)

Test Set: Agilent N4417A Option 103 (N1947A System)

Agilent N4417A Option 104 (N1948A System)

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4417A Option B20

Calibration Technique: Four-Port SOLT

Table B-5 System Dynamic Range

Frequency Range Specification

300 kHz to 1.3 GHz 120 dBa

a. May be limited to 100 dB at particular frequencies below 750 MHz due to spurious 
receiver residuals.

1.3 GHz to 3.0 GHz 120 dB

3.0 GHz to 6.0 GHz 108 dB

6.0 GHz to 9.0 GHz 103 dB
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Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table B-6 Measurement Port Characteristics

Description Characteristic

300 kHz
to

1.3 GHz

1.3 GHz
to

3.0 GHz

3.0 GHz
to

6.0 GHz

6.0 GHz
to

9.0 GHz

Directivity 50 dB 47 dB 42 dB 40 dB

Source Match 42 dB 42 dB 38 dB 35 dB

Load Match 50 dB 47 dB 42 dB 40 dB

Reflection Tracking ± 0.006 dB ± 0.007 dB ± 0.009 dB ± 0.015 dB

Transmission Tracking ± 0.012 dB ± 0.015 dB ± 0.040 dB ± 0.060 dB
Appendix B 303



Reference Information for Discontinued Physical Layer Test System Hardware
Discontinued System Information for Chapter 5. Specifications and Characteristics
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The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1947A and N1948A systems.

Figure B-1 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure B-2 3.5 mm Reflection Magnitude and Phase Uncertainty
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Power Supply

The power supply requirements for the test sets are listed below. 

Table B-7 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 300 kHz to 9.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler In 4.5 dB maximum

Port 2 to A In and Port 4 to B In 8.5 dB maximum

A In to A Out and B In to B Out 8.0 dB maximum

Isolation (port to port and A to B) ≥ 105 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

Test Port Connectors 50 Ohms (nom.) 
Type-N Connectors

Table 8-1 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +5 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent 8720ES Option H32

Test Set: Agilent N4418A

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4418A Option B20

Calibration Technique: Four-Port SOLT

Table B-8 System Dynamic Range

Frequency Range Specification

50 MHz to 840 MHz 77 dB

840 MHz to 20.0 GHz 90 dB
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Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table B-9 Measurement Port Characteristics

Description Characteristic

50 MHz
to

2.0 GHz

2.0 GHz
to

8.0 GHz

8.0 GHz
to

20.0 GHz

Directivity 48 dB 48 dB 43 dB

Source Match 41 dB 41 dB 38 dB

Load Match 48 dB 48 dB 43 dB

Reflection Tracking ± 0.005 dB ± 0.005 dB ± 0.008 dB

Transmission Tracking ± 0.014 dB ± 0.014 dB ± 0.035 dB
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The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1951A system.

Figure B-3 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure B-4 3.5 mm Reflection Magnitude and Phase Uncertainty
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Power Supply

The power supply requirements for the test sets are listed below. 

Table B-10 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 50 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss 8 to 10 dB

Isolation (port to port) ≥ 85 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

DC Bias Range 
(Option UNK only)

40 VDC, 500 mA

Test Port Connectors 50 Ohms (nom.) 
3.5 mm (m) Connectors

Table 8-2 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −5 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

System: N1953A

Network Analyzer: Agilent E8362A 
Options 014 and UNL

Test Set: Agilent N4419A

Calibration Kit: Agilent 85052D 3.5 mm

Test Port Cables: Agilent N4419A Option B20

Calibration 
Technique:

Four-Port SOLT

Table B-11 System Dynamic Range

Frequency Range Specification Supplemental 
Information

45 MHz to 500 MHz 70 dB

500 MHz to 2.0 GHz 100 dB

2.0 GHz to 10.0 GHz 100 dB

10.0 GHz to 20.0 GHz 85 dB
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Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table B-12 Measurement Port Characteristics

Description Characteristic

45 MHz
to

2.0 GHz

2.0 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

Directivity 56 dB 42 dB 40 dB

Source Match 42 dB 36 dB 33 dB

Load Match 56 dB 42 dB 40 dB

Reflection Tracking ± 0.0025 dB ± 0.009 dB ± 0.013 dB

Transmission Tracking ± 0.020 dB ± 0.032 dB ± 0.050 dB
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The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure B-5 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure B-6 3.5 mm Reflection Magnitude and Phase Uncertainty
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Table B-13 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 5.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 20.0 GHz 18 to 25 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

8.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 20 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
3.5 mm Connectors
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The power supply requirements for the test sets are listed below. 

Table 8-3 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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N1957A Electrical Specifications and Characteristics

The following specifications are applicable for the systems in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

System: N1957A

Network Analyzer: Agilent E8364A 
Options 014 and UNL

Test Set: Agilent N4421A

Calibration Kit: Agilent 85056A 2.4 mm

Test Cables: Agilent N4421A Option B20

Calibration 
Technique:

Four-Port SOLT

Table B-14 System Dynamic Range

Frequency Range Specification Supplemental 
Information

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 50.0 GHz 55 dB
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Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table B-15 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

50.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
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The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the system.

Figure B-7 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure B-8 2.4 mm Reflection Magnitude and Phase Uncertainty
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Table B-16 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 50.0 GHz 

Transition Time 
(10 to 90%, TR=.72/BW)

14 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 50.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 50 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50 Ohms (nom.) 
2.4 mm (m) Connectors
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The power supply requirements for the test sets are listed below. 

Table 8-4 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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The test set environmental operating conditions and physical characteristics are displayed on 
the following pages.

Environmental Operating Conditions

The environmental operating conditions for the test set are listed below.

This product is designed for use in INSTALLATION CATEGORY II and POLLUTION 
DEGREE 2, per IED 61010-1 and 664, respectively.

Table 8-5 Test Set Environmental Operating Conditions

Description Conditions

Operating Environment Indoor use

Altitude

Operating: 0 to 2.0 km (6,560 ft)

Storage: 0 to 15.24 km (50,000 ft)

Temperature 0 °C to 40 °C

Maximum Relative Humidity 80% for temperatures up to 31 °C decreasing 
linearly to 50% for a temperature of 40 °C
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The weight and dimensions for the test sets are listed below.

Weight and Dimensions  
Table B-17 Test Set Weight and Dimensions

 Model Number Weight Dimensions

Height (A) Width (B) Depth (C)

N4415A, N4416A, 
N4417A, N4418A,
and N4419A

9.0 kilograms
(19.9 pounds)

3.0 in
(7.62 cm)

16.75 in
(42.55 cm)

19.25 in
(48.90 cm)

N4421A 9.0 kilograms
(19.9 pounds)

5.5 in
(13.97 cm)

16.75 in
(42.55 cm)

16.75 in
(42.55 cm)
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Discontinued System Information for Chapter 6. Test Set 
Front Panel and Rear Panel
This chapter provides a graphical overview of the test sets used as part of the physical layer 
test system. This chapter also illustrates the front and rear panels of the S-parameter test 
sets separately. The features of each front and rear panel (such as connectors, switches, LEDs, 
and fuses) are identified and briefly described.

The individual network analyzer features are described in the network analyzer 
documentation. They are not be described in this document!

The front and rear panel of each S-parameter test set model is illustrated and described. Refer 
to the page number listed below for your test set model number.

For Model Number: Refer to:

N4415A page  323

N4416A page  327

N4417A page  331

N4418A page  335

N4419A page  339

N4421A page  343
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N4415A

N4415A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 COUPLER connector using a semirigid cable.

3 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

6 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 COUPLER connector using a semirigid cable.
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7 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

8 R IN SMA (f) connector that is connected to the network analyzer 
R Channel IN connector using a semirigid cable.

9 R OUT SMA (f) connector that is connected to the network analyzer 
R Channel OUT connector using a semirigid cable.

10 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

15 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4415A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT Not Used

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor. 

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN Not Used
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4416A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)
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7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4416A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4417A

N4417A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)
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7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4417A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal
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9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

ID 
Number

Rear Panel 
Feature

Feature Description
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N4418A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 BIAS TEE connector using a semirigid cable.

3 PORT 2 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.
Appendix B 335



Reference Information for Discontinued Physical Layer Test System Hardware
Discontinued System Information for Chapter 6. Test Set Front Panel and Rear Panel
6 PORT 4 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

7 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 BIAS TEE connector using a semirigid cable.

8 R OUT SMA (f) connector that is connected to the network analyzer 
R CHANNEL OUT connector using a semirigid cable.

9 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

10 IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

11 R IN SMA (f) connector that is connected to the network analyzer 
R CHANNEL IN connector using a semirigid cable.

12 OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

15 IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT SMA (f) connector, used as an output reference signal

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN SMA (f) connector, used as an input reference signal.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4419A Front Panels

ID 
Number

Front Panel 
Feature

Feature Description 

1 REFERENCE 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 SOURCE OUT connector using a semirigid cable.

2 REFERENCE 1 
RCVR R1 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 RCVR R1 IN connector using a semirigid cable.

3 PORT 2 PORT 2 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB STATUS Three LEDs (R, T, and L) that display the GPIB status of the test set 
when it is communicating with the network analyzer. R = Remote 
Operation, T = Talk mode, L = Listen mode.

5 POWER ON/OFF switch that disconnects the mains circuits from the mains 
supply before other parts of the test set. The front panel POWER 
switch disconnects the mains circuits from the mains supply after 
the EMC filters and before other parts of the instrument.

6 PORT 4 PORT 4 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

7 REFERENCE 2 
RCVR R2 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 RCVR R2 IN connector using a semirigid cable.
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8 REFERENCE 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 SOURCE OUT connector using a semirigid cable.

9 PORT 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 2 
SOURCE OUT connector using a semirigid cable.

10 PORT 2 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR ARM connector using a semirigid cable.

11 PORT 2 RCVR 
B IN

SMA (f) connector that is connected to the network analyzer PORT 2 
RCVR B IN connector using a semirigid cable.

12 PORT 2 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR THRU connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the Agilent 
N4430A/B ECal module to provide ECal capability.

14 PORT 1 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR THRU connector using a semirigid cable.

15 PORT 1 RCVR 
A IN

SMA (f) connector that is connected to the network analyzer PORT 1 
RCVR A IN connector using a semirigid cable.

16 PORT 1 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR ARM connector using a semirigid cable.

17 PORT 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 1 
SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description 
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ID 
Number 

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number 

Rear Panel 
Feature

Feature Description
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N4421A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.
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7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  2.4 mm (f) connector, used as an output reference signal

2 REF 2 R IN  2.4 mm (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 29 for further information.

4 REF 1 R IN 2.4 mm (f) connector, used as an input reference signal

5 REF 1 R OUT 2.4 mm (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250 Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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Symbols
.NET Framework, 45

Numerics
50 ohm cable option, 9

A
A IN connector, 324, 327, 331
A OUT connector, 324, 328, 332
About PLTS menu selection, 144
ac power, 31, 40

cord, 8
frequency range, 31

AC symbol, 241
accessories, 8, 44
acoustic noise emission, 245
Acquisition Hardware menu selection, 131
adapter

marking, 119
orientation, 119

address switch, 29, 39, 174, 325, 329, 333, 337, 
341

address, GPIB, 29, 39
adjustment, IF gain, 32
Agilent Technologies offices, 237, 238
All menu selection, 134, 139
altitude, 31, 167, 320
analyzer setup, 10
Apply menu selection, 125, 126
assistance, 237
Australian Spectrum Management Agency, 

241
AUXILIARY connector, 173, 324, 328, 332, 

336, 340

B
B IN connector, 324, 328, 332
B OUT connector, 324, 328, 332
Balanced 1234, 101
Balanced 1324, 101
balanced transmission line pc board, 8
bar

cursor, 89
format, 87
menu, 83
parameter, 86
scaling, 88
status, 89
title, 83
tool, 84

before applying power safety considerations, 
243

bench top installation, 16
bending, cable, 221
bent connector center pin, 220
bias fuse, 211
bias range, 309
bit pattern

menu selection, 125
browser, 85
Browser menu selection, 112
BUS ADDRESS switch, 174, 325, 329, 333, 

337, 341
bus connector, 174, 325, 329, 334, 337, 341

C
cable

bends, 221
care, 220
center pins, 220
GPIB, 29
handling, 221
option, 9

cables, 21, 284
semirigid interconnect, 8

Calibrate menu selection, 118
calibration, 146

kit, 9
Calibration menu selection, 117
Canadian

EMC requirements, 245
Interference-Causing Equipment Standard 

symbol, 241
Standards Association symbol, 241

care of connectors, 222
Cascade menu selection, 142
cautions

before applying power, 243
definition, 240
general, 244
safety earth ground, 242
servicing, 243

CD-ROM, 5, 36, 43, 44
CE symbol, 241
characteristics, 145–168, 301–321
Characterization Report menu selection, 104
Characterize Adapter menu selection, 119
Choose Data Acquisition Device menu 

selection, 132
CITIFile menu selection, 101, 103
cleaning connectors, 224
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cleaning the test set, 218
cm menu selection, 136
communication bus connector, 174, 325, 329, 

334, 337, 341
compatible network analyzer options, 10
compliance with

Canadian EMC requirements, 245
German noise requirements, 245

computer requirements, 5, 36, 43
configure a system, 81
conformity, declaration of, 246
connection manager, 55, 67
connector

care, 222
mating, 220
torque, 220

Continuous sweep indicator, 89
Continuous Sweep menu selection, 109
cord, ac power, 8
corrected, 146
COUPLER connector, 172, 173, 323, 335, 336, 

339
COUPLER IN connector, 327, 328, 331, 332
create a measurement system, 79
CSA symbol, 241
C-Tick mark, 241
cursor bar, 89

D
damage from shipment, 6, 37, 44
damage level, 150, 155, 160, 165, 305, 309, 

313, 318
Data menu, 133
Data Sharing menu selection, 122
dB, angle menu selection, 103
DC bias range, 309
declaration of conformity, 246
de-embedding

indicator, 89
menu selection, 121

depth, 168, 321
Design menu selection, 124, 126
device under test

sample, 8
dimensions, 168, 321
directivity, 148, 153, 158, 163, 303, 307, 311, 

316
dynamic range, 147, 152, 157, 162, 302, 306, 

310, 315

E
earth ground wire, 186

ECal
kit option, 9
module connector, 173, 324, 328, 332, 336, 

340
Edit Cal Kit menu selection, 119
electrostatic discharge. See ESD
EMC requirements, Canadian, 245
environment operating conditions, 167, 320
environment, operating, 31
equipment installation

TDR-based, 33–40
VNA-based, 3–32

equipment rack installation, 17
ESD

precautions, 186
supplies, 186

European Community symbol, 241
Exit menu selection, 108
Export menu selection, 101

F
File menu, 97
flange kit, 17
floor mat, static-control, 186
format bar, 87

menu selection, 115
format menu, 136
frequency

range, 7, 150, 155, 160, 165, 281, 305, 309, 
313, 318

range of power supply, 151, 156, 161, 166, 
305, 309, 314, 319

frequency domain
format bar, 87
menu selection, 102

front panel
N4415A, 323
N4416A, 327
N4417A, 331
N4418A, 335
N4419A, 172, 339
N4419B, 172, 339
N4420B, 176
N4421A, 180, 343
N4421B, 180, 343

Full Screen menu selection, 116
fuse, bias, 174, 325, 329, 333, 337, 341
fuse, power, 175, 326, 330, 334, 338, 342
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G
gaging connectors, 224
gain, IF, 32
gating

menu selection, 122
Gating Bar menu selection, 115
general safety considerations, 244
Geraeuschemission, 245
German noise requirements, 245
glossary, 250
GPIB, 5, 36, 43

address, 29, 39, 211
address switch, 29, 39, 174, 325, 329, 333, 

337, 341
card, 5, 36
connecting the able, 29
connector, 174, 325, 329, 334, 337, 341
STATUS LEDs, 172, 323, 327, 331, 335, 339

ground wire, 186

H
handle kit, 17
handles, 8, 9
handling cables, 221
handling connectors, 224
hardware, 78

indicator, 89
hardware, virtual, 78
heel straps, ESD, 186
height, 168, 321
help, 237
Help menu, 144
Help menu selection, 144
humidity, 31, 167, 320

I
ICES-001, 245
icon, software, 76
identifying, 78
identifying hardware, 78
IEEE-488 connector, 174, 325, 329, 334, 337, 

341
IF gain, 32
impedance, 150, 155, 160, 165, 305, 309, 313, 

318
indicator, 89

Impedance menu selection, 136
Import menu selection, 100
Impulse menu selection, 136
IN connector, 173, 336, 340
incompatible network analyzer options, 10

Industrial Scientific and Medical Group 1 
Class A product, 241

input voltage, 31
input voltage range of power supply, 151, 

156, 161, 166, 305, 309, 314, 319
insertion loss, 150, 155, 160, 165, 305, 309, 

313, 318
inspecting connectors, 224
installation

bench top, 16
equipment rack, 17
software, 41–81
TDR-based, 33–40
VNA-based, 3–32

instrument documentation symbol, 241
instrument markings, 241
interconnect cables, 8
interconnections, 21–28, 284–300
IO Libraries, 45
ISM1-A symbol, 241
isolation, 150, 155, 160, 165, 305, 309, 313, 318

L
Launch Startup Wizard menu selection, 129
LEDs, GPIB STATUS, 172, 323, 327, 331, 

335, 339
level

damage, 150, 155, 160, 165, 305, 309, 313, 
318

operating, 150, 155, 160, 165, 305, 309, 313, 
318

license
network-server floating, 68, 70–75
node-locked, 68, 68–70
specify type, 76

licensing, iii
line fuse, 211
list of open measurement windows, 142
LM-120, 44
load

match, 148, 153, 158, 163, 303, 307, 311, 316
termination, 211

Log Mag menu selection, 136, 137
logical measurement system, 79
loss

insertion, 150, 155, 160, 165, 305, 309, 313, 
318

M
mag, angle menu selection, 103
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magnitude, reflection, 149, 154, 159, 164, 304, 
308, 312, 317

magnitude, transmission, 149, 154, 159, 164, 
304, 308, 312, 317

main memory, 5, 36, 43
main window, 82
maintenance, 218
making connections, 224
manual, 44
manually configure a system, 81
Marker Bar menu selection, 113
markers, 89
markings, 241
mat, floor, static-control, 186
mat, table, static-control, 186
match

load, 148, 153, 158, 163, 303, 307, 311, 316
source, 148, 153, 158, 163, 303, 307, 311, 316

Math menu selection, 123
Measure menu, 109
measurement

indicator, 89
port, 148, 153, 158, 163, 303, 307, 311, 316
uncertainty, 149, 154, 159, 164, 304, 308, 

312, 317
window list, 142

measurement system, create a, 79
memory, main, 5, 36, 43
memory, virtual, 5, 36, 43
menu

bar, 83
Data, 133
File, 97
Format, 136
Help, 144
Measure, 109
Options, 140
RLCG, 138
Tools, 123
Utilities, 117
View, 111
Window, 142

menu selection, 134
About PLTS, 144
Acquisition Hardware, 131
All, 134, 139
Apply, 125, 126
Bit Pattern, 125
Browser, 112
Calibrate, 118
Calibration, 117

Cascade, 142
Characterization Report, 104
Characterize Adapter, 119
Choose Data Acquisition Device, 132
CITIFile, 101, 103
cm, 136
Continuous Sweep, 109
Data Sharing, 122
dB, angle, 103
De-embedding, 121
Design, 124, 126
Edit Cal Kit, 119
Exit, 108
Export, 101
Format Bar, 115
Frequency Domain, 102
Full Screen, 116
Gating, 122
Gating Bar, 115
Help, 144
Impedance, 136
Import, 100
Impulse, 136
Launch Startup Wizard, 129
Log Mag, 136, 137
mag, angle, 103
Marker Bar, 113
Math, 123
New, 98
New Plot, 135, 139
New Trace, 135
New Window, 142
ns, 136
Open, 98
open measurement window list, 142
Parameter Bar, 113
Plots to Clipboard, 102
Plots to Image File, 102
Print, 107
Print Preview, 106
Print Setup, 105
Real, 136
real, imaginary, 103
Recent Files, 108
RLCG, 104
S11 through S44, 133, 134, 138
Save, 99
Save As, 99
Scaling Bar, 116
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Scan for New Hardware, 132
SCC11 through SDC22, 134
SCD11 through SCD22, 134
SDC11 through SDC22, 134
SDD11 through SDD22, 134
Set Velocity Factor, 129
Start, 109
Status Bar, 112
Step, 136
Stimulus, 110
Stop, 109
TCC11 through TDC22, 133
TCD11 through TCD22, 133
TDA MeasureXtractor, 104
TDC11 through TDC22, 133
TDD11 through TDD22, 133
Tile, 142
Time Domain, 104
Time Domain Window, 130
T-Line Characteristics, 128
Toolbar, 111
Touchstone, 101, 103
User Preferences, 140
Volts, 136
W-element display configuration, 128

microwave connector care, 222
model number

network analyzer, 7, 281
test set, 7, 281

N
N1947A interconnections, 295
N1948A interconnections, 293
N1951A interconnections, 291
N1953A interconnections, 27, 289
N1953B interconnections, 27, 289
N1955B interconnections, 25
N1957A interconnections, 23, 285
N1957B interconnections, 23, 285
N4443A interconnections, 299
N4444A interconnections, 297
N4446A interconnections, 291
network analyzer

options, 7, 281
setup, 10

network-server floating license, 68, 70–75
New menu selection, 98
New Plot, 86
New Plot menu selection, 135, 139
New Trace, 86

New Trace menu selection, 135
New Window menu selection, 142
node-locked license, 68, 68–70
noise emission, acoustic, 245
noise requirements, German, 245
nominal, 146
ns menu selection, 136

O
off symbol, 241
offices of Agilent Technologies, 237, 238
on symbol, 241
ON/OFF switch, 172, 324, 328, 332, 335, 339
online assistance, 237
open measurement window list, 142
Open menu selection, 98
operating environment, 31, 167, 320
operating level, 150, 155, 160, 165, 305, 309, 

313, 318
option

060, 9
1CP, 9
B20, 9
UNK, 309

options, 9
network analyzer, 7, 10, 281

Options menu, 140
orientation of adapters, 119
OUT connector, 173, 336, 340

P
packing materials, 238
parameter bar, 86
Parameter Bar menu selection, 113
pc board

sample balanced transmission line, 8
PC requirements, 5, 36, 43
Pentium, 5, 36, 43
phase uncertainty, 149, 154, 159, 164, 304, 

308, 312, 317
physical characteristics, 168, 321
Plots to Clipboard menu selection, 102
Plots to Image File menu selection, 102
plots window, 90
PLTS connection manager, 55, 67
PORT 2 BIAS connector, 174, 325, 329, 333, 

337, 341
PORT 2 connector, 172, 323, 327, 331, 335, 

339
PORT 2 FUSE, 174, 325, 329, 333, 337, 341
PORT 4 BIAS connector, 174, 329, 333, 337, 

341
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PORT 4 connector, 172, 323, 327, 331, 336, 
339

PORT 4 FUSE, 174, 325, 329, 333, 337, 341
power cord, 8
power cord connector, 175, 326, 330, 334, 338, 

342
power source requirements, 31
power supply requirements, 151, 156, 161, 

166, 305, 309, 314, 319
POWER switch, 172, 324, 328, 332, 335, 339
Print menu selection, 107
Print Preview menu selection, 106
Print Setup menu selection, 105
Programmer’s Toolkit, 45

R
R IN connector, 173, 324, 336, 340
R OUT connector, 173, 324, 336, 340
R1 IN connector, 327, 331
R1 OUT connector, 328, 332
R2 IN connector, 328, 332
R2 OUT connector, 328, 332
rack mount option, 9
rail set, 17
RAM, 5, 36, 43
range

DC bias, 309
frequency, 150, 155, 160, 165, 305, 309, 313, 

318
system dynamic, 147, 152, 157, 162, 302, 

306, 310, 315
Real menu selection, 136
real, imaginary menu selection, 103
rear panel

N4415A, 325
N4416A, 329
N4417A, 333
N4418A, 337
N4419A, 174, 341
N4419B, 174, 341
N4420B, 178
N4421A, 182, 345
N4421B, 182, 345

Recent Files menu selection, 108
REF 1 R IN connector, 174, 326, 329, 333, 338, 

341
REF 1 R OUT connector, 174, 325, 329, 333, 

337, 341
REF 2 R IN connector, 174, 329, 333, 337, 341
REF 2 R OUT connector, 175, 330, 334, 337, 

342

reflection magnitude, 149, 154, 159, 164, 304, 
308, 312, 317

reflection tracking, 148, 153, 158, 163, 303, 
307, 311, 316

Ref-Z indicator, 89
repairs, 238
requirements, computer, 5, 36, 43
resolution

screen, 5, 36, 43
RF connector care, 222
RF power, 211
ripple, 211
RLCG

menu, 138
menu selection, 104

run the software, 76

S
S11 through S44 menu selection, 133, 134, 

138
safety considerations, 242–244

before applying power, 243
general, 244
safety earth ground, 242
servicing, 243

safety earth ground safety considerations, 
242

safety symbols, 240
sample device under test, 8
sample pc board, 8
Save As menu selection, 99
Save menu selection, 99
scaling bar, 88
Scaling Bar menu selection, 116
Scan for New Hardware menu selection, 132
scanning, 78
SCC11 through SDC22 menu selection, 134
SCD11 through SCD22 menu selection, 134
screen resolution, 5, 36, 43
screen, main, 82
SDC11 through SDC22 menu selection, 134
SDD11 through SDD22 menu selection, 134
semirigid interconnect, 21, 284
semirigid interconnect cables, 8, 21, 284
servicing safety considerations, 243
Set Velocity Factor menu selection, 129
shipment damage, 6, 37, 44
shipment for service, 238
shipping materials, 238
software

CD-ROM, 44, 45
icon, 76
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licence, 68
window, 82

software installation, 41–81
source match, 148, 153, 158, 163, 303, 307, 

311, 316
SOURCE OUT connector, 328, 332
specifications, 145–168, 301–321
Start menu selection, 109
start the software, 76
static-safe workstation, 186
Status bar, 89
Status Bar menu selection, 112
Step menu selection, 136
Stimulus menu selection, 110
Stop menu selection, 109
storage altitude, 167, 320
storing connectors, 224
sweep, continuous indicator, 89
switch

BUS ADDRESS, 174, 325, 329, 333, 337, 341
GPIB address, 29, 39
POWER, 172, 324, 328, 332, 335, 339

SWITCH connector, 172, 173, 323, 324, 335, 
336, 339, 340

symbols, 241
system

configurations, 7, 281
dynamic range, 147, 152, 157, 162, 302, 306, 

310, 315
interconnections, 21–28, 284–300
weight, 6, 37

system, create a, 79

T
T11 through T44 menu selection, 134
table mat, static-control, 186
TCC11 through TDC22 menu selection, 133
TCD11 through TCD22 menu selection, 133
TDA MeasureXtractor

menu selection, 104
TDC11 through TDC22 menu selection, 133
TDD11 through TDD22 menu selection, 133
TDR

setup, 37
TDR firmware, 44
TDR setup, 37
TDR-based installation, 33–40
telephone numbers, Agilent, 237
temperature, 167, 320
temperature requirements, 31
test

cable, care of, 220

port connector type, 150, 155, 160, 165, 305, 
309, 313, 318

set performance, 150, 155, 160, 165, 305, 
309, 313, 318

set ports, 119
Tile menu selection, 142
time domain

format bar, 87
menu selection, 104
windowing, 130

Time Domain Window menu selection, 130
title bar, 83
T-Line Characteristics menu selection, 128
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